
ΔΘΝΙΚΟ ΜΔΣ΢ΟΒΙΟ ΠΟΛΤΣΔΥΝΔΙΟ 

 

 

ΓΙΔΠΙ΢ΣΗΜΟΝΙΚΟ-ΓΙΑΣΜΗΜΑΣΙΚΟ  

ΠΡΟΓΡΑΜΜΑ ΜΔΣΑΠΣΤΥΙΑΚΩΝ ΢ΠΟΤΓΩΝ 

«ΔΠΙ΢ΣΗΜΗ ΚΑΙ ΣΔΥΝΟΛΟΓΙΑ ΤΓΑΣΙΚΩΝ ΠΟΡΩΝ» 

 

 

 

 

 

 

 

 

 

 

 

ΤΛΟΠΟΙΗ΢Η ΜΔΘΟΓΟΛΟΓΙΚΟΤ ΠΛΑΙ΢ΙΟΤ 

ΓΙΑ ΣΗΝ ΚΑΣΑΡΣΙ΢Η ΥΑΡΣΩΝ 

ΠΛΗΜΜΤΡΑ΢ 

Δυαρμογή στο ΢αρανταπόταμο Δλεσσίνας 
 

 

 

 

 

 

 

 

Σουτζιάρη Μαγδαληνή 
 

 

 

 

 

 

Δπιβλέπων: Μαμάσης Νίκος, Λέκτορας ΔΜΠ 

 

 

 

 

 

 

 

 

 

 

 

Αθήνα, Μάρτιος 2012 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

ΤΛΟΠΟΙΗ΢Η ΜΔΘΟΓΟΛΟΓΙΚΟΤ ΠΛΑΙ΢ΙΟΤ ΓΙΑ ΣΗΝ 

ΚΑΣΑΡΣΙ΢Η ΥΑΡΣΩΝ ΠΛΗΜΜΤΡΑ΢ 

Δυαρμογή στο ΢αρανταπόταμο Δλεσσίνας 

 

 

 

 

 

 

 

 

 

 

Σουτζιάρη Μαγδαληνή 
 

Αγρονόμος και Σοπογράυος Μητανικός, Α.Π.Θ. 

 

 

 

 

 

 

 

 

ΔΘΝΙΚΟ ΜΔΣ΢ΟΒΙΟ ΠΟΛΤΣΔΥΝΔΙΟ 

 

ΔΠΜΣ Επιζηήμη και Τεχνολογία Υδαηικών Πόρων 

  

 

 

 

 

 

 

 

 

Δπιβλέπων: Μαμάσης Νίκος, Λέκτορας ΔΜΠ 

 

 

 

 

 

Αθήνα, Μάρτιος 2012 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 i 

ΕΥΦΑΡΙΣΤΙΕΣ 

 

 

Η παξνύζα κεηαπηπρηαθή εξγαζία κνπ αλαηέζεθε ζηα πιαίζηα ηεο νινθιήξσζεο ηνπ 

κεηαπηπρηαθνύ πξνγξάκκαηνο Δπηζηήκε θαη Τερλνινγία Υδαηηθώλ Πόξσλ, ηνπ 

Δζληθνύ Μεηζόβηνπ Πνιπηερλείνπ. Θα ήζεια αξρηθά λα επραξηζηήζσ ζεξκά ηνλ 

επηβιέπνληα θαζεγεηή, ιέθηνξα ΔΜΠ θ. Νίθν Μακάζε, γηα ηελ αλάζεζε ηνπ 

ζέκαηνο, ηελ επίβιεςε θαη ηε ζπκβνιή ηνπ κε θαίξηεο επηζεκάλζεηο θαηά ηε δηάξθεηα 

ηεο εθπόλεζεο ηεο εξγαζίαο απηήο. 

Σηε ζπλέρεηα, ζα ήζεια λα επραξηζηήζσ ηδηαίηεξα ηνλ Αγξνλόκν Τνπνγξάθν 

Μεραληθό θαη κέινο ηεο εξεπλεηηθήο νκάδαο ΙΤΙΑ, θ. Αληώλε Κνπθνπβίλν, γηα ην 

ελδηαθέξνλ ηνπ, ηε ζπκπαξάζηαζε ηνπ θαη  ηελ ακέξηζηε βνήζεηα ηνπ ζε πξαθηηθά, 

θνκβηθά ζεκεία ηεο εξγαζίαο. Θα ήηαλ παξάιεηςε από κέξνπο κνπ αλ δελ αλαθεξζώ 

ζηνλ Γξ. Πνιηηηθό Μεραληθό, θ. Αλδξέα Δπζηξαηηάδε, ν νπνίνο κε ηελ αλεμάληιεηε 

επγέλεηα ηνπ, ήηαλ πξόζπκνο λα ζπλεξγαζηεί θαη λα πξνηείλεη ιύζεηο ζε νπνηαδήπνηε 

δπζθνιία παξνπζηαδόηαλ. Τέινο, ην πδξαπιηθό κέξνο ηεο παξνύζαο κεηαπηπρηαθήο 

εξγαζίαο δηεθπεξαηώζεθε νκαιά, ράξε ζηελ πνιύηηκε βνήζεηα θαη θαζνδήγεζε ηνπ 

ππνςήθηνπ Γηδάθηνξα, Παλαγηώηε Γεκεηξηάδε, ηνλ νπνίν θαη επραξηζηώ ζεξκά γηα 

ην ρξόλν πνπ αθηέξσζε ζην ζηάδην απηό ηεο εξγαζίαο. 

Τέινο, επραξηζηώ ηδηαίηεξα ηελ νηθνγέλεηα κνπ γηα ηε ζπλερή ππνζηήξημε θαη 

βνήζεηα ζε νπνηνδήπνηε πξνζσπηθό κνπ εγρείξεκα, θαζώο θαη ηα κέιε ηνπ 

«Διιεληθνύ Ιλζηηηνύηνπ Υδξνινγίαο», Βάζσ Παγάλα θαη Μαξίλα Μαζηνπδάθε, γηα 

ηηο αηειείσηεο κελ, επνηθνδνκεηηθέο θαη επράξηζηεο δε, ώξεο πνπ πεξάζακε θαηά ηε 

δηάξθεηα ηεο πινπνίεζεο ηεο εξγαζίαο. Οθείισ λα παξαδερζώ όηη, ν θύθινο απηόο 

ησλ ζπνπδώλ θιείλεη κε ηηο θαιύηεξεο εληππώζεηο από ηνλ ηξόπν ζπλεξγαζίαο, 

πξνζέγγηζεο θαη βνήζεηαο από ηα κέιε ηεο εξεπλεηηθήο νκάδαο ΙΤΙΑ, ηνπ Δζληθνύ 

Μεηζόβηνπ Πνιπηερλείνπ.  

 

 

 

 

 

 

 

  

 

 

Τνπηδηάξε Μαγδαιελή, 

 

Αζήλα, Μάξηηνο 2012. 
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ΠΕΡΙΛΗΨΗ 
 

 

Σηελ παξνύζα κεηαπηπρηαθή εξγαζία εμεηάδεηαη, ε δηαδηθαζία ηεο πδξνινγηθήο 

πξνζνκνίσζεο ιεθάλεο απνξξνήο πνηακνύ, ηεο κεηέπεηηα πδξαπιηθήο πξνζνκνίσζεο 

ηκήκαηνο πδαηνξεύκαηνο θαη ηειηθά ε εμαγσγή ραξηώλ πηεδνκεηξηθώλ βαζώλ θαη 

ραξηώλ πνιπγώλσλ πιεκκπξηθήο θαηάθιπζεο.   

Τα ινγηζκηθά πνπ ρξεζηκνπνηήζεθαλ είλαη ην πδξνινγηθό κνληέιν HEC-HMS θαη ην 

πδξαπιηθό κνληέιν HEC-RAS, ζρεδηαζκέλα από ην Σώκα Μεραληθώλ ηνπ 

Ακεξηθαληθνύ Σηξαηνύ. Τν πξώην εθαξκόδεηαη γηα ηελ πξνζνκνίσζε ησλ δηεξγαζηώλ 

βξνρόπησζεο-απνξξνήο ζε ιεθάλεο απνξξνήο, ελώ ην δεύηεξν επηηξέπεη ηε 

κνλνδηάζηαηε αλάιπζε θαη ηελ πξνζνκνίσζε θπζηθώλ πδαηνξεπκάησλ ή ηερλεηώλ 

ζπζηεκάησλ. Η πξνεπεμεξγαζία ησλ δεδνκέλσλ επηηπγράλεηαη κε ην ζύζηεκα 

γεσγξαθηθώλ πιεξνθνξηώλ ArcGis θαη ζπγθεθξηκέλα κε ηηο επεθηάζεηο απηνύ HEC-

GeoHMS θαη HEC-GeoRAS.  

Αξρηθά, επηιέρζεθε ε πεξηνρή κειέηεο, ήηνη 200 km
2
, ηεο ιεθάλεο απνξξνήο ηνπ 

Σαξαληαπόηακνπ ζηελ Ειεπζίλα γηα ηελ πδξνινγηθή πξνζνκνίσζε θαη πεξίπνπ 20 

km ηνπ βόξεηνπ θιάδνπ ηνπ πνηακνύ γηα ηελ πδξαπιηθή πξνζνκνίσζε ζε ζπλζήθεο 

κόληκεο ξνήο.  

Σπγθεθξηκέλα, πξαγκαηνπνηήζεθε ε ζπιινγή πξσηνγελώλ δεδνκέλσλ, δειαδή, ην 

ςεθηαθό κνληέιν εδάθνπο, νη ράξηεο ρξήζεσλ γεο θαη ν γεσινγηθόο ράξηεο. 

Αθνινύζεζε ε πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο κειέηεο, γηα ηξεηο πεξηόδνπο 

επαλαθνξάο Τ=20, 100, 1000 έηε, θαη ελόο παξαηεξεκέλνπ επεηζνδίνπ βξνρήο 

(06/02/12-10/02/12). Αξρηθά, ιόγσ έιιεηςεο βξνρνκεηξηθώλ δεδνκέλσλ, έγηλε 

πξνζεγγηζηηθή εθηίκεζε ηνπ πδξνινγηθνύ θαζεζηώηνο κέζσ όκβξησλ θακππιώλ πνπ 

ηζρύνπλ γηα ηελ πεξηνρή. Η πδξνινγηθή πξνζνκνίσζε έδσζε σο ηειηθά εμαγόκελα, 

πιεκκπξνγξαθήκαηα ζρεδηαζκνύ γηα θάζε ππνιεθάλε ηεο πεξηνρήο κειέηεο θαη γηα 

θάζε πεξίνδν επαλαθνξάο ηα νπνία ζηε ζπλέρεηα ρξεζηκνπνηνύληαη γηα ηελ 

πδξαπιηθή πξνζνκνίσζε ηνπ πνηακνύ. Η πδξαπιηθή πξνζνκνίσζε ηεο ξνήο θαηά 

κήθνο ηνπ πνηακνύ ζε ζπλζήθεο κόληκεο ξνήο εμάγεη ηειηθά ηηο γξακκέο ελέξγεηαο 

θαη ηα πηεδνκεηξηθά βάζε γηα θάζε πεξίνδν επαλαθνξάο θαη γηα ηελ παξαηεξεκέλε 

βξνρόπησζε. 

Τα ηειηθά απνηειέζκαηα ηεο πξνζνκνίσζεο απηήο δίλνπλ ηηο πηεδνκεηξηθέο 

επηθάλεηεο νη νπνίεο ζπγθξηλόκελεο κε ην ςεθηαθό κνληέιν εδάθνπο ππνινγίδνπλ ηα 

βάζε ηνπ λεξνύ. Η ραξηνγξάθεζε ηεο πιεκκύξαο πξαγκαηνπνηείηαη ζε πεξηβάιινλ 

ArcGis (HEC-GeoRAS), κε ηε ζρεδίαζε ησλ πηεδνκεηξηθώλ επηθαλεηώλ θαη ηειηθά 

ηνλ νξηζκό ησλ πνιπγώλσλ πιεκκπξηθήο θαηάθιπζεο. Παξαηεξνύληαη κηθξέο 
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δηαθνξέο ζηηο εθηάζεηο ησλ πιεκκπξηθώλ πεδίσλ γηα ηηο ηξείο πεξηόδνπο επαλαθνξάο 

θαη γηα ην παξαηεξεκέλν επεηζόδην βξνρόπησζεο (έσο 1 km
2
). 

Η εθπόλεζε ραξηώλ πιεκκπξηθήο επηθηλδπλόηεηαο πνπ πξαγκαηεύεηαη ε ελ ιόγσ 

εξγαζία απνηειεί νπζηαζηηθό θνκκάηη εθαξκνγήο ηεο Οδεγίαο 2007/60/ΕΚ γηα ηε 

δηαρείξηζε ηνπ πιεκκπξηθνύ θηλδύλνπ. Η νινθιεξσκέλε πξνζέγγηζε αμηνιόγεζεο 

ησλ πιεκκπξώλ πξαγκαηνπνηείηαη κε ηελ εθπόλεζε ραξηώλ θηλδύλσλ πιεκκύξαο 

όπνπ πεξηγξάθνληαη νη δπζκελείο επηπηώζεηο πιεκκύξαο, κηα πηζαλή κεηέπεηηα 

εμέιημε ηεο παξνύζαο κεηαπηπρηαθήο εξγαζίαο.  
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EXTENDED ABSTRACT 
 

Introduction 

Floods are a natural phenomenon that is often characterized as extreme, due to the 

serious material damage and human losses. A flood can simply be defined as the 

temporary covering by water of land not normally covered by water. Floods are 

normally caused by climatic processes, while their evolution depends mainly on 

geomorphologic factors, such as soil stability and permeability, vegetation cover, as 

well as the geometrical characteristics of the river basin. 

Scope 

In this postgraduate thesis, entitled as, “Implementation of a methodological 

framework for mapping flood inundation in Sarantapotamos river basin”, the process 

of hydrological river basin simulation, the hydraulic simulation of a stream section 

and finally the export of piezometric flood depth maps and flood depth polygon maps 

are examined.  

The study was accomplished through the use of the software developed by the 

Hydrologic Engineering Center of the U.S. Army Corps of Engineers, specifically the 

hydrological model HEC-HMS and hydraulic model HEC-RAS. The first, applied to 

simulate rain-runoff processes in river basins, while the second allows the one-

dimensional analysis and simulation of natural water courses or artificial systems. The 

preprocessing of the data obtained with the geographical information system ArcGis 

and specifically with ArcGis extensions, HEC-GeoHMS and HEC-GeoRAS. 

Thesis outline 

The thesis is structured in chapters as follows: 

Chapter 1 Introduction 

 Floods-Generally. 

 Current conditions in Greece. 

 The institutional framework for floods. 

 Hydrologic models- HEC-HMS. 

 Thesis scope and brief description of the methodology followed. 

Chapter 2 Case study 

 Presentation of the case study. 

 Geographical information. 

 Digital elevation model, slopes, land use map, soil type map. 
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Chapter 3 Hydrologic simulation of river basin 

 Data preprocessing, through the use of HEC-GeoHMS, for the determination 

of basin topology and hydrographic network and finally the computation of 
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Case study 

The case study of the developed methodology is a part of Sarantapotamos river basin, 

in Eleysina, Greece, covering an area of 200 km
2
. For this region, the collected raw 
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data consisted of the digital elevation model, as well as the land use and soil type 

maps. Due to lack of rainfall data, for the hydrologic inputs, we initially used reliable 

rainfall data in the estimation of rainfall intensity curves, as adapted to data from 

adjacent basins. The hydraulic simulation is run on 20 km along Sarantapotamos river 

in steady flow analysis.  

Hydrologic simulation 

The hydrologic simulation was designed and run through the use of HEC-HMS, with 

the collaboration of HEC-GeoHMS, which is a hydrologic add-in tool in the ArcGis 

platform.  

The input files required, are the basin model file, which is constructed in HEC-

GeoHMS software, and the meteorologic model file. Initially, we selected the 

methods for the computation of rainfall losses and direct runoff. Specifically, the SCS 

method was applied for the computation of rainfall losses and the user specified unit 

hydrograph (a variation of the British Hydrological Institute method) was applied for 

the calculation of the direct runoff. The channel flow routing is used for specific cases 

by lag time and the baseflow component is omitted on purpose, due to lack of data. 

The meteorologic model file consists of rainfall events which derived from the 

estimated rainfall intensity curves, corresponding to the return periods T=20 yrs, 

T=100 yrs, T=1000 yrs, applied in each subbasin of the case study. The simulation 

was run for this design storms as well as, for the observed rainfall event. The output 

of the procedure is a package of flood hydrographs for each subbasin and each return 

period (like the one shown in fig.1).  

 

 

 

 

 

 

 

 

 

 

 

Figure 1. Rainfall hyetograph and direct runoff hydrograph for a 24-hour rainfall 

event corresponding to 20-years return period to an upstream river basin. 
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Figure 2. Rainfall hyetograph and direct runoff hydrograph for an observed rainfall 

event (06/02/12-10/02/12) to an upstream river basin. 

Hydraulic simulation 

The hydraulic simulation of 20 km along Sarantapotamos river was designed and run 

for the selected return periods through the use of HEC-RAS, with the collaboration of 

HEC GeoRAS, an add-in to ArcGis.  

Firstly, a geometric file is created in HEC GeoRAS, which includes the basic layers of 

the geometry of river, i.e. stream centreline, banks, cross sections etc. After the 

accomplishment of the first step, the geometric file is imported in HEC-RAS program 

and the hydrologic file is created. This file includes the peak discharges as they are 

computed in HEC-HMS. The river was simulated in steady flow conditions and the 

relevant boundary conditions, as set up according to the data. 

The whole computational procedure is based on the resolution of the energy balance 

equation between successive river cross-sections. Particularly, the calculations result 

in the determination of the piezometric depth, the mean kinetic energy and the energy 

gradient for every cross-section. In the following chart is presented a river cross 

section to a downstream position for a 20 year flood, 100 year flood and 1000 year 

flood.  
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Chart 1. A downstream river cross section for flood events for the three return periods 

(20 years, 100 years, 1000 years) 

Digital mapping 

The results of hydrologic and hydraulic simulation are imported in HEC GeoRAS and 

they include all the necessary information for the creation of flood maps.  

The software compares the grid cell values of the digital elevation model (i.e. 

topographical elevations) with the corresponding values of piezometric surface (i.e. 

water surface elevations). Consequently, the software constructs a three dimensional 

model of water surface profiles from the river cross section and the piezometric depth 

on each cross section. In points where the elevation of the piezometric surface is 

higher than the ground elevation, the difference between two heights is calculated, 

which represents the corresponding water depth at the position. The output product is 

a new grid surface, which depicts the water depths in the whole area of the river basin. 

A floodplain inundation map for a 100 year flood event is presented in the end of this 

document. 

The comparison between the inundated areas between the three different flood events 

leads to the conclusion that there is a little correlation between the increase in peak 

discharge flows with the corresponding increase in the floodplain area. Listed in a 

comparative chart, are the areas of floodplain for these cases.  
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Chart 2. Comparative presentation of inundated areas. 

Evaluation of the study 

Floods are among the most crucial problems in the field of natural disasters 

management. The floodplain delineation of a basin for several flood events is of vital 

importance, specifically in regions where human activities, like agriculture, farming 

and industry flourish. 

The flood hazard mapping that addresses this thesis is an essential part of the 

Directive 2007/60/EC on the management of flood risk. The integrated approach to 

the evaluation of flood affected by the flood risk mapping, which describe the adverse 

flood effects.  

Another plan of evaluation of this thesis could be the examination of the other 

methods for computation of rainfall losses and direct runoff which provides the HEC-

HMS program.  
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   Map 1.Floodplain inundation for a 100 year flood event 
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ΕΙ΢ΑΓΩΓΗ 

1.1. ΠΛΗΜΜΤΡΕ΢ 

1.1.1. Γενικά  

Οη πιεκκύξεο απνηεινύλ έλα θπζηθό θαηλόκελν πνπ ζπρλά ραξαθηεξίδεηαη σο 

αθξαίν εμαηηίαο ησλ ζνβαξώλ πιηθώλ δεκηώλ θαη ησλ αλζξώπηλσλ απσιεηώλ.  

Έλαο από ηνπο πην δόθηκνπο νξηζκνύο γηα ηελ πιεκκύξα είλαη ν εμήο: «ε πξνζσξηλή 

θάιπςε από λεξό εδάθνπο ην νπνίν ππό θπζηνινγηθέο ζπλζήθεο δελ θαιύπηεηαη από 

λεξό» (άξζξν 2, Οδεγία 2007/60/ΔΚ). 

Οη πιεκκύξεο ζεσξνύληαη σο ε δεύηεξε πην ζπρλή αηηία θαηαζηξνθώλ κεηά ηηο  

δαζηθέο ππξθαγηέο. Οη βαζηθέο αηηίεο ησλ πιεκκπξώλ είλαη (Λέθθαο, 2009): 

 Σνπηθέο, παξαηεηακέλεο βξνρνπηώζεηο 

 Σήμε ρηνληνύ (επνρηαθέο πιεκκύξεο) 

 Θξαύζε θξάγκαηνο 

 Τπεξρείιηζε πνηακνύ 

 Δηζξνή ηεο ζάιαζζαο (παιηξξνηαθά θύκαηα, ηζνπλάκη)  

Η θαηάηαμε ησλ πιεκκπξώλ ζε θαηεγνξίεο δελ είλαη εύθνιε ππόζεζε εμαηηίαο ησλ 

πνιππνίθηισλ αηηηώλ πνπ κπνξνύλ λα ηηο πξνθαιέζνπλ θαη ησλ παξαγόλησλ, πνπ 

επεξεάδνπλ ηελ εμέιημε ηνπο, όπσο είλαη ν ηόπνο θαη ε δηάξθεηα ηνπο. Αλάινγα 

ινηπόλ κε ην ρώξν πνπ ιακβάλνπλ ρώξα, ηηο αηηίεο πξόθιεζεο ηνπο θαη ηηο 

επηπηώζεηο ηνπο δηαθξίλνληαη ζηηο παξαθάησ θαηεγνξίεο. 
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Πίνακαρ 1.1. Καηηγοπίερ πλημμςπών, αιηίερ ππόκληζηρ και επιπηώζειρ (Πηγή: 

EXCIMAP, 2007). 

 

Σύπος πλημμύρας Αιηίες πλημμύρας Επιπηώζεις πλημμύρας ΢τεηικές παράμεηροι 

Πιεκκύξα πνηακώλ Έληνλε βξνρόπησζε ή 

ιηώζηκν ρηνληνύ 

΢ηάζηκα λεξά ή λεξά ζε ξνή 

εθηόο ηεο θύξηαο θνίηεο ηνπ 

πνηακνύ 

Έθηαζε (ζύκθσλα κε 

ηελ πηζαλόηεηα 

εκθάληζεο) 

  Απόθξαμε ιόγσ πάγνπ   Βάζνο λεξνύ 

  

Καηάξξεπζε 

αλαρσκάησλ ή άιισλ 

έξγσλ πξνζηαζίαο   

Σαρύηεηα λεξνύ 

      Γηάδνζε πιεκκύξαο 

Παξάθηηα πιεκκύξα Πιεκκύξα ιόγσ 

θαηαηγίδαο 

΢ηάζηκα λεξά ή λεξά ζε ξνή 

πίζσ από ηελ αθηνγξακκή 

Οκνίσο κε παξαπάλσ 

  

Σζνπλάκη Τθαικύξηλζε αγξνηηθώλ 

εθηάζεσλ   

  Παιηξξντθό θύκα     

Οξεηλνί ρείκαξξνί Ξαθληθή θαηαηγίδα Πξόζρσζε πεξηνρώλ κε λεξό 

θαη ηδήκαηα 

Οκνίσο κε παξαπάλσ 

  Τπεξρείιηζε ιίκλεο Γηάβξσζε θαηά κήθνο ηεο 

θύξηαο θνίηεο ηνπ πνηακνύ 

Δλαπόζεζε ηδεκάησλ 

  Αζηαζήο θιίζε ηνπ 

πδξνθξίηε 

    

  Ρνή θεξηώλ πιώλ     

΢ηηγκηαίεο πιεκκύξεο 

ζηε Μεζόγεην από 

εθήκεξα ξέκαηα 

Ξαθληθή θαηαηγίδα Πξόζρσζε πεξηνρώλ κε λεξό 

θαη ηδήκαηα 

Οκνίσο κε παξαπάλσ 

    Γηάβξσζε θαηά κήθνο ηεο 

θύξηαο θνίηεο ηνπ πνηακνύ 

  

Πιεκκύξα ππόγεησλ 

πδξνθνξέσλ 

Τςειή ζηάζκε λεξνύ 

ζε παξαθείκελα πδάηηλα 

ζώκαηα 

΢ηάζηκα λεξά ζηελ 

πιεκκπξηθή θνίηε (κεγάιε 

δηάξθεηα πιεκκύξαο) 

Έθηαζε (ζύκθσλα κε 

ηελ πηζαλόηεηα 

εκθάληζεο) 

      Βάζνο λεξνύ 

Πιεκκύξα ζε ιίκλε ΢ηαδηαθή αύμεζε ηεο 

ζηάζκεο αλάινγα κε ηελ 

εηζεξρόκελε παξνρή 

΢ηάζηκα λεξά πίζσ από ηελ 

αθηνγξακκή 

Οκνίσο κε παξαπάλσ 
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Όζνλ αθνξά ζηηο επηπηώζεηο ησλ πιεκκπξώλ, ζεκαληηθέο είλαη νη δεκίεο πνπ 

πξνθαινύλ ηόζν ζε νηθνλνκηθό επίπεδν, όζν θαη ζε απώιεηεο δσώλ. Δλδεηθηηθά 

αλαθέξεηαη όηη, κεηαμύ ηνπ 1998 θαη 2002 ζεκεηώζεθαλ ζηελ Δπξώπε πεξηζζόηεξεο 

από 100 κεγάιεο, δεκηνγόλεο πιεκκύξεο, ζπκπεξηιακβαλνκέλσλ ησλ 

θαηαζηξεπηηθώλ πιεκκπξώλ ζηνλ Έιβα θαη ζην Γνύλαβε ην 2002. Από ην 1998, νη 

πιεκκύξεο απηέο έρνπλ επηθέξεη ην ζάλαην 700 αλζξώπσλ, ηελ αλαγθαζηηθή 

κεηαθίλεζε ζρεδόλ κηζνύ εθαηνκκπξίνπ αηόκσλ θαη ηνπιάρηζηνλ 25 δηζεθαηνκκύξηα 

επξώ ζε νηθνλνκηθέο απώιεηεο. Δπηπιένλ, ν αξηζκόο ησλ αλζξώπσλ πνπ έρεη 

επεξεαζηεί από ηηο πιεκκύξεο αγγίδεη ην 1,5% ηνπ πιεζπζκνύ ηεο Δπξώπεο (ΔΔΑ, 

2003).  

΢ύκθσλα κε ην Υάπηη 1.1., νη ρώξεο ηεο Κεληξηθήο θαη Αλαηνιηθήο Δπξώπεο είλαη 

απηέο πνπ ππέζηεζαλ ηα πεξηζζόηεξα πιεκκπξηθά θαηλόκελα ζην ρξνληθό δηάζηεκα 

1998-2002.  

 

 

 

 

 

 

 

 

 

 

 

Υάπηηρ 1.1. Οι μεγαλύηεπερ πλημμύπερ πος έλαβαν σώπα ζηην Δςπώπη καηά ηην 

πεπίοδο 1998-2002 (Πηγή: ΔΔΑ, 2003) 

΢ην Υάπηη 1.2. απεηθνλίδεηαη ε ζπρλόηεηα πιεκκπξηθώλ επεηζνδίσλ ζηελ Δπξώπε 

θαηά ηελ πεξίνδν 1998-2002. 
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Υάπηηρ 1.2. ΢ςσνόηηηα πλημμςπικών θαινομένυν ζηην Δςπώπη καηά ηην πεπίοδο 

1998-2002 (Πηγή: ΔΔΑ, 2003). 

1.1.2. Πλημμύρες: ηι ζσμβαίνει ζηην Ελλάδα 

Η εθδήισζε πιεκκπξηθώλ γεγνλόησλ ζηελ Διιάδα είλαη θπξίσο απόξξνηα ηεο 

έληνλεο γεσγξαθηθήο κεηαβιεηόηεηαο ησλ θιηκαηηθώλ ζηνηρείσλ ιόγσ ηεο 

ζπλύπαξμεο αλεπηπγκέλεο αθηνγξακκήο θαη νξνγξαθίαο (Ράκπηαο, 2007). ΢ε απηήλ 

ηελ θαηεύζπλζε ε νξνζεηξά ηεο Πίλδνπ δηαδξακαηίδεη ζεκαληηθό ξόιν θαη απνηειεί 

έλα «πδξνινγηθό ζύλνξν», κηαο θαη ε κέζε εηήζηα βξνρόπησζε ζηε Γπηηθή Διιάδα 

είλαη ηεο ηάμεο ησλ 1800 mm ελώ ζηα Αλαηνιηθά ην αληίζηνηρν κέγεζνο είλαη  

πεξίπνπ 400 mm. ΢ηελ Δικόνα 1.1., παξαηίζεληαη νη κέζεο ππεξεηήζηεο βξνρνπηώζεηο 

αλά πδαηηθό δηακέξηζκα ζηελ Διιάδα γηα ην δηάζηεκα 1960-1990. 

Ωζηόζν, ε παξαηήξεζε ζρεηηθά κε ηελ αλνκνηνκνξθία ησλ βξνρνπηώζεσλ δελ 

ζπκβαδίδεη θαη κε ηελ αληίζηνηρε εθδήισζε πιεκκπξηθώλ γεγνλόησλ ζην αλαηνιηθό 

θαη δπηηθό κέξνο ηεο ρώξαο. ΢πλεπώο, παξόηη νη βξνρνπηώζεηο ζηα δπηηθά είλαη θαηά 

πεξίπνπ ηξεηο θνξέο κεγαιύηεξεο απ’ όηη ζηα αλαηνιηθά, νη πιεκκπξηθέο απνξξνέο 

ζηα αλαηνιηθά είλαη θαηά πνιύ ζπρλόηεξεο (Γθηόθαο, 2009). Απηό ζπκβαίλεη, όπσο 

απνδεηθλύεηαη θαη ζην Υάπηη 1.3., από ηα πνζνζηά κέζνπ εηήζηνπ βξνρνκεηξηθνύ 

ύςνπο ζε κηα εκέξα. ΢πγθεθξηκέλα, ζπλαληώληαη κεγαιύηεξα εκεξήζηα ύςε βξνρήο 

ζηα αλαηνιηθά (βι. Αηηηθή) από όηη ζηα δπηηθά, γεγνλόο πνπ εμεγεί ηε ζπρλόηεηα ησλ 

πιεκκπξηθώλ απνξξνώλ ζηα κέξε απηά. Δμάιινπ, ε πιεκκύξα, σο επί ησ πιείζην 

πξνθαιείηαη από κεγάια ύςε βξνρήο ζε κηθξό ρξόλν.  
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Δικόνα 1.1. Μέζη ςπεπεηήζια βποσόπηυζη (mm) για ηην πεπίοδο 1960 –1990 ανά 

ςδαηικό διαμέπιζμα (Πηγή: http://ndbhmi.chi.civil.ntua.gr). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Υάπηηρ 1.3. Ποζοζηά μέζος εηήζιος ύτοςρ βποσήρ ζε μια μέπα, ανά ηην Δλλάδα 

(Πηγή: Φαπμακάκη, 2012).   
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1.1.3. Σο θεζμικό πλαίζιο για ηις πλημμύρες 

Σν Δπξσπατθό Κνηλνβνύιην εμέδσζε ζηηο 23 Οθησβξίνπ ηνπ 2007, ηελ Οδεγία 

2007/60/ΔΚ γηα ηελ αμηνιόγεζε θαη ηε δηαρείξηζε ησλ θηλδύλσλ πιεκκύξαο. Η 

νδεγία ηέζεθε ζε ηζρύ ζηηο 26 Ννεκβξίνπ ηνπ 2007.  

Ο ζθνπόο ηεο νδεγίαο είλαη, ε ζέζπηζε ελόο πιαηζίνπ γηα ηελ αμηνιόγεζε θαη ηε 

δηαρείξηζε ησλ θηλδύλσλ πιεκκύξαο, κε ζηόρν ηε κείσζε ησλ δπζκελώλ ζπλεπεηώλ 

ηεο, ζηελ αλζξώπηλε πγεία, ζην πεξηβάιινλ, ζηελ πνιηηηζηηθή θιεξνλνκηά θαη ζηελ 

νηθνλνκηθή αλάπηπμε (άξζξν 1, 2007/60/ΔΚ). 

Οη βαζηθνί άμνλεο δηαρείξηζεο ηνπ θηλδύλνπ πιεκκύξαο ζύκθσλα κε ηελ επξσπατθή 

νδεγία είλαη: 

 Η πξόιεςε. 

 Η πξνζηαζία. 

 Η εηνηκόηεηα. 

 Η αληηκεηώπηζε θαηαζηάζεσλ έθηαθηεο αλάγθεο. 

 Η απνθαηάζηαζε θαη ε εμαγσγή δηδαγκάησλ. 

Σα βήκαηα εθαξκνγήο ηεο Οδεγίαο 2007/60/ΔΚ πεξηιακβάλνπλ αξρηθά ηελ 

πποκαηαπκηική αξιολόγηζη ηυν κινδύνυν πλημμύπαρ. ΢ηε ζπλέρεηα αθνινπζεί ε 

θαηάξηηζε σαπηών επικινδςνόηηηαρ πλημμύπαρ (flood hazard) θαη σαπηών κινδύνυν 

πλημμύπαρ (flood risk), πάληα ζε επίπεδν ιεθάλεο απνξξνήο πνηακνύ. Σέινο, 

εθπνλνύληαη ζσέδια διασείπιζηρ γηα θάζε ιεθάλε απνξξνήο. 

΢ην πξώην ζηάδην εθαξκνγήο ηεο Οδεγίαο 2007/60/ΔΚ, ζηελ πποκαηαπκηική 

αξιολόγηζη, ηα Κξάηε Μέιε ππνρξενύληαη λα πξνζδηνξίζνπλ ηηο πεξηνρέο πνπ είλαη 

επηξξεπείο ζηελ εκθάληζε πιεκκπξηθώλ ζπκβάλησλ, ώζηε λα πξνθαηαιάβνπλ ηηο 

δπζκελείο επηπηώζεηο ηνπο (άξζξν 4-5, παξ.1). Οπζηαζηηθά, θαηαγξάθνληαη ηα 

πεξηγξαθηθά δεδνκέλα ηζηνξηθώλ πιεκκπξώλ κε ηηο αληίζηνηρεο ζπλέπεηεο ηνπο θαη 

γίλεηαη κηα αμηνιόγεζε δπλεηηθώλ αξλεηηθώλ ζπλεπεηώλ κειινληηθώλ πιεκκπξώλ, 

κε βάζε ζηνηρεία όπσο ε ηνπνγξαθία, ε ζέζε θαη ηα όξηα ησλ πδαηνξεπκάησλ, ηα 

πδξνινγηθά θαη γεσκνξθνινγηθά ραξαθηεξηζηηθά ηνπο, ε απνηειεζκαηηθόηεηα ησλ 

πθηζηάκελσλ αληηπιεκκπξηθώλ έξγσλ, ε ζέζε ησλ θαηνηθεκέλσλ πεξηνρώλ θαη ησλ 

πεξηνρώλ νηθνλνκηθήο δξαζηεξηόηεηαο θαζώο θαη νη καθξνπξόζεζκεο δπλεηηθέο 

εμειίμεηο (Δπζηξαηηάδεο θαη Μακάζεο, 2011). 

Όζνλ αθνξά ζηελ εθπόλεζε ραξηώλ επηθηλδπλόηεηαο θαη θηλδύλσλ πιεκκύξαο, νη 

πξώηνη θαιύπηνπλ ηηο γεσγξαθηθέο πεξηνρέο πνπ ζα κπνξνύζαλ λα πιεκκπξίζνπλ 

ζύκθσλα κε ηα αθόινπζα ζελάξηα (άξζξν 6, παξ.3): 

 Πιεκκύξεο ρακειήο πηζαλόηεηαο ή ζελάξηα αθξαίσλ θαηλνκέλσλ. 

 Πιεκκύξεο κέζεο πηζαλόηεηαο κε πηζαλή πεξίνδν επαλαθνξάο≥100 ρξόληα. 
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 Πιεκκύξεο πςειήο πηζαλόηεηαο, αλάινγα κε ηελ πεξίπησζε. 

Γηα θάζε ηέηνην ζελάξην ζα πξέπεη λα παξαηίζεληαη ηα εμήο ζηνηρεία: 

 Η έθηαζε ηεο πιεκκύξαο. 

 Σν βάζνο λεξνύ ή ε ζηάζκε λεξνύ αλάινγα κε ηελ πεξίπησζε. 

 Η ηαρύηεηα ξνήο ή ε ζρεηηθή ξνή ησλ πδάησλ αλάινγα κε ηελ πεξίπησζε. 

Οη σάπηερ κινδύνυν πλημμύπαρ πεξηγξάθνπλ ηηο δπζκελείο επηπηώζεηο ησλ 

πιεκκπξώλ πνπ ζπλδένληαη κε ηα ζελάξηα ηεο παξαπάλσ παξαγξάθνπ. Οη επηπηώζεηο 

απηέο εθθξάδνληαη σο εμήο (άξζξν 6, παξ. 5): 

 Δλδεηθηηθόο αξηζκόο θαηνίθσλ πνπ ελδέρεηαη λα πιεγνύλ. 

 Σύπνο νηθνλνκηθήο δξαζηεξηόηεηαο ηεο πεξηνρήο πνπ πηζαλώο λα πιεγεί. 

 Δγθαηαζηάζεηο νη νπνίεο ελδέρεηαη λα πξνθαιέζνπλ ηπραία ξύπαλζε ζε 

πεξίπησζε πιεκκύξαο θαη νη πξνζηαηεπόκελεο πεξηνρέο πνπ ελδέρεηαη λα 

πιεγνύλ. 

 Άιιεο πιεξνθνξίεο γηα ελέξγεηεο πνπ θξίλνληαη από ηα Κξάηε Μέιε όηη ζα 

πξνθαιέζνπλ πηζαλή θζνξά ζην πεξηβάιινλ. ΢πγθεθξηκέλα, ε επηζήκαλζε ησλ 

πεξηνρώλ πνπ ππάξρεη κεγάιε πηζαλόηεηα εκθάληζεο πιεκκπξώλ κε απμεκέλν 

πνζνζηό κεηαθεξόκελσλ ηδεκάησλ, πιεκκπξώλ πνπ παξαζύξνπλ ππνιείκκαηα 

θαη πιεξνθνξίεο γηα πηζαλέο άιιεο πεγέο ξύπαλζεο. 

΢ην ηειηθό ζηάδην εθαξκνγήο ηεο νδεγίαο εθπνλνύληαη ηα ζσέδια διασείπιζηρ γηα 

θάζε ιεθάλε απνξξνήο. Σα ζρέδηα δηαρείξηζεο ησλ θηλδύλσλ πιεκκύξαο 

ζπληάζζνληαη από ηα Κξάηε Μέιε, κε βάζε ηνπο σάπηερ επικινδςνόηηηαρ πλημμύπαρ 

θαη ηνπο σάπηερ κινδύνυν πλημμύπαρ, γηα ηηο πεξηνρέο ζηηο νπνίεο ππάξρνπλ 

δπλεηηθνί, ζνβαξνί θίλδπλνη εκθάληζεο πιεκκύξαο. Οπζηαζηηθά, πεξηιακβάλνληαη 

κέηξα γηα ηελ επίηεπμε ζπγθεθξηκέλσλ ζηόρσλ, όπσο είλαη ν πεξηνξηζκόο ησλ 

δπζάξεζησλ, επηδήκησλ απνηειεζκάησλ πνπ έρνπλ νη πιεκκύξεο ζηελ αλζξώπηλε 

πγεία, ζηελ πνιηηηζηηθή θιεξνλνκηά, ζην πεξηβάιινλ θαη ζηελ νηθνλνκηθή 

δξαζηεξηόηεηα (άξζξν 7, παξ.2). ΢εκεηώλεηαη επίζεο, όηη ηα Κξάηε Μέιε νθείινπλ 

λα εθπνλήζνπλ θαη λα δεκνζηεύζνπλ ηα ζρέδηα δηαρείξηζεο ησλ θηλδύλσλ πιεκκύξαο 

έσο ηηο 22 Γεθεκβξίνπ ηνπ 2015, ζηε ζπλέρεηα επαλεμεηάδνληαη θαη ελεκεξώλνληαη 

ην αξγόηεξν κέρξη ην 2021, θαη κεηά αλά εμαεηία.  

Δλδεηθηηθά παξαηίζεηαη ην ρξνλνδηάγξακκα εθαξκνγήο ηεο Οδεγίαο 2007/60/ΔΚ: 
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Πίνακαρ 1.2. Σο σπονοδιάγπαμμα εθαπμογήρ ηηρ Οδηγίαρ 2007/60/ΔΚ. 

α/α Διαδικασία Ημερομηνία 

1 Έναρξη ισχύος της Οδηγίας (άρθρο 18) 26/11/2007 

2 
Συμμόρφωση των Κρατών Μελών με την Οδηγία 

(άρθρο 17) 
26/11/2009 

3 Θέσπιση τεχνικών υποδειγμάτων (άρθρο 11) για: 

 Την προκαταρκτική αξιολόγηση των κινδύνων 

πλημμύρας (άρθρο 4, παρ.4) 

 Τους χάρτες επικινδυνότητας πλημμύρας και 

τους χάρτες κινδύνων πλημμύρας (άρθρο 6, 

παρ.8) 

 Τα σχέδια των κινδύνων πλημμύρας (άρθρο 

7,παρ.5) 

 

22/12/2009 

 

22/12/2011 

 

22/12/2013 

4 Διοικητικές ρυθμίσεις (άρθρο 3) 26/05/2010 

5 Προκαταρκτική αξιολόγηση των κινδύνων 

πλημμύρας (άρθρα 4 και 5) 

22/12/2011 

6 Χάρτες επικινδυνότητας πλημμύρας και χάρτες 

κινδύνων πλημμύρας (άρθρο 6) 

22/12/2013 

7 Σχέδια διαχείρισης των κινδύνων πλημμύρας 

(άρθρα 7 και 8) 

22/12/2015 

8 Ενημέρωση του κοινού και διαβούλευση (άρθρο 9) 

και Οδηγία 2000/60/ΕΚ (άρθρο 14): 

 Χρονοδιάγραμμα και πρόγραμμα εργασιών 

(άρθρο 14, παρ.1α) 

 Ενδιάμεση επισκόπηση των σημαντικών 

ζητημάτων διαχείρισης των υδάτων (άρθρο 14, 

παρ. 1β) 

 Αντίγραφο του προσχεδίου διαχείρισης λεκάνης 

απορροής (άρθρο 14, παρ.1γ) 

 

 

22/12/2012 

 

22/12/2013 

 

22/12/2014 

9 Χρήση των υφιστάμενων εργαλείων (άρθρο 13) 22/12/2010 
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Πίνακαρ 1.2.(ζςνέσεια) Σο σπονοδιάγπαμμα εθαπμογήρ ηηρ Οδηγίαρ 2007/60/ΔΚ. 

α/α Διαδικασία Ημερομηνία 

10 Καταληκτικές ημερομηνίες της Οδηγίας 

2000/60/ΕΚ: 

 Σχέδια διαχείρισης λεκάνης απορροής ποταμού: 

 Δημοσίευση 

 Αναθεώρηση και ενημέρωση 

 Αναθεώρηση της ανάλυσης του άρθρου 5 

 

 

22/12/2009 

22/12/2015 

22/12/2013 

11 Επανεξέταση και επικαιροποίηση (εφόσον 

χρειάζεται) προκαταρκτικής αξιολόγησης κινδύνου 

πλημμύρας-πιθανή επίδραση κλιματικών αλλαγών 

στη συχνότητα πλημμύρων (άρθρο 14, παρ. 1 και 4) 

22/12/2018 και 

στη συνέχεια 

ανά εξαετία 

12 Επανεξέταση και επικαιροποίηση (εφόσον 

χρειάζεται) χαρτών επικινδυνότητας πλημμύρας 

και χαρτών κινδύνων πλημμύρας- πιθανή επίδραση 

κλιματικών αλλαγών στη συχνότητα πλημμύρων 

(άρθρο 14, παρ. 2 και 4) 

22/12/2019 και 

στη συνέχεια 

ανά εξαετία 

13 Επανεξέταση και επικαιροποίηση (εφόσον 

χρειάζεται) των χαρτών κινδύνων πλημμύρας και 

των σχεδίων διαχείρισης των κινδύνων πλημμύρας 

συμπεριλαμβανομένων των στοιχείων του μέρους Β 

του Παραρτήματος- πιθανή επίδραση κλιματικών 

αλλαγών στη συχνότητα πλημμύρων (άρθρο 14, 

παρ. 3και 4) 

22/12/2021 και 

στη συνέχεια 

ανά εξαετία 

1.2. ΤΔΡΟΛΟΓΙΚΑ ΜΟΝΣΕΛΑ 

Γεληθά, ηα κνληέια είλαη αιγόξηζκνη πνπ αλαπαξηζηνύλ ηε ζπκπεξηθνξά θαη ηελ 

απόθξηζε ελόο θπζηθνύ ζπζηήκαηνο. Πεξηιακβάλνπλ ηα γλσζηά ζηνηρεία 

(παξάκεηξνη) θαη ηα άγλσζηα ζηνηρεία πνπ πξέπεη λα πξνζδηνξηζηνύλ (κεηαβιεηέο 

ζρεδηαζκνύ). 

Ωο ςδπολογικό μονηέλο ζεσξείηαη έλα επξύ θάζκα καζεκαηηθώλ κεηαζρεκαηηζκώλ 

πνπ ζθνπό έρνπλ ηελ αλαπαξάζηαζε δηαθόξσλ πδξνινγηθώλ δηεξγαζηώλ ζε 

θαηάιιειε ρξνληθή θαη ρσξηθή θιίκαθα, έρνληαο δεδνκέλα πεδίνπ (πδξνινγηθά, 
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γεσκνξθνινγηθά θ.η.ι.) θαη εύινγεο ππνζέζεηο ζρεηηθά κε ηνπο θπζηθνύο 

κεραληζκνύο (Δπζηξαηηάδεο, 2008). 

Η καζεκαηηθή αλαπαξάζηαζε ελόο πδξνινγηθνύ κνληέινπ ζα κπνξνύζε λα ήηαλ ε 

εμήο: 

),,( 0 xshy   

Όπνπ s0 νη αξρηθέο νξηαθέο ζπλζήθεο ηνπ θπζηθνύ ζπζηήκαηνο,  

x νη πδξνινγηθέο κεηαβιεηέο εηζόδνπ ή θνξηίζεηο (βξνρόπησζε, δπλεηηθή 

εμαηκηζνδηαπλνή θ.α.), 

y νη κεηαβιεηέο εμόδνπ, ή απνθξίζεηο ηνπ κνληέινπ (επηθαλεηαθή θαη ππόγεηα 

απνξξνή, δηαθπγέο θ.α.), 

θ ηα ραξαθηεξηζηηθά  κεγέζε ηνπ ζπζηήκαηνο, παξάκεηξνη εμαξηώκελνη από 

ηδηόηεηεο πεδίνπ. 

Σα δεδνκέλα εηζόδνπ (κεηαβιεηέο) ζε έλα κνληέιν δίλνληαη κε ηε κνξθή 

ρξνλνζεηξώλ θαη αλαπαξηζηνύλ δηεξγαζίεο ζε ζπγθεθξηκέλε ζέζε ή πεξηνρή κηαο 

ιεθάλεο. Πηζαλά ιάζε ζηηο κεηξήζεηο αιιά θαη ειιηπείο πιεξνθνξίεο νδεγνύλ ζε 

κνληεινπνηήζεηο είηε γηα ηε ζπκπιήξσζε ζηνηρείσλ είηε γηα κειινληηθέο πξνβιέςεηο.  

Σα πδξνινγηθά κνληέια θαηεγνξηνπνηνύληαη αλάινγα κε: 

 ην πεδίν εθαξκνγήο ηνπο 

 ηε ρσξηθή ηνπο θιίκαθα 

 ηε καζεκαηηθή ηνπο δνκή 

 ηε ρξνληθή ηνπο δηαθξηηόηεηα. 

Σο πεδίο εθαπμογήρ: 

Σα πεδία εθαξκνγήο ησλ πδξνινγηθώλ κνληέισλ είλαη ηα εμήο (Δπζηξαηηάδεο, 2008): 

 Δθηίκεζε επηθαλεηαθνύ θαη ππόγεηνπ πδαηηθνύ δπλακηθνύ. 

 Δθηίκεζε πιεκκπξηθώλ κεγεζώλ (πιεκκπξνγξαθήκαηα, παξνρέο αηρκήο θ.α.). 

 Δθηίκεζε επηπηώζεσλ εμαηηίαο αιιαγώλ ζηηο ρξήζεηο γεο, ζηα 

ραξαθηεξηζηηθά ηεο ιεθάλεο απνξξνήο (αζηηθνπνίεζε, απνςίισζε, 

δηεπζεηήζεηο πνηακώλ). 

 Πξόγλσζε πδξνινγηθώλ κεγεζώλ ζε πξαγκαηηθό ρξόλν. 

Η συπική κλίμακα: 
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1. Αδηακέξηζηα ή ζπγθεληξσηηθά (lumped): Κνηλέο θνξηίζεηο, θνηλέο παξάκεηξνη γη 

όιε ηε ιεθάλε απνξξνήο. 

2. Ηκηθαηαλεκεκέλα (semi-distributed): Γηαθνξεηηθέο θνξηίζεηο θαη παξάκεηξνη αλά 

ρσξηθή ελόηεηα. 

3. Ηκη-αδηακέξηζηα (semi-lumped): Γηαθνξεηηθέο θνξηίζεηο αιιά θνηλέο παξάκεηξνη 

αλά ρσξηθή ελόηεηα. 

4. Καηαλεκεκέλα (distributed): Καηάηκεζε ζε πνιύ κηθξέο ρσξηθέο ελόηεηεο. 

Η μαθημαηική δομή: 

Πίνακαρ 1.3. Καηηγοπίερ μονηέλυν ανάλογα με ηη μαθημαηική δομή (Πηγή: 

Δςζηπαηιάδηρ, 2008). 

 Θεωρηηικό σπόβαθρο Φσζική ζσνέπεια 

Μονηέλα 

θσζικής βάζης 

Δμηζώζεηο αθόξεζηεο θαη 

θνξεζκέλεο ξνήο, άιιεο 

εκπεηξηθέο εμηζώζεηο από 

πεηξακαηηθέο ιεθάλεο 

Θεσξεηηθά πιήξεο, αιιά 

κόλνλ ζε πνιύ κηθξή ρσξηθή 

θιίκαθα 

Εννοιολογικά 

μονηέλα 

Παξακεηξηθέο ζρέζεηο, ζε 

πδξαπιηθά αλάινγα 

αλαπαξηζηνύλ ηηο θύξηεο 

πδξνινγηθέο δηεξγαζίεο 

΢ρεηηθή, εθόζνλ νη 

παξάκεηξνη ζεσξεζνύλ 

αληηπξνζσπεπηηθέο ησλ 

"καθξνζθνπηθώλ" 

ραξαθηεξηζηηθώλ ηεο 

ιεθάλεο 

΢ηαηιζηικά-

΢ηοταζηικά 

μονηέλα 

΢ρέζεηο πνπ αλαπαξάγνπλ 

ηε ζηαηηζηηθή δνκή ησλ 

κεηξεκέλσλ απνθξίζεσλ 

΢ηνηρεηώδεο θπζηθή 

ζπλέπεηα, ειεγρόκελε 

ζηαηηζηηθή ζπλέπεηα 

Μονηέλα 

μαύροσ 

κοσηιού 

Γηαδνρηθνί κε γξακκηθνί 

κεηαζρεκαηηζκνί ζρέζεσλ 

αηηίνπ-απνηειέζκαηνο 

Απνιύησο θακία 

Η σπονική διακπιηόηηηα: 

H ρξνληθή δηαθξηηόηεηα είλαη άκεζα εμαξηώκελε από ην ζθνπό ηνπ κνληέινπ. Γηα 

παξάδεηγκα, ζρήκαηα πξνζνκνίσζεο πνπ ρξεζηκνπνηνύληαη γηα δηαρεηξηζηηθνύο 

ζθνπνύο πηνζεηνύλ ηε κεληαία ή ζπαληόηεξα, ηελ εκεξήζηα θιίκαθα, ελώ ηα κνληέια 

πιεκκπξώλ ή ηα ζπλδπαζηηθά πδξνινγηθά κνληέια πηνζεηνύλ κηθξόηεξεο θιίκαθεο, 

κε κέγηζηε ηελ εκεξήζηα. 
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1.2.1. ΣΟ ΤΔΡΟΛΟΓΙΚΟ ΜΟΝΣΕΛΟ HEC-HMS 

Σν πδξνινγηθό κνληέιν HEC-HMS είλαη έλα ελλνηνινγηθό κνληέιν πνπ ζρεδηάζηεθε 

από ην ΢ώκα Μεραληθώλ ηνπ Ακεξηθαληθνύ ΢ηξαηνύ γηα ηελ πξνζνκνίσζε ησλ 

δηεξγαζηώλ βξνρόπησζεο-απνξξνήο ζε ιεθάλεο απνξξνήο κε δελδξνεηδή κνξθή. 

Δθαξκόδεηαη ηόζν ζε κεγάιεο αγξνηηθέο ιεθάλεο απνξξνήο όζν θαη ζε κηθξέο 

αζηηθέο ή εκηαζηηθέο ιεθάλεο. Σα πδξνγξαθήκαηα πνπ παξάγνληαη από ην κνληέιν 

απηό κπνξνύλ λα ρξεζηκνπνηεζνύλ ζε κειέηεο: 

 Γηαζεζηκόηεηαο πδαηηθώλ πόξσλ. 

 ΢πλέπεηεο κειινληηθήο αζηηθνπνίεζεο ιεθάλεο απνξξνήο. 

 Πξόγλσζεο πιεκκπξώλ. 

 ΢ρεδηαζκνύο αληηκεηώπηζεο θαηαζηξνθώλ από πιεκκύξεο. 

 Γηεπζέηεζε πεξηνρήο θαηάθιπζεο πιεκκύξαο. 

 ΢ρεδηαζκόο ππεξρεηιηζηώλ θξαγκάησλ. 

΢ην πξόγξακκα απηό, έλα κνληέιν ιεθάλεο θαηαζθεπάδεηαη κε ην δηαρσξηζκό ηνπ 

πδξνινγηθνύ θύθινπ ζε επηκέξνπο κέξε κε δπλαηόηεηα επεμεξγαζίαο ηνπ θαζελόο 

ρσξηζηά. Κάζε ζπληζηώζα ηνπ πδξνινγηθνύ θύθινπ αλαπαξίζηαηαη κε έλα 

καζεκαηηθό κνληέιν. ΢ηηο πεξηζζόηεξεο πεξηπηώζεηο είλαη αξθεηέο νη επηινγέο ηνπ 

ρξήζηε γηα ηελ πξνζνκνίσζε ηεο θάζε ζπληζηώζαο. Η επηινγή γηα ηελ εθαξκνγή ηεο 

πην θαηάιιειεο κεζόδνπ, είλαη απόξξνηα ηεο γλώζεο ηνπ θπζηθνύ ζπζηήκαηνο, ησλ 

ζηόρσλ ηεο πδξνινγηθήο κειέηεο θαζώο θαη ηεο θξίζεο θαη ηεο εκπεηξίαο ηνπ 

εξεπλεηή (Fleming and Scharffenberg, 2010). 

Σν πξόγξακκα πεξηιακβάλεη κία βάζε δεδνκέλσλ, ε νπνία δέρεηαη δεδνκέλα εηζόδνπ 

θαη εμάγεη απνηειέζκαηα κε ρξήζε δηάθνξσλ ελζσκαησκέλσλ εξγαιείσλ. ΢ηελ 

παξνύζα εξγαζία, δίλνληαη ζπγθεθξηκέλα επεηζόδηα βξνρήο γηα δηαθνξεηηθέο 

πεξηόδνπο επαλαθνξάο (Σ=20, Σ=100, Σ=1000) ζηελ πεξηνρή κειέηεο κε ηειηθά 

εμαγόκελα πιεκκπξνγξαθήκαηα ζρεδηαζκνύ.  

Σα βαζηθά κέξε είλαη ην κνληέιν ιεθάλεο απνξξνήο όπσο έρεη ζρεκαηνπνηεζεί ζην 

HEC-GeoHMS, θαη ην κεηεσξνινγηθό κνληέιν. Σν κνληέιν ιεθάλεο απνξξνήο 

απεηθνλίδεη ηα πδξνινγηθά ζηνηρεία ζπλδένληαο ηα ζε έλα δελδξνεηδέο δίθηπν, κε ηε 

δηαδηθαζία ππνινγηζκνύ λα μεθηλά από ηα αλάληε πξνο ηα θαηάληε. ΢ην πξόγξακκα 

δηαηίζεληαη δηαθνξεηηθέο κέζνδνη ππνινγηζκνύ ησλ απσιεηώλ βξνρήο, ηεο άκεζεο 

απνξξνήο, ηεο βαζηθήο ξνήο θαη ηεο δηόδεπζεο πιεκκύξαο.  

Ο ρξήζηεο επηιέγεη πνην καζεκαηηθό πξόηππν ζα ρξεζηκνπνηήζεη δεδνκέλνπ ησλ 

ζπλζεθώλ θαη ησλ δηαζέζηκσλ ζηνηρείσλ.  

Δλδεηθηηθά αλαθέξνληαη ηα καζεκαηηθά πξόηππα ησλ παξαπάλσ δηεξγαζίσλ: 
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Δκηίμηζη Απυλειών:  

• Initial constant (δείθηεο θ) 

• SCS Curve Number 

• Gridded SCS Curve Number 

• Exponential (εθζεηηθή ζπλάξηεζε ηνπ ρξόλνπ) 

• Green-Ampt. 

Τπολογιζμόρ Δπιθανειακήρ Αποπποήρ: Μοναδιαίο Τδπογπάθημα 

• Snyder 

• SCS 

• Οξηδόκελν από ην ρξήζηε 

Βαζική Ροή:  

• Recession method (εθζεηηθά κεηνύκελε) 

• ΢ηαζεξή ξνή 

• Linear reservoir method (εθθόξηηζε δηεζνύκελνπ λεξνύ ζην πδαηόξεπκα κε 

δηαηήξεζε κάδαο  

Γιόδεςζη:  

• Lag method (κέζνδνο θαζπζηέξεζεο – όρη εμαζζέληζε πιεκκπξηθνύ θύκαηνο) 

• Muskingum 

• Κηλεκαηηθό θύκα 

• Muskingum-Cunge  

Σν πξόγξακκα ζε γεληθέο γξακκέο ζεσξείηαη εύρξεζην, κε αξλεηηθό ζεκείν όηη ζηελ 

πεξίπησζε ύπαξμεο ιαζώλ ή πξνβιεκάησλ θαηά ηνλ ππνινγηζκό δελ ππάξρεη ζαθήο 

θαζνδήγεζε γηα ηελ επίιπζε ηνπο, παξά κόλν ε παξνπζία κελπκάησλ-ζθαικάησλ. 

Αθόκα, πξνβιήκαηα παξνπζηάζηεθαλ θαηά ηελ εηζαγσγή ησλ δεδνκέλσλ από ην 

ππνινγηζηηθό θύιιν excel, (κε αληηγξαθή θαη επηθόιιεζε), όπνπ δελ αλαγλσξηδόηαλ 

ην θόκκα σο δηαρσξηζηηθό ησλ δεθαδηθώλ ςεθίσλ, θαη ζηνλ αξηζκό ησλ δεθαδηθώλ 

ςεθίσλ πνπ δερόηαλ ην πξόγξακκα. Σν πξόγξακκα δίλεη ηε δπλαηόηεηα εηζαγσγήο 

ησλ δεδνκέλσλ κέζσ ελδηάκεζεο επεμεξγαζίαο ζε ινγηζκηθό HEC-DSSVue. Σα 

αξρεία πνπ εηζάγνληαη ζην HMS πξέπεη λα είλαη ζε format .dss, θάηη ην νπνίν 

πξνθύπηεη από θαηάιιειε δηακόξθσζε ησλ πεδίσλ ζην excel θαη κέζσ εηδηθήο 

εθαξκνγήο, κεηαηξαπνύλ ζην ζπκβαηό format. Ωζηόζν, απηή ε εθαξκνγή δελ ήηαλ 

εθηθηή ζηελ παξνύζα εξγαζία, επνκέλσο ε εηζαγσγή ησλ δεδνκέλσλ έγηλε 

ρεηξνθίλεηα.  
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1.3. ΢ΚΟΠΟ΢ ΚΑΙ ΔΙΑΡΘΡΩ΢Η ΕΡΓΑ΢ΙΑ΢ 

Σν αληηθείκελν ηεο παξνύζαο κεηαπηπρηαθήο εξγαζίαο είλαη ε νινθιεξσκέλε 

πεξηγξαθή ηεο πδξνινγηθήο πξνζνκνίσζεο ιεθάλεο απνξξνήο πνηακνύ, ηεο 

κεηέπεηηα πδξαπιηθήο πξνζνκνίσζεο ηκήκαηνο πδαηνξεύκαηνο θαη ηειηθά, ε 

εμαγσγή ραξηώλ επηθηλδπλόηεηαο πιεκκύξαο .   

Η πεξηνρή κειέηεο πνπ επηιέρζεθε είλαη, ε ιεθάλε απνξξνήο ηνπ ΢αξαληαπόηακνπ 

Διεπζίλαο. Η επεμεξγαζία ησλ πδξνινγηθώλ δεδνκέλσλ πξαγκαηνπνηήζεθε 

ζπλδπαζηηθά ζε πεξηβάιινλ ArcGis (HEC-GeoHMS), θαη ζην πδξνινγηθό κνληέιν 

HEC-HMS νκνίσο, ε πδξαπιηθή αλάιπζε αξρηθά μεθίλεζε ζε πεξηβάιινλ ArcGis 

(HEC-GeoRAS) θαη νινθιεξώζεθε ζην πδξαπιηθό κνληέιν HEC-RAS. 

΢πγθεθξηκέλα, κεηά ηελ παξνπζίαζε  ηεο πεξηνρήο κειέηεο ζην δεύηεξν θεθάιαην, 

αθνινπζεί ε αλάιπζε ηεο πξνεπεμεξγαζίαο ησλ γεσγξαθηθώλ δεδνκέλσλ, κε ζθνπό 

ηελ εμαγσγή πδξνγξαθηθνύ δηθηύνπ θαη ηε ράξαμε ππνιεθαλώλ απνξξνήο (HEC-

GeoHMS), θαη ζηε ζπλέρεηα, ε ηειηθή επεμεξγαζία απηώλ ζην κνληέιν HEC-HMS, 

κε απνηέιεζκα ηελ πδξνινγηθή απόθξηζε ησλ ππνιεθαλώλ απνξξνήο ηεο πεξηνρήο 

κειέηεο ππν ηε κνξθή πδξνγξαθεκάησλ (Κεθάιαην 3). 

Αθνινύζσο, πξαγκαηνπνηείηαη ε επεμεξγαζία επηιερζέληνο ηκήκαηνο ηνπ πνηακνύ 

(HEC-GeoRAS) γηα ηε δεκηνπξγία γεσκεηξηθνύ αξρείνπ ην νπνίν ηειηθά εηζάγεηαη 

ζην πξόγξακκα HEC-RAS, όπνπ ζε ζπλδπαζκό κε ην πδξνινγηθό αξρείν πνπ 

παξήρζε από ηελ πδξνινγηθή πξνζνκνίσζε, εθηειείηαη ε κνλνδηάζηαηε πδξαπιηθή 

αλάιπζε ζε ζπλζήθεο κόληκεο ξνήο (Κεθάιαην 4). Η παξαπάλσ δηαδηθαζία 

εθαξκόδεηαη γηα έλα παξαηεξεκέλν επεηζόδην βξνρόπησζεο, δηάξθεηαο ηεζζάξσλ 

εκεξώλ (06/02/2012-10/02/2012), κε ηελ παξνπζίαζε θαη ηελ αλάιπζε ησλ 

απνηειεζκάησλ (Κεθάιαην 5).  

Σέινο, ν ζπλδπαζκόο ησλ απνηειεζκάησλ ηεο πδξνινγηθήο θαη ηεο πδξαπιηθήο 

πξνζνκνίσζεο, εμάγεηαη ζε πεξηβάιινλ ArcGIS-HEC-GeoRAS, έηζη ώζηε 

παξάγνληαη ηειηθά, νη ράξηεο πιεκκπξηθήο θαηάθιπζεο θαη πηεδνκεηξηθώλ βαζώλ.  
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Η ΠΕΡΙΟΥΗ ΜΕΛΕΣΗ΢ 

  

Εικόνα 2.1. Η πεπιοσή ηος Θπιάζιος πεδίος (Πηγή: Κοςηζογιάννηρ και Μαμάζηρ, 

2001) 

2.1.Η ΠΕΡΙΟΥΗ ΜΕΛΕΣΗ΢- ΓΕΝΙΚΑ 

Η πεξηνρή κειέηεο βξίζθεηαη ζηε Γπηηθή Αηηηθή θαη ζπγθεθξηκέλα ζηελ πεξηνρή ηνπ 

Θξηάζηνπ πεδίνπ. Πεξηβάιιεηαη από ηνπο νξεηλνύο όγθνπο, Παηέξα, Κηζαηξώλα, 

Πάζηξα, Πάξλεζα θαη από ην όξνο Αηγάιεσ (Εικόνα 2.1.). Πεξηκεηξηθά, εληνπίδνληαη 

αξθεηά ξέκαηα. Η πεξηνρή έρεη εμειηρζεί ζε κηα θαζαξά βηνκεραληθή δώλε, κε έληνλν 

ην θαηλόκελν ηεο αζηηθνπνίεζεο. Σα κεγαιύηεξα αζηηθά θέληξα είλαη ηεο Διεπζίλαο, 

ηνπ Αζπξόππξγνπ, ηεο Μάλδξαο θαη ηεο Μαγνύιαο (ΟΡ΢Α, 2011). 
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Σν θύξην πδαηόξεπκα ηεο πεξηνρήο είλαη ν ΢αξαληαπόηακνο ή Διεπζίληνο Κεθηζόο, 

όπσο νλνκαδόηαλ θαηά ηελ αξραηόηεηα. Ο ΢αξαληαπόηακνο είλαη ην κεγαιύηεξν 

πνηάκη ηεο πεξηνρήο θαζώο ζε απηό θαηαιήγνπλ νη απνξξνέο από ηνπο ηξηγύξσ 

νξεηλνύο όγθνπο. Γηαζρίδεη ηελ θνηιάδα ηεο Οηλόεο θαη ηνπ Θξηάζηνπ πεδίνπ θαη 

εθβάιιεη ζηνλ θόιπν ηεο Διεπζίλαο.  

Οπζηαζηηθά (Εικόνα 2.1.), ν ΢αξαληαπόηακνο δηαθιαδίδεηαη πξηλ ηελ είζνδν ηνπ ζην 

Θξηάζην πεδίν ζε δύν βαζηθνύο παξαπόηακνπο κε δηεύζπλζε ξνήο από δπηηθά πξνο 

αλαηνιηθά. Ο βόξεηνο θιάδνο δηαζρίδεη ηελ θνηιάδα ηεο Οηλόεο, μεθηλώληαο από ην 

όξνο Κηζαηξώλαο θαη  ν άιινο θιάδνο, ην ξέκα Αγ. Γεώξγηνο, μεθηλά από ηνλ νξεηλό 

όγθν Παηέξα, δηαζρίδνληαο λνηηόηεξα ηελ νκώλπκε θνηιάδα. 

Η ιεθάλε απνξξνήο ηνπ ΢αξαληαπόηακνπ, έθηαζεο 335 km
2
, νξίδεηαη αλαηνιηθά από 

ην όξνο ηεο Πάξλεζαο, βόξεηα ην όξνο Πάζηξα, βνξεηνδπηηθά ηνλ Κηζαηξώλα, θαη 

λνηηνδπηηθά από ην νξεηλό όγθν Παηέξα. Η θύξηα πεγή ηνπ βξίζθεηαη ζην όξνο 

Κηζαηξώλα θαη νη ζεκαληηθόηεξνη ρείκαξξνη πνπ ζπκβάιινπλ ζην πνηάκη είλαη ηα 

ξέκαηα Αγ. Βιάζηνο, Ξεξόξεκα θαη Μεγάιν Καηεξίλη (ΟΡ΢Α, 2011). 

2.2.ΦΤ΢ΙΟΓΡΑΦΙΚΑ ΥΑΡΑΚΣΗΡΙ΢ΣΙΚΑ ΠΕΡΙΟΥΗ΢ 

΢ε ό,ηη αθνξά ην ηνπνγξαθηθό αλάγιπθν ηεο πεξηνρήο, ην πςόκεηξν ηεο ιεθάλεο 

απνξξνήο θπκαίλεηαη από 0 έσο 1338 m, κε κέζν πςόκεηξν ζηα 400 m. 

΢πλδπάδνληαο ην ηνπνγξαθηθό αλάγιπθν κε ηηο θιίζεηο γεο (Χάπηηρ 2.2.), 

παξαηεξνύληαη ήπηεο θιίζεηο ζην θέληξν ηεο ιεθάλεο κειέηεο θαη εληνλόηεξεο 

θιίζεηο πξνο ην λνηηόηεξν κέξνο ηεο πεξηνρήο. Η κέζε θιίζε είλαη πεξίπνπ 10 m, κε 

ηε κέγηζηε θιίζε λα θηάλεη ζηα 61 m. 

Όζν αθνξά ζηελ πδξνγεσινγία ηεο πεξηνρήο κειέηεο, νη εδαθηθνί ηύπνη πνπ 

εκθαλίδνληαη είλαη ζην κεγαιύηεξν πνζνζηό πςειήο πεξαηόηεηαο. Οη γεσινγηθνί 

ζρεκαηηζκνί κε πνιύ κηθξνύο ξπζκνύο δηήζεζεο θαηαιακβάλνπλ ηε κηθξόηεξε 

πεξηνρή, θαη ακέζσο κεηά αθνινπζνύλ ηα εκηπεξαηά εδάθε, κε κηθξνύο ή κεζαίνπο 

ξπζκνύο δηήζεζεο (βι. Χάπηηρ 2.3.). Σέινο, ζηελ πεξηνρή κειέηεο πξαγκαηνπνηήζεθε 

έλαο γεληθόο δηαρσξηζκόο ησλ ρξήζεσλ γεο ζε πέληε θαηεγνξίεο, ήηνη, θαιιηέξγεηεο, 

ιηβάδηα, δάζε, αζηηθή πεξηνρή θαη δξόκνη (βι. Κεθάιαην 3, Πίλαθαο 3.2.). Αθνινπζεί 

ν Χάπηηρ 2.4., όπνπ παξνπζηάδνληαη νη ελ ιόγσ γεληθεπκέλεο θαηεγνξίεο ρξήζεσλ 

γεο, νκνίσο θαη ν Πίνακαρ 2.3. πνπ απνδίδεη ηα πνζνζηά έθηαζεο ησλ παξαπάλσ 

θαηεγνξηώλ. 
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Χάπηηρ 2.1. Το τηθιακό μονηέλο εδάθοςρ ηηρ λεκάνηρ αποπποήρ ηος Σαπανηαπόηαμος. 

Χάπηηρ 2.2. Κλίζειρ εδάθοςρ ηηρ λεκάνηρ αποπποήρ ηος Σαπανηαπόηαμος. 
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Χάπηηρ 2.3. Καηάηαξη εδαθών υρ ππορ ηην πεπαηόηηηα. 

 

Χάπηηρ 2.4. Οι σπήζειρ γηρ ηηρ πεπιοσήρ μελέηηρ ζε γενικεςμένερ καηηγοπίερ. 
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Πίνακαρ 2.1. Καηηγοπίερ εδαθών ζηην πεπιοσή μελέηηρ με κπιηήπιο ηην 

ςδαηοπεπαηόηηηα. 

Σύποι εδαθών Ρσθμοί διήθηζης Ποζοζηά εμθάνιζης (%) 

Αδηαπέξαηα πνιύ κηθξνί 1 

Πεξαηά κεγάινη 66 

Ηκηπεξαηά κηθξνί ή κέζνη 33 

Πίνακαρ 2.2. Οι γενικεςμένερ σπήζειρ γηρ με ηα ανηίζηοισα ποζοζηά έκηαζηρ πος 

καηαλαμβάνοςν. 

Καηηγορία Περιγραθή Ποζοζηά έκηαζης (%) 

1 Καιιηέξγεηεο 16 

2 Ληβάδηα 58 

3 Γάζε 18 

4 Αζηηθή πεξηνρή 3 

5 Γξόκνη 5 
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ΤΓΡΟΛΟΓΙΚΗ ΠΡΟ΢ΟΜΟΙΩ΢Η ΛΔΚΑΝΗ΢ ΑΠΟΡΡΟΗ΢ 

3.1. ΔΙ΢ΑΓΩΓΗ 

Σην θεθάιαην απηό, παξνπζηάδεηαη ε δηαδηθαζία πνπ αθνινπζείηαη γηα  ηελ 

ςδπολογική πποζομοίυζη ηεο ιεθάλεο απνξξνήο ζηελ πεξηνρή κειέηεο πνπ 

επηιέρζεθε. Σπγθεθξηκέλα, ε γεσκνξθνινγηθή θαη ε πδξνινγηθή αλάιπζε ηεο 

ιεθάλεο κειέηεο κε ηειηθά εμαγόκελα ηα πιεκκπξνγξαθήκαηα ζρεδηαζκνύ γηα 

επηιεγκέλεο πεξηόδνπο επαλαθνξάο.  

Ζ αξρηθή επεμεξγαζία γηα ηελ εμαγσγή ησλ ηνπνγξαθηθώλ θαη ησλ πδξνινγηθώλ 

ραξαθηεξηζηηθώλ ηεο ιεθάλεο γίλεηαη κε ηε βνήζεηα ηνπ ινγηζκηθνύ HEC-GeoHMS, 

κηα επέθηαζε ηνπ πξνγξάκκαηνο ArcGis 9.3. Με απηόλ ηνλ ηξόπν δεκηνπξγείηαη ην 

κνληέιν ιεθάλεο απνξξνήο ην νπνίν εηζάγεηαη καδί κε ην κεηεσξνινγηθό κνληέιν 

ζην πδξνινγηθό κνληέιν ΖΔC-HMS, έηζη ώζηε λα πξαγκαηνπνηεζεί ηειηθώο ε 

πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο.  
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Σσήμα 3.1. Σσεδιάγπαμμα διαδικαζίαρ πποεπεξεπγαζίαρ δεδομένυν ζηο HEC-GeoHMS 

και ηηρ ςδπολογικήρ πποζομοίυζηρ ζηο ΗΔC-HMS. 

HEC Geo-HMS 

Χεθηαθό κνληέιν 

εδάθνπο 

Κάλαβνο δηεύζπλζεο 

απνξξνήο 

 

Κάλαβνο 

ζπγθεληξσηηθήο  ξνήο 

 
Κάλαβνο πδαηνξεπκάησλ/ 

θαηώθιη 

 

Ηεξάξρεζε 

πδξνγξαθηθνύ δηθηύνπ 

Γηαλπζκαηηθό 

πδξνγξαθηθό δίθηπν  

 

Δπηινγή πεξηνρή 

κειέηεο  

Υπνινγηζκόο 

ραξαθηεξηζηηθώλ 

ιεθάλεο θαη ξεκάησλ 

 

Πξνεηνηκαζία αξρείνπ 

ιεθάλεο γηα είζνδν 

ζην HEC-HMS 

HEC-HMS 

Υδξνινγηθή πξνζνκνίσζε 

Μνληέιν ιεθάλεο 

απνξξνήο 

Μεηεσξνινγηθό 

κνληέιν 

Αξρείν 

πξνζνκνίσζεο 

Δκβαδά ππνιεθαλώλ 

Σπλδεζηκόηεηα 

πδξνινγηθώλ 

ζηνηρείσλ 

 Πξόηππν απσιεηώλ 

βξνρήο 

Πξόηππν άκεζεο 

απνξξνήο 

Πξόηππν βαζηθήο 

ξνήο 

Πξόηππν δηόδεπζεο 

Όκβξηεο θακπύιεο 

Μέζνδνο 

ελαιιαζζόκελσλ 

πςώλ 

Υεηόγξακκα 

ζρεδηαζκνύ 

Καζνξηζκόο 

ρξνληθήο δηάξθεηαο 

πξνζνκνίσζεο 

Φξήζεηο γεο θαη 

Γεσινγία  

 CN 

Μνλαδηαίν 

Υδξνγξάθεκα 

Φάξαμε 

ππνιεθαλώλ 

Γηαλπζκαηηθό δίθηπν 

ππνιεθαλώλ 
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3.2. ΓΔΩΜΟΡΦΟΛΟΓΙΚΗ ΚΑΙ ΤΓΡΟΛΟΓΙΚΗ ΔΠΔΞΔΡΓΑ΢ΙΑ ΢ΣΟ ΗΔC-

GEOHMS 

Όπσο έρεη ήδε αλαθεξζεί, ζε πεξηβάιινλ ArcGis 9.3 θαη κέζσ ηεο επέθηαζεο HEC-

GeoHMS ζηήλεηαη ην πδξνινγηθό κνληέιν ηεο ιεθάλεο κειέηεο ην νπνίν ζηε 

ζπλέρεηα εηζάγεηαη ζην πξόγξακκα ΖΔC-HMS γηα πεξαηηέξσ επεμεξγαζία. 

Οπζηαζηηθά, έρνληαο ζαλ πξσηνγελέο δεδνκέλν ην ςεθηαθό κνληέιν εδάθνπο 

ζρεκαηνπνηνύληαη νη ιεθάλεο απνξξνήο θαη εμάγεηαη ην πδξνγξαθηθό δίθηπν. Σηε 

ζπλέρεηα ππνινγίδνληαη ηα πδξνινγηθά θαη ηα γεσκνξθνινγηθά ραξαθηεξηζηηθά ηεο 

ιεθάλεο κειέηεο, ηα απνηειέζκαηα ησλ νπνίσλ εηνηκάδνληαη γηα εηζαγσγή θαη 

επεμεξγαζία ζην ΖΔC-HMS. 

Τν πξόγξακκα δεκηνπξγεί ηα εμήο αξρεία εηζόδνπ:  

 έλα αξρείν ράξηε (background map file) 

 έλα αξρείν ηνπ κνληέινπ ηεο ιεθάλεο απνξξνήο (basin model file) 

 έλα αξρείν ηνπ κεηεσξνινγηθνύ κνληέινπ (meteorologic model file) 

Σηε ζπγθεθξηκέλε εξγαζία δεκηνπξγήζεθαλ ζην HEC-GeoHMS ηα δύν πξώηα αξρεία 

εηζόδνπ, ελώ ην κεηεσξνινγηθό κνληέιν δεκηνπξγήζεθε θαηεπζείαλ ζην πξόγξακκα 

ΖΔC-HMS. Τν αξρείν ηνπ κνληέινπ ηεο ιεθάλεο απνξξνήο πεξηέρεη ηα πδξνινγηθά 

θαη γεσκνξθνινγηθά ζηνηρεία ηεο ιεθάλεο. Τα όξηα ηεο ιεθάλεο θαη ν ζρεκαηηζκόο 

ηνπ πδξνγξαθηθνύ δηθηύνπ κεηαηξέπνληαη ζε έλα ζύζηεκα πδξνινγηθώλ δεδνκέλσλ 

πνπ αλαπαξηζηά ηελ απόθξηζε ηεο ιεθάλεο ζηε βξνρόπησζε.  

Γηα λα μεθηλήζεη ε επεμεξγαζία ζην HEC-GeoHMS, απαηηείηαη αξρηθά ην ςεθηαθό 

κνληέιν εδάθνπο. Δδώ, ην ςεθηαθό κνληέιν εδάθνπο πνπ ρξεζηκνπνηήζεθε έρεη 

θάλαβν 25 m × 25 m. Άιια αξρεία εηζόδνπ γηα ην HEC-GeoHMS είλαη νη ράξηεο 

ρξήζεσλ γεο θαη γεσινγίαο, όπσο παξνπζηάδνληαη ζε επόκελε ελόηεηα.  

Τα βαζηθά βήκαηα πνπ αθνινπζνύληαη ζην HEC-GeoHMS είλαη: 

1. Ζ πξνεπεμεξγαζία ηνπ κνληέινπ εδάθνπο (Terrain Preprocessing). 

2. Οξηζκόο ηνπ project πνπ ζα εηζαρζεί ζην ΖΔC-HMS (HMS Project Setup). 

3. Δπεμεξγαζία ηεο ιεθάλεο απνξξνήο (Basin Processing). 

4. Υπνινγηζκόο θαη πξνζδηνξηζκόο ησλ πδξνινγηθώλ θαη γεσκνξθνινγηθώλ 

δεδνκέλσλ (Stream and Watershed characteristics). 

5. Τέινο, πξνεηνηκαζία ηνπ αξρείνπ ιεθάλεο απνξξνήο γηα εηζαγσγή ζην 

πδξνινγηθό κνληέιν ΖΔC-HMS (ΖΔC-HMS Model Files). 

3.2.1. Πποεπεξεπγαζία ηος μονηέλος εδάθοςρ  

Σην ζηάδην απηό, έρνληαο ζαλ αξρείν εηζόδνπ ην ςεθηαθό κνληέιν εδάθνπο θαη 

εθηειώληαο κε ηε ζεηξά ηηο εληνιέο Terrain Preprocessing ηεο εξγαιεηνζήθεο 
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ArcHydro ηνπ ArcGis, ππνινγίδνληαη πδξνινγηθά θαη γεσκνξθνινγηθά 

ραξαθηεξηζηηθά ηνπ κνληέινπ εδάθνπο κε ηειηθό εμαγόκελν ην πδξνγξαθηθό δίθηπν 

κε ηηο αληίζηνηρεο ππνιεθάλεο απνξξνήο.  

Σρεκαηηθά νη εληνιέο ηνπ κελνύ Terrain Preprocessing είλαη νη αθόινπζεο: 

Fill sinks 

 

Flow direction 

 

Flow accumulation 

 

Stream definition 

 

Stream segmentation 

 

Catchment grid delineation 

 

Catchment polygon processing 

  

Drainage line processing 

 

Adjoint catchment processing 

 

Σσήμα 3.2. Σειπά ενηολών ηηρ πποεπεξεπγαζίαρ ηος μονηέλος εδάθοςρ 

Fill sinks 

Καηά ηε δεκηνπξγία ηνπ ςεθηαθνύ κνληέινπ εδάθνπο πξνθύπηνπλ ςεπδή βπζίζκαηα 

ζην αλάγιπθν. Ψο βύζηζκα, ζεσξείηαη έλα ή πεξηζζόηεξα θαηλία, γύξσ από ηα νπνία 

ππάξρνπλ θαηλία κε πςειόηεξν πςόκεηξν. Έηζη ινηπόλ, δηνξζώλνληαη ηα βπζίζκαηα 

ώζηε ην λεξό λα κελ ζπγθεληξώλεηαη ζε κηθξά, δηαζθνξπηζκέλα ηκήκαηα ηεο 

ιεθάλεο θαη λα «κπεξδεύεη» ηε κεηέπεηηα δηαδηθαζία γηα ηελ εμαγσγή ηνπ 

πδξνγξαθηθνύ δηθηύνπ.  
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Flow direction 

Σηε ζπλέρεηα, κεηά ηε δηόξζσζε ηνπ ςεθηαθνύ κνληέινπ εδάθνπο από ηα βπζίζκαηα, 

δεκηνπξγείηαη ν θάλαβνο δηεύζπλζεο απνξξνήο. Δθαξκόδεηαη ζηνλ θάλαβν 

πςνκέηξνπ θαη ππνινγίδεη γηα θάζε θαηλίν πξνο ηα πνύ ζα θαηεπζπλζεί ε ξνή. Ζ 

βαζηθή αξρή ηνπ θαλάβνπ απνξξνήο είλαη όηη ε απνξξνή μεθηλά από θάζε θαηλίν ηνπ 

ςεθηαθνύ κνληέινπ εδάθνπο πξνο έλα θαη κόλν θαηλίν από ηα 8 γεηηνληθά ηνπ, 

αλάινγα κε ηελ θιίζε (κεγαιύηεξε πξνο κηθξόηεξε θιίζε). Ζ θιίζε κεηαμύ 2 

γεηηνληθώλ θαηλίσλ ππνινγίδεηαη σο ε δηαθνξά ησλ πςνκέηξσλ ηνπο δηαηξεκέλε κε 

ην 1, αλ ην ελ ιόγσ θαηλίν βξίζθεηαη νξηδόληηα ή θάζεηα ηνπ αξρηθνύ ή δηαηξεκέλε κε 

ην 2 αλ βξίζθεηαη δηαγώληα. Αλάινγα κε ηε δηεύζπλζε ηεο απνξξνήο, θάζε θαηλίν 

παίξλεη κία ηηκή όπσο θαίλεηαη θαη ζην αθόινπζν ζρήκα: 

 

1= αλαηνιηθά, 2= λνηηναλαηνιηθά 

4= λόηηα, 8= λνηηνδπηηθά 

16=δπηηθά, 32= βνξεηνδπηηθά 

64= βόξεηα, 128= βνξεηναλαηνιηθά  

 

Σσήμα 3.3. Τιμή κενηπικού θαηνίος ανάλογα με ηη διεύθςνζη αποπποήρ (Πηγή: Σηάμος 

και Σκοπελίηη, 2009) 

Έηζη, ζύκθσλα κε ηελ παξαπάλσ θσδηθνπνίεζε ηεο δηεύζπλζεο απνξξνήο, 

πξνθύπηεη ηειηθά ν θάλαβνο δηεύζπλζεο απνξξνήο: 

 

 

 

 

 

 

 

Σσήμα 3.4. Κάναβορ διεςθύνζευν αποπποήρ (Πηγή: Σηάμος και Σκοπελίηη, 2009) 

Flow accumulation 

Σηνλ θάλαβν απηό, ε ζπγθεληξσηηθή ξνή θάζε θαηλίνπ ηζνύηαη κε ην άζξνηζκα ησλ 

γεηηνληθώλ πνπ απνξξένπλ ζε απηό. Τα θαηλία ζπγθεληξσηηθήο ξνήο κε πςειέο ηηκέο 
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αληηζηνηρνύλ ζηηο κηζγάγγεηεο, ελώ απηά κε ηηο  κεδεληθέο ηηκέο αληηζηνηρνύλ ζηηο 

θνξπθνγξακκέο.  

Οπζηαζηηθά, θαζνξίδεηαη ν αξηζκόο ησλ αλάληε θαηλίσλ πνπ απνζηξαγγίδνληαη ζε 

έλα ζπγθεθξηκέλν θαηλίν. Τν εκβαδόλ ηεο αλάληε πεξηνρήο απνζηξάγγηζεο κπνξεί λα 

ππνινγηζηεί εύθνια κε ηνλ πνιιαπιαζηαζκό ηεο ηηκήο ζπζζώξεπζεο ηνπ 

ζπγθεθξηκέλνπ θαηάληε θειηνύ κε ην εκβαδόλ ηνπ θειηνύ.  

 

 

 

 

 

 

 

Σσήμα 3.5. Κάναβορ πλήθοςρ θαηνίυν αποπποήρ (Πηγή: Σηάμος και Σκοπελίηη, 2009) 

Stream definition 

Σην ζεκείν απηό δεκηνπξγείηαη έλαο θάλαβνο πδαηνξεπκάησλ έρνληαο ζαλ 

εηζαγόκελν ηνλ θάλαβν ζπγθεληξσηηθήο απνξξνήο θαη νξίδνληαο έλα θαηώθιη 

(threshold). Τν θαηώθιη είλαη κηα ειάρηζηε ηηκή πνπ νξίδεηαη από ην ρξήζηε. 

Οπζηαζηηθά, επηιέγνληαη ηα θειηά πνπ έρνπλ ζπζζώξεπζε ξνήο κεγαιύηεξε από ην 

νξηδόκελν θαηώθιη. Τα επηιεγκέλα θειηά νξίδνπλ θαη ην πδξνγξαθηθό δίθηπν. Όζν 

κεγαιύηεξε είλαη ε ηηκή πνπ δίλεηαη ζην θαηώθιη, ηόζν κηθξόηεξν είλαη ην 

πδξνγξαθηθό δίθηπν πνπ παξάγεηαη.  

Stream segmentation 

Με ηελ εληνιή απηή ρσξίδεηαη ην πδξνγξαθηθό δίθηπν ζε κηθξόηεξα ηκήκαηα κε 

βάζε ηηο κεζόδνπο ηεξάξρεζεο πδαηνξεπκάησλ π.ρ. θαηά Strahler or  Shreve.  

Catchment grid delineation 

Ζ εληνιή απηή δεκηνπξγεί ππνιεθάλεο γηα θάζε ηκήκα ηνπ πδξνγξαθηθνύ δηθηύνπ. 

Τα παξαγόκελα είλαη αθόκα ζε κνξθή θαλάβνπ.  

Catchment polygon processing 

Σην ζεκείν απηό, νη ππνιεθάλεο πνπ παξήρζεζαλ ζην πξνεγνύκελν βήκα, 

κεηαηξέπνληαη ζε δηαλπζκαηηθή κνξθή. 
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Drainage line processing 

Ζ εληνιή απηή κεηαηξέπεη ην πδξνγξαθηθό δίθηπν από κνξθή θαλάβνπ (grid) ζε 

δηαλπζκαηηθή κνξθή (vector).  

Adjoint catchment processing 

Απηό ην βήκα δελ έρεη θάπνηα πδξνινγηθή ζεκαζία, είλαη αλαγθαίν γηα λα βειηηώζεη 

ηελ ππνινγηζηηθή ηζρύ ηνπ πξνγξάκκαηνο. Αζξνίδεη ηηο αλάληε ππνιεθάλεο ζε θάζε 

ζπκβνιή ηνπ πδαηνξέκαηνο. (Doan and Fleming, 2010) 

Μεηά ηελ νινθιήξσζε ηεο ζεηξάο απηήο ησλ εληνιώλ πξνεπεμεξγαζίαο ηνπ 

κνληέινπ εδάθνπο, αθνινπζεί ε πξνεηνηκαζία ησλ αξρείσλ εηζόδνπ ζην πξόγξακκα 

HEC-HMS, γηα ηελ πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο κειέηεο.  

3.2.2. Πποεηοιμαζία απσείων ειζόδος για ειζαγωγή ζηο  HEC-HMS 

Τν επόκελν βήκα είλαη λα νξηζηεί ε πεξηνρή κειέηεο, ζηελ νπνία ζα γίλεη ε 

πεξαηηέξσ επεμεξγαζία. Απηό πξαγκαηνπνηείηαη κε ηε βνήζεηα ηνπ κελνύ HMS 

Project Setup. Τν κελνύ απηό εμάγεη ηα δεδνκέλα πνπ είλαη απαξαίηεηα γηα ηε 

δεκηνπξγία ελόο project ζην HEC-HMS. Δπηιέγεηαη έλα ζεκείν εμόδνπ (project 

point) θαη απηόκαηα κέζσ κηαο εληνιήο νξίδεηαη θαη ε πεξηνρή κειέηεο (project area) 

αλάληε ηνπ επηιεγκέλνπ ζεκείνπ.  

Αξρηθά, επηιέγνληαο ηελ εληνιή Start a new project, δίλεηαη έλα όλνκα ζην αξρείν 

ηεο κειέηεο. Έπεηηα, γίλεηαη ε αληηζηνίρεζε ηνπ ςεθηαθνύ κνληέινπ εδάθνπο, ηνπ 

θαλάβνπ δηεύζπλζεο απνξξνήο, ηνπ πδξνγξαθηθνύ δηθηύνπ, ησλ ππνιεθαλώλ θ.ιπ. 

κέζσ ηεο εληνιήο Data Management πνπ βξίζθεηαη ζην ίδην κελνύ.  

Σηε ζπλέρεηα, επηιέγνληαο ην εξγαιείν Add Project Points νξίδεηαη νπζηαζηηθά 

ην ζεκείν εμόδνπ ηεο ιεθάλεο θαη κε ηελ εληνιή Generate Project δεκηνπξγείηαη  ε 

πεξηνρή κειέηεο αλάληε ηνπ ζεκείνπ απηνύ. Ζ επηινγή ηεο πεξηνρήο έγηλε κε βάζε 

ηηο ζέζεηο ησλ ζηαζκώλ κέηξεζεο  πνπ έρνπλ ηνπνζεηεζεί ζηε πεξηνρή.  

Δικόνα 3.1. Οι θέζειρ ηυν ζηαθμών μέηπηζηρ ζηην πεπιοσή μελέηηρ. 
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Έηζη, θαηαιήγνπκε ζηηο εμήο ππνιεθάλεο θαη ζην αληίζηνηρν πδξνγξαθηθό δίθηπν. 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.2. Το τηθιακό μονηέλο εδάθοςρ ηηρ εςπύηεπηρ πεπιοσήρ ππιν ηην εθαπμογή 

ηηρ ενηολήρ Generate Project. 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.3. Η πεπιοσή μελέηηρ όπυρ έσει οπιζηεί με ηην εθαπμογή ηηρ ενηολήρ 

Generate Project. 

Δθόζνλ έρεη νξηζηεί ε πεξηνρή κειέηεο, έθηαζεο 200 km
2
, ην επόκελν βήκα είλαη ε 

επεμεξγαζία ησλ ππνιεθαλώλ θαη ηειηθά, ε εμαγσγή ρξήζηκσλ ηνπνγξαθηθώλ 

ραξαθηεξηζηηθώλ ησλ ιεθαλώλ. Απηά επηηπγράλνληαη κε ηηο εληνιέο Basin Processing 

θαη Basin Characteristics.  

Από ην πξώην κελνύ εθαξκόζηεθε κόλν ε εληνιή Subbasin Divide, ζύκθσλα κε ηελ 

νπνία κηα ιεθάλε κπνξεί λα ρσξηζηεί ζε δύν ππνιεθάλεο ζε έλα ππάξρνλ πδαηόξεκα 
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(Doan and Fleming, 2010). Με ην εξγαιείν Subbasin Divide επηιέγνληαη δύν ζεκεία, 

ην έλα θνληά ζην ζηαζκό 4 θαη ην δεύηεξν ζην ζηαζκό 1 (Δικόνα 3.1.) ηα νπνία 

νξίδνληαη σο user points.  

 

 

 

 

 

 

 

 

 

Δικόνα 3.4. Η ηελική μοπθή ηυν ςπολεκανών και ηος ςδπογπαθικού δικηύος μελέηηρ. 

Σηε ζπλέρεηα κε ηε βνήζεηα ηνπ κελνύ Basin Characteristics ππνινγίδνληαη ηα 

ηνπνγξαθηθά ραξαθηεξηζηηθά ησλ ξεκάησλ ησλ ππνιεθαλώλ. Σπγθεθξηκέλα, ε θιίζε 

(basin slope), ην θέληξν βάξνπο (basin centroid) ηεο θάζε ππνιεθάλεο, ην κήθνο ηεο 

κέγηζηεο πδάηηλεο δηαδξνκήο (longest flowpath), ην κήθνο (river length) θαη ε θιίζε 

(river slope) ησλ πδαηνξεκάησλ. Κάπνηα από απηά ηα ραξαθηεξηζηηθά 

ζπκπιεξώλνληαη απηόκαηα ζηνλ πίλαθα ηδηνηήησλ (open the attribute table) ησλ 

ιεθαλώλ θαη ησλ ξεκάησλ, ελώ άιια όπσο ην θέληξν βάξνπο ηεο θάζε ππνιεθάλεο 

θαη ην κήθνο ηεο κέγηζηεο πδάηηλεο δηαδξνκήο θαίλνληαη θαηεπζείαλ ζην ράξηε.  

Δλδεηθηηθά παξνπζηάδνληαη ν πίλαθαο ηδηνηήησλ ησλ ζρεκαηηδόκελσλ ππνιεθαλώλ: 

 

 

 

 

 

 

 

 

 

Δικόνα 3.5. Πίνακαρ ιδιοηήηυν ηυν ςπολεκανών. 
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Σηε ζπλέρεηα αθνινπζεί, ν ππνινγηζκόο δηαθόξσλ πδξνινγηθώλ παξακέηξσλ κε ηε 

βνήζεηα ηνπ κελνύ Hydrologic Parameters. Αξρηθά, δίλεηαη ε δπλαηόηεηα επηινγήο 

ησλ κεζόδσλ πνπ ζα ρξεζηκνπνηεζνύλ ζην HEC-HMS (Select HMS Processes). 

Σπγθεθξηκέλα, ηα πξόηππα γηα ηνλ ππνινγηζκό ησλ απσιεηώλ βξνρήο, ηεο άκεζεο 

απνξξνήο, ηεο βαζηθήο ξνήο θαη ηεο δηόδεπζεο ηνπ πιεκκπξνγξαθήκαηνο. Ψζηόζν 

απηό ην βήκα παξαιείπεηαη ζην ζπγθεθξηκέλν ζηάδην, θαζώο ε επηινγή ησλ 

πξνηύπσλ κπνξεί λα γίλεη αξγόηεξα ζην HEC-HMS, όπσο παξνπζηάδεηαη παξαθάησ. 

Τέινο, δόζεθαλ νλόκαηα ζηα πδαηνξέκαηα θαη ζηηο ππνιεθάλεο μεθηλώληαο από ηα 

αλάληε πξνο ηα θαηάληε κε ην κελνύ River Auto Name θαη Basin Auto Name. 

Τν ηειεπηαίν βήκα, είλαη ε ηειηθή επεμεξγαζία ησλ αξρείσλ εηζόδνπ πξηλ ηελ 

εηζαγσγή ηνπο  ζην HEC-HMS. Απηό επηηπγράλεηαη κε κηα ζεηξά εληνιώλ ζην κελνύ 

HMS, όπσο θαίλεηαη θαη παξαθάησ: 

o Map to HMS Units   → Αληηζηνηρία ησλ κνλάδσλ ησλ δεδνκέλσλ κε κνλάδεο 

ζπκβαηέο κε ην HEC-HMS.  

o Check Data            → Διέγρεη ηελ νξζόηεηα ησλ δεδνκέλσλ. 

o  HMS Schematic   → Γεκηνπξγία ελόο απινύ πδξνγξαθηθνύ δηθηύνπ θαη 

έιεγρνο ηεο ζύλδεζεο ησλ θόκβσλ (nodes) θαη ησλ 

ζπλδέζκσλ (links). 

o HMS Legend             → Αλαπαξάζηαζε ησλ βαζηθώλ ζηνηρείσλ (ππνιεθάλεο, 

ζπλδέζκνπο, ζεκείν εμόδνπ θ.α.) κε ζύκβνια πνπ 

ρξεζηκνπνηνύληαη ζην HEC-HMS.  

o Add coordinates   → Δμαγσγή ζπληεηαγκέλσλ ζηα ζηνηρεία θόκβσλ θαη 

ζπλδέζκσλ. 

o Prepare data for model export → Απνζήθεπζε ησλ δεδνκέλσλ ππνιεθαλώλ 

θαη πδαηνξεπκάησλ ζε πίλαθεο ηδηνηήησλ γηα ηελ 

εμαγσγή ηνπ κνληέινπ ιεθάλεο (basin model file) ζην 

HEC-HMS.  

o Background Shape File → Δμαγσγή ράξηε ζπκβαηνύ ζε πεξηβάιινλ HEC-

HMS. 

o Basin Model File          → Δμαγσγή ηνπ κνληέινπ ιεθάλεο κε ηα πδξνινγηθά 

ζηνηρεία, ηε ζπλδεζηκόηεηα ηνπο θαη ηηο απαξαίηεηεο 

γεσγξαθηθέο πιεξνθνξίεο.  

o Create HEC-HMS Project → Γεκηνπξγία ελόο Project έηνηκν γηα επεμεξγαζία 

ζην HEC-HMS.  
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Να ζεκεησζεί όηη ππάξρεη δπλαηόηεηα δεκηνπξγίαο θαη κεηεσξνινγηθνύ κνληέινπ 

(Met Model File) ζην HEC-GeoHMS. Ψζηόζν, ζηελ παξνύζα εξγαζία ηα 

κεηεσξνινγηθά κνληέια δεκηνπξγήζεθαλ θαηεπζείαλ ζην HEC-HMS.  

3.3. ΤΓΡΟΛΟΓΙΚΗ ΠΡΟ΢ΟΜΟΙΩ΢Η ΛΔΚΑΝΗ΢ ΑΠΟΡΡΟΗ΢ 

3.3.1. Σο μονηέλο λεκάνηρ αποπποήρ (BASIN MODEL) 

Ζ επεμεξγαζία ηεο ιεθάλεο κειέηεο γίλεηαη πιένλ ζην πδξνινγηθό κνληέιν HEC-

HMS. Αξρηθά θνξηώλεηαη ην αξρείν ηεο ιεθάλεο απνξξνήο (basin model) όπσο έρεη 

εηνηκαζηεί από ην HEC-GeoHMS. Οη εληνιέο πνπ ρξεζηκνπνηνύληαη είλαη: 

File → Import → Basin Model 

Δπηπιένλ,  πξνζηίζεηαη θαη ν ράξηεο ππνβάζξνπ γηα κηα πην νινθιεξσκέλε εηθόλα 

επηιέγνληαο: 

 View → Background Maps → Add  

Έρνπκε ινηπόλ: 

 12 επηκέξνπο ππνιεθάλεο  

  ξέκαηα (reaches)  πνπ ζπλδένληαη κε  

 θόκβνπο  (junctions)  θαηαιήγνληαο  

 ζην ζεκείν εμόδνπ ηεο ιεθάλεο (outlet)   

όπσο θαίλεηαη θαη ζηελ παξαθάησ εηθόλα:  

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.6. Το μονηέλο λεκάνηρ αποπποήρ ζε πεπιβάλλον HEC-HMS. 
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Έηζη, γηα θάζε ππνιεθάλε δίλνληαη ζηνηρεία γηα ηελ έθηαζε ηεο, ην ηκήκα ξέκαηνο κε 

ην νπνίν ζπλδέεηαη θαηάληε θαη ηα καζεκαηηθά πξόηππα πνπ επηιέγνληαη, όπσο 

παξνπζηάδεηαη ζηελ παξαθάησ εηθόλα: 

 

Δικόνα 3.7. Τα σαπακηηπιζηικά ζηοισεία ηυν ςπολεκανών. 

Σηε ζπλέρεηα γίλεηαη ε επηινγή ησλ πξνηύπσλ: 

 ππνινγηζκνύ απσιεηώλ βξνρήο 

 ππνινγηζκνύ άκεζεο απνξξνήο 

 ππνινγηζκνύ βαζηθήο απνξξνήο 

 δηόδεπζεο πιεκκπξνγξαθήκαηνο  

Οη επηινγέο γίλνληαη ράξηλ επθνιίαο καδηθά γηα όιεο ηηο ππνιεθάλεο από ην κελνύ 

Parameters → Loss / Transform/ Baseflow/ Routing αληίζηνηρα.  

3.3.1.1. Σο ππόηςπο ςπολογιζμού απωλειών βποσήρ 

Ζ άκεζε απνξξνή πξνθαιείηαη από ηελ ελεξγό βξνρόπησζε αθνύ έρνπλ αθαηξεζεί 

από ην ζπλνιηθό όγθν βξνρήο νη πδξνινγηθέο απώιεηεο. Ζ εκθάληζε ησλ απσιεηώλ 

εμαξηάηαη θαη από ηε ρξνληθή θιίκαθα πνπ εμεηάδεηαη. Σε κεγάιε ρξνληθή θιίκαθα 

π.ρ. εηήζηα, ηα ειιείκκαηα πνπ πξνθύπηνπλ από ηελ πνζόηεηα πνπ βξέρεη κε ηελ 

πνζόηεηα πνπ ηειηθά ζα απνξξεύζεη νθείινληαη ζηελ εμάηκηζε θαη ζηε δηαπλνή. 

Όηαλ όκσο εμεηάδνληαη επεηζόδηα βξνρόπησζεο ζε κηθξή ρξνληθή θιίκαθα π.ρ. 

εκεξήζηα, ε ζπλεηζθνξά ησλ παξαπάλσ δηεξγαζηώλ ζεσξείηαη ακειεηέα. Οη 

δηεξγαζίεο πνπ ιακβάλνπλ ρώξα ζε απηήλ ηελ πεξίπησζε είλαη ε θαηαθξάηεζε από 

ηε θπηνθάιπςε, ε δηήζεζε θαη ε επηθαλεηαθή απνζήθεπζε.   

Ζ πνζνηηθή εθηίκεζε ησλ απσιεηώλ βξνρήο, είλαη έλα δύζθνιν πξόβιεκα θαζώο 

εμαξηάηαη από ηα ραξαθηεξηζηηθά ηεο ιεθάλεο απνξξνήο θαη από ηα ραξαθηεξηζηηθά 

ηεο βξνρήο. Τν ηξνρνπέδε ζηνλ ππνινγηζκό απηό παξακέλεη ε αλνκνηνγέλεηα ζηα 

θπζηνγξαθηθά ραξαθηεξηζηηθά (γεσκνξθνινγία, ηύπνη εδαθώλ, ρισξίδα) ηεο 
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ιεθάλεο, επεξεάδνληαο ηηο αληίζηνηρεο πδξνινγηθέο δηεξγαζίεο (Κνπηζνγηάλλεο θαη 

Ξαλζόπνπινο 1999). 

Ζ απινύζηεξε κέζνδνο ππνινγηζκνύ ηεο ελεξγνύ βξνρόπησζεο είλαη η μέθοδορ ηος 

ζςνηελεζηή αποπποήρ όπσο ρξεζηκνπνηείηαη ζηελ νξζνινγηθή κέζνδν, ε νπνία 

κεηαζρεκαηίδεη ηε βξνρή ζε απνξξνή κε ηελ απιή ζρέζε Q ciA . Ψζηόζν ε κέζνδνο 

απηή είλαη επαξθήο κόλν ζηελ πεξίπησζε πνπ ε βξνρή έρεη νκνηόκνξθε έληαζε ζε 

όιε ηε δηάξθεηα ηεο. Μηα θαιύηεξε πξνζέγγηζε γηα βξνρή ρξνληθά αλνκνηόκνξθεο 

έληαζεο είλαη η μέθοδορ ηος δείκηη ολικών απυλειών θ. Σύκθσλα κε απηήλ, νη 

απώιεηεο πξαγκαηνπνηνύληαη κε ρξνληθά ζηαζεξό ξπζκό, κεγέζνπο θ. Σεκεηώλεηαη 

όηη, νη κέζνδνη απηέο είλαη ηζνδύλακέο γηα ρξνληθά νκνηόκνξθε βξνρόπησζε 

(Κνπηζνγηάλλεο, 2011). 

Ζ πην ξεαιηζηηθή κέζνδνο γηα ηνλ ππνινγηζκό ησλ απσιεηώλ βξνρήο, απνηειεί ε 

κέζνδνο ησλ Ζ.Π.Α. Soil Conservation Service (SCS), ε νπνία επηιέρηεθε σο ην 

πξόηππν ππνινγηζκνύ ησλ απσιεηώλ ζηελ παξνύζα εξγαζία. Ζ κέζνδνο θαηαιήγεη 

ζηελ αθόινπζε ζρέζε (Κνπηζνγηάλλεο, 2011): 

 

 (3.1) 

 

όπνπ P ην νιηθό ύςνο βξνρήο (mm) ζε κηα ηπραία ρξνληθή ζηηγκή, ην νπνίν 

ππνινγίδεηαη αζξνηζηηθά από ηελ έλαξμε ηεο βξνρήο, Η ην ύςνο ηεο ελεξγνύο 

βξνρόπησζεο (mm) ζηελ ίδηα ρξνληθή ζηηγκή θαη S παξάκεηξνο κέγηζηεο δπλεηηθήο 

θαηαθξάηεζεο (mm). Ζ παξαπάλσ ζρέζε αλαπαξηζηά ην θαηλόκελν κεηαηξνπήο ηεο 

βξνρήο ζε απνξξνή κε κεγαιύηεξε αθξίβεηα από όηη νη κέζνδνη πνπ ζηεξίδνληαη ζε 

δείθηεο απσιεηώλ, ζηαζεξνύο ζην ρξόλν (δείθηε θ) ή κεηαβιεηνύο (π.ρ. εθζεηηθήο 

κείσζεο). Ζ ζρέζε απηή ππνινγίδεη ην ηειηθό ύςνο βξνρήο αιιά θαη ηηο ελδηάκεζεο 

ηηκέο ηνπ θη έηζη πξνθύπηεη ε ρξνληθή εμέιημε ηνπ θαηλνκέλνπ.  

Σην κνληέιν πνπ αληηπξνζσπεύεη ε παξαπάλσ ζρέζε ζεσξείηαη όηη έλα αξρηθό ύςνο 

βξνρήο, ίζν κε 0.2S, κεηαηξέπεηαη ζε απώιεηεο (αξρηθή θαηαθξάηεζε) ρσξίο λα 

πξαγκαηνπνηεζεί απνξξνή. Μεηά ην πέξαο ηνπ ρξνληθνύ απηνύ δηαζηήκαηνο θαη 

θαζώο εμειίζζεηαη ε θαηαηγίδα, ην κνληέιν ζεσξεί όηη κπνξεί λα κεηαηξαπεί ζε 

απώιεηεο κηα πξόζζεηε πνζόηεηα βξνρήο, ην πνιύ ίζε κε ηελ παξάκεηξν S. Σπλεπώο, 

ην νιηθό ύςνο ησλ απσιεηώλ βξνρήο κπνξεί λα θηάζεη έσο 1.2S. 

Ζ παξάκεηξνο S ζπλδέεηαη κε κηα άιιε ραξαθηεξηζηηθή παξάκεηξν,                                                                                                                                                               

ηνλ απιθμό καμπύληρ αποπποήρ CN (curve number). Ζ παξάκεηξνο απηή εμαξηάηαη 

από ην γεσινγηθό ηύπν (δηαπεξαηόηεηα εδάθνπο), ηηο ρξήζεηο γεο θαη ηηο 

πξνεγνύκελεο ζπλζήθεο εδαθηθήο πγξαζίαο. Δίλαη έλαο αξηζκόο πνπ παίξλεη ηηκέο 
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από ην 0 κέρξη ην 100 θαη ζπλδέεηαη κε ηε κέγηζηε δπλεηηθή θαηαθξάηεζε S κε ηε 

ζρέζε: 

 (3.2) 

Σηελ πεξίπησζε πνπ είλαη γλσζηό ην ελεξγό ύςνο βξνρήο (ζρέζε 3.1) είλαη δπλαηόο ν 

ππνινγηζκόο ηεο παξακέηξνπ S. Όηαλ όκσο δελ ππάξρνπλ δεδνκέλα απνξξνήο ε 

παξάκεηξνο απηή ππνινγίδεηαη εκκέζσο κέζσ ηνπ αξηζκνύ CN. Σπλεπώο, ην επόκελν 

βήκα είλαη ν ππνινγηζκόο ηνπ αξηζκνύ CN. 

3.3.1.2. Τπολογιζμόρ ηος απιθμού καμπύληρ αποπποήρ CN 

Έρνληαο επηιέμεη ηε κέζνδν SCS γηα ηνλ ππνινγηζκό ησλ απσιεηώλ βξνρήο, ην 

επόκελν βήκα είλαη ν ππνινγηζκόο ηνπ αξηζκνύ CN. Όπσο έρεη ήδε αλαθεξζεί, ε 

παξάκεηξνο CN επεξεάδεηαη από ηνλ ηύπν εδάθνπο, ηηο ρξήζεηο γεο ζηε ιεθάλε 

απνξξνήο, θαη από ηηο πξνεγνύκελεο ζπλζήθεο εδαθηθήο πγξαζίαο, θαη παίξλεη ηηκέο 

από 0 έσο 100. 

Ζ κέζνδνο απηή θαηαηάζζεη αξρηθά ηα εδάθε ζε 3 ηύπνπο πποηγούμενυν ζςνθηκών 

ςγπαζίαρ, νη νπνίνη είλαη (Κνπηζνγηάλλεο θαη Ξαλζόπνπινο, 1999): 

Τύπορ Ι:  Ξεξέο ζπλζήθεο (εδάθε μεξά, αιιά πάλσ από ην ζεκείν καξαζκνύ). 

Αληηζηνηρνύλ ζηελ πεξίπησζε πνπ ε βξνρόπησζε ησλ πξνεγνύκελσλ 

5 εκεξώλ είλαη κηθξόηεξε από 13 mm (ή 35 mm γηα πεξηνρή κε 

θπηνθάιπςε ζε ζπλζήθεο αλάπηπμεο).  

Τύπορ ΙΙ:  Μέζεο ζπλζήθεο. Αληηζηνηρνύλ ζηελ πεξίπησζε πνπ ε βξνρόπησζε 

ησλ πξνεγνύκελσλ 5 εκεξώλ είλαη κηθξόηεξε από 13 θαη 38 mm (ή 

κεηαμύ 35 θαη 53 mm γηα πεξηνρή κε θπηνθάιπςε ζε ζπλζήθεο 

αλάπηπμεο).  

Τύπορ ΙΙΙ: Υγξέο ζπλζήθεο (εδάθε ζρεδόλ θνξεζκέλα). Αληηζηνηρνύλ ζηελ 

πεξίπησζε πνπ ε βξνρόπησζε ησλ πξνεγνύκελσλ 5 εκεξώλ είλαη 

κεγαιύηεξε από 38 mm (ή κεγαιύηεξε από 53 mm γηα πεξηνρή κε 

θπηνθάιπςε ζε ζπλζήθεο αλάπηπμεο). 

Γηα ηνλ ηύπν II ε κέζνδνο SCS δίλεη ηηκέο γηα ηνλ αξηζκό CN αλάινγα κε ηηο ρξήζεηο 

γεο θαη ηνπο γεσινγηθνύο ζρεκαηηζκνύο ηνπ εδάθνπο. Γηα ηνπο άιινπο δύν ηύπνπο νη 

αξηζκνί CN ππνινγίδνληαη ζπλαξηήζεη ηνπ αξηζκνύ IICN  όπσο θαίλεηαη αθνινύζσο: 

   

(3.3) 

 

          (3.4) 

0.42

1 0.0058

II
I

II

CN
CN

CN




2.3

1 0.013

II

II

CN
CN

CN
 



100
254 1S

CN

 
  

 



Κεθάλαιο 3: Υδπολογική πποζομοίυζη λεκάνηρ αποπποήρ 

 35 

Σηελ παξνύζα εξγαζία, ζεσξείηαη όηη ηζρύεη ν δεύηεξνο ηύπνο πξνεγνύκελσλ 

ζπλζεθώλ πγξαζίαο. 

Ο δεύηεξνο δηαρσξηζκόο πνπ γίλεηαη ζηε κέζνδν απηή είλαη ζπλαξηήζεη ηυν σπήζευν 

γηρ. Αξρηθά, νη ρξήζεηο γεο πνπ εκθαλίδνληαη ζηε ιεθάλε κειέηεο θαηαηάζζνληαη ζε 

πέληε γεληθεπκέλεο θαηεγνξίεο: 

Πίνακαρ 3.1. Γενικεςμένη καηηγοπιοποίηζη σπήζευν γηρ 

Καηεγνξία 1 2 3 4 5 

Φξήζε γεο 
Καιιηεξγεκέλε 

έθηαζε 
Ληβάδηα Γάζε 

Αζηηθή 

πεξηνρή 
Γξόκνη 

 Σηε ζπλέρεηα γίλεηαη αληηζηνίρεζε ησλ ρξήζεσλ γεο (corine) πνπ εκθαλίδνληαη ζηε 

ιεθάλε κειέηεο κε ηηο παξαπάλσ θαηεγνξίεο θαη πξνθύπηεη  ν αθόινπζνο πίλαθαο 

(Γαιηνπλά, 2011) θαη αθνινύζσο, ν αληίζηνηρνο ράξηεο κε ηηο ρξήζεηο γεο (Φάπηηρ 

3.1).  

 

 

Φάπηηρ 3.1. Οι σπήζειρ γηρ ζηην πεπιοσή μελέηηρ. 
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Πίνακαρ 3.2. Καηηγοπιοποίηζη ηυν σπήζευν γηρ για ηον ςπολογιζμό ηος απιθμού CN 

ζηη λεκάνη μελέηηρ.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ο ηξίηνο θαη ηειεπηαίνο δηαρσξηζκόο γίλεηαη κε βάζε ηε διαπεπαηόηηηα ησλ εδαθώλ, 
ζε 4 νκάδεο.  

Πίνακαρ 3.3. Καηάηαξη εδαθών ανάλογα με ηη διαπεπαηόηηηα ηοςρ (Πηγή: 

Κοςηζογιάννηρ και Ξανθόποςλορ, 1999). 

Οκάδα Α: Δδάθε κε κεγάινπο ξπζκνύο δηήζεζεο, π.ρ. ακκώδε θαη ραιηθώδε κε πνιύ 

κηθξό πνζνζηό ηιύνο θαη αξγίινπ. 

Οκάδα Β: Δδάθε κε κέζνπο ξπζκνύο δηήζεζεο, π.ρ. ακκώδεο πειόο. 

Οκάδα C: Δδάθε κε κηθξνύο ξπζκνύο δηήζεζεο, π.ρ. εδάθε από αξγηινπειό, εδάθε 

κε ζεκαληηθό πνζνζηό αξγίινπ, εδάθε θησρά ζε νξγαληθό πιηθό. 

Οκάδα D: Δδάθε κε πνιύ κηθξνύο ξπζκνύο δηήζεζεο, π.ρ. εδάθε πνπ δηνγθώλνληαη 

ζεκαληηθά όηαλ δηαβξαρνύλ, πιαζηηθέο άξγηινη. Σηελ ίδηα νκάδα 

Κωδικόρ corine Υπήζειρ γηρ Καηηγοπία 

112 Γηαθεθνκκέλε αζηηθή δόκεζε 4 

121 Βηνκεραληθέο ή εκπνξηθέο δώλεο 5 

122 Οδηθά θαη ζηδεξνδξνκηθά δίθηπα 5 

124 Εώλεο αεξνδξνκίσλ 5 

131 Φώξνη εμόξπμεο νξπθηώλ 4 

133 Φώξνη νηθνδόκεζεο 4 

211 Με αξδεύζηκε γε 1 

221 Ακπειώλεο 1 

223 Διαηώλεο 1 

231 Ληβάδηα 2 

242 Σύλζεηα ζπζηήκαηα θαιιηέξγεηαο 1 

243 
Γε θαιππηόκελε από γεσξγία θαη 

θπζηθή βιάζηεζε 
1 

312 Γάζνο θσλνθόξσλ 3 

321 Φπζηθνί βνζθόηνπνη 2 

323 Σθιεξνθπιιηθή βιάζηεζε 2 

324 Γαζώδεηο- ζακλώδεηο εθηάζεηο 2 
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πεξηιακβάλνληαη εδάθε κηθξνύ βάζνπο κε ζρεδόλ αδηαπέξαηνπο ππν-

νξίδνληεο θνληά ζηελ επηθάλεηα.  

Αθνινύζσο, δίλνληαη νη ηππηθνί αξηζκνί CN ζπλδπάδνληαο ηηο ρξήζεηο γεο κε ηνλ 

πδξνινγηθό ηύπν εδαθώλ. 

Πίνακαρ 3.4. Δύπορ ηιμών καμπύληρ αποπποήρ CN για κάθε σπήζη γηρ και ηύπο 

εδάθοςρ (Κοςηζογιάννηρ και Ξανθόποςλορ, 1999) 

 

 

 

 

 

 

Τειηθά, πξνθύπηεη ν πίλαθαο κε ηηο ηηκέο ηνπ αξηζκνύ CN, όπσο ρξεζηκνπνηνύληαη 

ζηελ παξνύζα εξγαζία: 

Πίνακαρ 3.5. Απιθμοί καμπύλη αποπποήρ για κάθε σπήζη γηρ και ηύπο εδάθοςρ πος 

σπηζιμοποιούνηαι ζηην επγαζία.  

  Α Β-C D 

1 Και. Έθηαζε 67 80 86 

2 Ληβάδηα 49 74 84 

3 Γάζε 35 68 80 

4 Αζηηθή πεξηνρή 64 81 88 

5 Γξόκνη 85 92 94 

Αλαιπηηθά ε δηαδηθαζία ππνινγηζκνύ ηνπ αξηζκνύ θακπύιεο απνξξνήο έρεη σο εμήο. 

Γηα θάζε ππνιεθάλε ζα ππνινγηζηεί θαη έλαο αξηζκόο CN. Ζ δηαδηθαζία ππνινγηζκνύ 

γίλεηαη κε ηε βνήζεηα ηνπ πξνγξάκκαηνο ArcGis. Αθνινπζνύληαη ηα παξαθάησ 

βήκαηα: 

1. Πξνζζήθε ελόο λένπ πεδίνπ (type) ζηνλ πίλαθα ηδηνηήησλ (attribute table) ηνπ 

ράξηε ρξήζεσλ γεο (corine), πνπ ζπκπιεξώλεηαη κε ηνλ ηύπν (1,2,3,4 θαη 5)  

ησλ γεληθεπκέλσλ θαηεγνξηώλ (θαι.έθηαζε, ιηβάδηα θ.ιπ.), όπσο 

παξνπζηάδνληαη ζηνλ Πίνακα 3.1. 

Πεπιγπαθή σπήζηρ γηρ Τδπολογικόρ ηύπορ εδάθοςρ  

 Α Β C D 

Καιιηεξγεκέλεο εθηάζεηο 62-72 71-81 78-88 81-91 

Ληβάδηα, βνζθόηνπνη 30-68 58-79 71-86 78-89 

Γάζε 22-45 55-66 70-77 77-83 

Αζηηθέο πεξηνρέο 51-77 68-85 79-90 84-92 

Γξόκνη 72-98 82-98 87-98 89-98 



Κεθάλαιο 3: Υδπολογική πποζομοίυζη λεκάνηρ αποπποήρ 

 38 

2. Έλσζε ηνπ ράξηε ρξήζεσλ γεο (corine) κε ην ράξηε πνπ δίλεη ηνπο 

πδξνιηζνινγηθνύο ηύπνπο εδαθώλ (geology) γηα ηελ εκθάληζε ελόο ηειηθνύ 

ράξηε κε πίλαθα ηδηνηήησλ πνπ ζα πεξηιακβάλεη ηα ραξαθηεξηζηηθά θαη ησλ 

δύν. Απηό επηηπγράλεηαη κε ηελ εληνιή Intersect από ηελ εξγαιεηνζήθε 

Arctoolbox ηνπ ArcMap. Σηνλ ηειηθό απηό πίλαθα πξνζηίζεηαη έλα λέν πεδίν 

πνπ ζπκπιεξώλεηαη από ην ρξήζηε κε ηνπο αξηζκνύο CN όπσο πξνθύπηνπλ 

από ηνλ ηειηθό Πίνακα 3.5. 

3. Με ηελ εληνιή clip από ηελ εξγαιεηνζήθε Arctoolbox ηνπ ArcMap, 

«θόβεηαη» ν αξρηθόο ελσκέλνο ράξηεο (corine θαη geology) ζε θάζε 

ππνιεθάλε.  

4. Γηα θάζε ηύπν εδάθνπο (Α, Β-C, D) θαη γηα θάζε ρξήζε γεο αληηζηνηρεί έλαο 

αξηζκόο CN. Υπνινγίδνληαη ινηπόλ ηα πνζνζηά έθηαζεο ηεο θάζε ρξήζεο γεο 

ζε ζπλδπαζκό κε ηνλ γεσινγηθό ηύπν εδάθνπο ζηελ  ππνιεθάλε. 

Πνιιαπιαζηάδνληαη ηα πνζνζηά απηά κε ηνλ αληίζηνηρν αξηζκό CN (Πίνακαρ 

3.5) θαη ην άζξνηζκα απηώλ δίλεη ηνλ ηειηθό αξηζκό CN ηεο ππνιεθάλεο.  

Σεκεηώλεηαη όηη, πξηλ ηελ ηειηθή κνξθή ηνπ πίλαθα ηδηνηήησλ, όπσο παξνπζηάδεηαη 

παξαθάησ, έγηλε κηα απινπνίεζε ράξηλ επθνιίαο ησλ ππνινγηζκώλ. Ζ εληνιή 

dissolve από ηελ εξγαιεηνζήθε Arctoolbox ηνπ ArcMap, αζξνίδεη ζηνηρεία κε βάζε 

ζπγθεθξηκέλεο ηδηόηεηεο. Δδώ, επηιέρζε λα πξνζηεζνύλ όζα ζηνηρεία έρνπλ ηνλ ίδην 

αξηζκό CN. Έηζη πξνθύπηεη ν αθόινπζνο πίλαθαο γηα κηα ηπραία ιεθάλε απνξξνήο 

(17): 

 

 

Δικόνα 3.8. Ο πίνακαρ ιδιοηήηυν ηηρ ςπολεκάνηρ 17 με ηοςρ ανηίζηοισοςρ απιθμούρ 

CN. 

0.3*35+ 0.58*49 +0.01*64 + 0.06*67 +0.01*68 + 0.01*74 + 0.02*80 = 47  

Ζ ίδηα δηαδηθαζία εθηειείηαη γηα όιεο ηηο ππνιεθάλεο.  

Δθηόο από ηνλ αξηζκό CN δεηείηαη ζην πξόγξακκα HEC-HMS θαη ην πνζνζηό ηεο 

αδηαπέξαηεο επηθάλεηαο πνπ ππάξρεη ζε θάζε ππνιεθάλε. Έηζη ζπκπιεξώλεηαη ν 
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αθόινπζνο πίλαθαο ησλ απαξαίηεησλ δεδνκέλσλ γηα ηνλ ππνινγηζκό ηνπ πξνηύπνπ 

απσιεηώλ βξνρήο: 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα  3.9. Οι απιθμοί CN και ηα ποζοζηά αδιαπέπαηηρ επιθάνειαρ ζε κάθε 

ςπολεκάνη.  

Σην πεδίν initial abstraction, δίλεηαη ε δπλαηόηεηα εηζαγσγήο ελόο αξρηθνύ 

ειιείκκαηνο. Αλ απηό δελ ζπκπιεξσζεί, όπσο εδώ, ην πξόγξακκα ζεσξεί όηη ην 

αξρηθό έιιεηκκα ηζνύηαη κε ην 20% ηεο κέγηζηεο δπλεηηθήο θαηαθξάηεζεο, όπσο 

πξνθύπηεη θαη από ηε βαζηθή ζρέζε ππνινγηζκνύ ηνπ ελεξγνύ ύςνπο βξνρήο (βι. 

ζρέζε 3.1) 

3.3.1.3. Σο ππόηςπο ςπολογιζμού άμεζηρ αποπποήρ 

Γηα ην πξόηππν ππνινγηζκνύ άκεζεο απνξξνήο, επηιέρζεθε λα ρξεζηκνπνηεζεί ην 

κνλαδηαίν πδξνγξάθεκα νξηδόκελν από ην ρξήζηε (user specified Unit Hydrograph).  

Ζ ελεξγόο βξνρόπησζε είλαη εθείλν ην ηκήκα ηεο νιηθήο βξνρήο πνπ κεηαηξέπεηαη ζε 

απνξξνή. Τν ελδηαθέξνλ έγθεηηαη ζηε κεηαηξνπή ηεο βξνρήο  ζε απνξξνή. Ψζηόζν, ε 

αλνκνηόκνξθε ρσξηθή θαη ρξνληθή θαηαλνκή ηεο βξνρόπησζεο ζηε ιεθάλε 

απνξξνήο παξαθσιύνπλ ηε ζπζρέηηζε απηή. Γηα ην ιόγν απηό έρνπλ αλαπηπρζεί 

ζεσξίεο θαη καζεκαηηθά κνληέια πνπ λα κεηαηξέπνπλ ηε βξνρόπησζε ζε άκεζε 

απνξξνή, πξνζδηνξίδνληαο ηε ρξνληθή δηάξθεηα ηεο άκεζεο απνξξνήο, ην ρξόλν πνπ 

ζα θηάζεη ε παξνρή αηρκήο θαζώο θαη ηελ ηηκή ηεο (Γθηόθαο, 2009). Από ηε κηα, 

ππάξρεη ε επηινγή ησλ κνληέισλ θπζηθήο βάζεο όπσο είλαη ην κνληέιν ηνπ 

θηλεκαηηθνύ θύκαηνο (kinematic wave) βαζηζκέλν ζηηο ζεκειηώδεηο εμηζώζεηο ηεο 
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πδξαπιηθήο θαη από ηελ άιιε κνληέια πνπ ζηεξίδνληαη ζηε ζεσξία ηνπ κνλαδηαίνπ 

πδξνγξαθήκαηνο (Νηναλίδεο, 2007).   

Ψο μοναδιαίο ςδπογπάθημα ζεσξείηαη ην πδξνγξάθεκα ηεο άκεζεο απνξξνήο πνπ 

πξνέξρεηαη από ελεξγό βξνρόπησζε, ζηαζεξήο έληαζεο, ύςνπο 10 mm νκνηόκνξθα 

θαηαλεκεκέλνπ ζε όιε ηελ έθηαζε ηεο ιεθάλεο.  

Ζ ζεσξία ηνπ κνλαδηαίνπ πδξνγξαθήκαηνο βαζίδεηαη ζηηο εμήο παξαδνρέο 

(Μακάζεο, 2011): 

 Σε κηα ζπγθεθξηκέλε πδξνινγηθή ιεθάλε, βξνρέο ίζεο δηάξθεηαο πνπ 

πξνθαινύλ απνξξνή, δίλνπλ πδξνγξαθήκαηα άκεζεο απνξξνήο κε ηελ ίδηα 

πεξίπνπ ρξνληθή βάζε αλεμάξηεηα από ηελ έληαζε ηεο βξνρήο. 

 Σε  κηα δεδνκέλε πδξνινγηθή ιεθάλε, ε άκεζε απνξξνή πνπ πξνθαιείηαη από 

κηα ζπγθεθξηκέλε βξνρή δελ εμαξηάηαη από ηηο πξνεγνύκελεο βξνρέο.  

 Ζ θαηάζηαζε ηεο πδξνινγηθήο ιεθάλεο παξακέλεη ρξνληθά ακεηάβιεηε.  

Δπίζεο, νη βαζηθέο αξρέο ζηηο νπνίεο ζηεξίδεηαη ε κέζνδνο ηνπ κνλαδηαίνπ 

πδξνγξαθήκαηνο είλαη η απσή ηηρ επαλληλίαρ θαη η απσή ηηρ αναλογίαρ. Σύκθσλα κε 

ηελ πξώηε, ην ζπλνιηθό πδξνγξάθεκα απνξξνήο πνπ πξνθύπηεη από δηαδνρηθέο 

βξνρνπηώζεηο, είλαη ην πδξνγξάθεκα κε παξνρέο πνπ ηζνύληαη κε ην άζξνηζκα ησλ 

παξνρώλ ησλ επηκέξνπο βξνρνπηώζεσλ.  Σύκθσλα κε ηε δεύηεξε, δύν ελεξγέο 

βξνρέο ηεο ίδηαο δηάξθεηαο αιιά δηαθνξεηηθήο έληαζεο δίλνπλ πδξνγξαθήκαηα 

απνξξνήο κε ηελ ίδηα ρξνληθή βάζε, ελώ ζε θάζε ρξνληθή ζηηγκή ν ιόγνο ησλ 

παξνρώλ είλαη ίζνο κε ην ιόγν ησλ εληάζεσλ.  

Τν ζπλζεηηθό κνλαδηαίν πδξνγξάθεκα ρξεζηκνπνηείηαη ζηηο πεξηπηώζεηο όπνπ δελ 

ππάξρνπλ δεδνκέλα κεηξήζεσλ από πξαγκαηηθά επεηζόδηα βξνρήο. Σηελ πεξίπησζε 

απηή, ην κνλαδηαίν πδξνγξάθεκα κπνξεί λα ππνινγηζηεί ζπλζεηηθά από ηα 

γεσκεηξηθά ραξαθηεξηζηηθά ηεο ιεθάλεο απνξξνήο. Σηε κειέηε απηή ε κέζνδνο πνπ 

επηιέρζεθε γηα ηε ζύλζεζε ηνπ κνλαδηαίνπ πδξνγξαθήκαηνο είλαη ηνπ Βπεηανικού 

Ινζηιηούηος Υδπολογίαρ.  

Ζ κέζνδνο ηνπ Βπεηανικού Ινζηιηούηος Υδπολογίαρ 

Ζ κέζνδνο απηή, ρξεζηκνπνηεί ηνπνγξαθηθά θαη πδξνινγηθά ραξαθηεξηζηηθά ηεο 

ιεθάλεο, θαζώο θαη δεδνκέλα θιίζεσλ πνπ πξνθύπηνπλ από ηε κεθνηνκή ηνπ θύξηνπ 

πδαηνξεύκαηνο. Σπληζηά ηε ζύλζεζε ηξηγσληθνύ πδξνγξαθήκαηνο γηα δηάξθεηα 

βξνρήο d= 1h. Ο ρξόλνο αλόδνπ tp ηνπ πδξνγξαθήκαηνο ππνινγίδεηαη ζπλαξηήζεη 

ησλ ραξαθηεξηζηηθώλ ηεο ιεθάλεο από ηε ζρέζε: 

                                                                                                      

 (3.5) 

0.14
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tp  ρξόλνο αλόδνπ ζε h 

Qp παξνρή αηρκήο ζε m3/s 

tb  ρξόλνο βάζεο ζε h 

L  κήθνο θύξηνπ πδαηνξεύκαηνο ζε km 

0.38

0.1* 0.85*L LS         ε κέζε θιίζε πδαηνξεύκαηνο κεηαμύ ησλ ζεκείσλ 10% θαη 85% ηνπ 

κήθνπο ηνπ ζε m/km 

URBAN  αλαινγία αζηηθώλ πεξηνρώλ ζηε ιεθάλε απνξξνήο 

RMSD  παξάκεηξνο κεγέζνπο βξνρνπηώζεσλ ζε mm (πξαθηηθά ππνινγίδεηαη 

σο ην ύςνο 24ώξεο βξνρήο πνπ αληηζηνηρεί ζε πεξίνδν επαλαθνξάο 5 

εηώλ) 

A             έθηαζε ιεθάλεο απνξξνήο ζε km
2
 

Ο ρξόλνο βάζεο tb δίλεηαη από ηε ζρέζε:        

 (3.6) 

Δμ νξηζκνύ ην κνλαδηαίν πδξνγξάθεκα πξνέξρεηαη από ελεξγό βξνρή ύςνπο h=10 

mm. Δθαξκόδνληαο ινηπόλ ηελ εμίζσζε ζπλέρεηαο (όγθνο πεηνγξαθήκαηνο= όγθνο 

πιεκκπξνγξαθήκαηνο), ε παξνρή αηρκήο Qp πξνθύπηεη από ηελ αθόινπζε ζρέζε:  

        (3.7) 

 

Ζ κέζνδνο ηνπ Βπεηανικού Ινζηιηούηος Υδπολογίαρ, δίλεη κνλαδηαίν πδξνγξάθεκα γηα 

δηάξθεηα βξνρήο d= 1h. Ψζηόζν, ηα επεηζόδηα βξνρήο πνπ ρξεζηκνπνηήζεθαλ, όπσο 

αλαιπηηθά αλαθέξνληαη παξαθάησ, είλαη εκεξήζηα, ρξνληθνύ βήκαηνο d= 15 min. Γηα 

λα γίλεη ινηπόλ ε πξνζαξκνγή απηή ώζηε λα παξαρζνύλ κνλαδηαία πδξνγξαθήκαηα 

15 min, ν ρξόλνο αλόδνπ tp ππνινγίζηεθε από ηε ζρέζε: 

    (3.8) 

όπνπ tc ν ρξόλνο ζπγθέληξσζεο θαη d= 15 min. 

Σεκεηώλεηαη όηη, ζηνπο ππνινγηζκνύο γηα ηε ζύλζεζε ηνπ κνλαδηαίνπ 

πδξνγξαθήκαηνο, ν ρξόλνο αλόδνπ tp θαη ν ρξόλνο βάζεο tb ζηξνγγπινπνηήζεθαλ έηζη 

ώζηε λα είλαη αθέξαηα πνιιαπιάζηα ηνπ ρξνληθνύ βήκαηνο d.  

Ο ρξόλνο ζπγθέληξσζεο tc ππνινγίζηεθε από ηνλ ηύπν ηνπ Giandotti: 

                                   (3.9) 
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A (km
2
)   έθηαζε ηεο ιεθάλεο 

L (km)    ην κήθνο ηνπ θπξίνπ πδαηνξεύκαηνο  

ΓH (m)    ε δηαθνξά ηνπ κέζνπ πςνκέηξνπ ιεθάλεο από ην πςόκεηξν ζηελ έμνδν 

Καηά απηόλ ηνλ ηξόπν, ππνινγίζηεθαλ ηα κνλαδηαία πδξνγξαθήκαηα γηα θάζε 

ππνιεθάλε. Αξρηθά, γηα ηελ επηινγή ηεο κεζόδνπ ζην πξόγξακκα HEC-HMS 

αθνινπζήζεθε ε ζεηξά εληνιώλ: 

 Parameters →Transform→ User-Specified Unit Hydrograph  

Ζ εηζαγσγή ησλ κνλαδηαίσλ πδξνγξαθεκάησλ έγηλε ππό ηε κνξθή δεπγώλ 

δεδνκέλσλ (paired data) επηιέγνληαο: 

Components → Paired Data Manager → New → Unit Hydrograph Curves  

Ζ εηζαγσγή ησλ ηηκώλ έγηλε ρεηξνθίλεηα (manual entry) από ππνινγηζηηθό θύιιν ηνπ 

excel. Δλδεηθηηθά παξνπζηάδεηαη ην κνλαδηαίν πδξνγξάθεκα κηαο ηπραίαο ιεθάλεο:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.10. Οι ηιμέρ ηος μοναδιαίος ςδπογπαθήμαηορ μιαρ ηςσαίαρ λεκάνηρ (W140) 

ζε πεπιβάλλον HEC-HMS. 

Καη ην αληίζηνηρν δηάγξακκα ηνπ ζπγθεθξηκέλνπ κνλαδηαίνπ πδξνγξαθήκαηνο είλαη: 
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Δικόνα 3.11. Το μοναδιαίο ςδπογπάθημα ηηρ λεκάνηρ W140. 

Μηα ζεκαληηθή παξαηήξεζε είλαη όηη νη ηηκέο ησλ παξνρώλ ησλ ΜΥ εηζήρζεζαλ ζην 

πξόγξακκα HEC-HMS αθνύ ηξνπνπνηήζεθαλ έηζη ώζηε λα ππάξρεη ζπκθσλία ζηνπο 

όγθνπο ησλ ΜΥ θαη ησλ εμαγόκελσλ πιεκκπξνγξαθεκάησλ ζε θάζε ππνιεθάλε. Σηα 

ηειηθά απνηειέζκαηα, ππήξραλ κελύκαηα πξνεηδνπνίεζεο γηα πνιύ κεγάιεο δηαθνξέο 

κεηαμύ ησλ παξαπάλσ όγθσλ, πξηλ από ηηο κεηαηξνπέο.  

3.3.1.4. Σο ππόηςπο ςπολογιζμού βαζικήρ ποήρ 

Γύν είλαη νη ζπληζηώζεο ηεο επηθαλεηαθήο απνξξνήο, ε άκεζε απνξξνή θαη ε βαζηθή 

ξνή. Ζ άκεζε απνξξνή ζρεηίδεηαη επζέσο κε ηελ ελεξγό βξνρόπησζε. Δλώ ε βαζηθή 

ξνή, είλαη έλα ζύλνιν πξνεγνύκελσλ θαηαθξεκληζκάησλ απνζεθεπκέλσλ πξνζσξηλά 

ζηε ιεθάλε απνξξνήο θαη ηεο ππόγεηαο απνξξνήο ηεο ηξέρνπζαο βξνρόπησζεο.   

Σηελ αλάιπζε ελόο πδξνγξαθήκαηνο, ην νπνίν πεξηιακβάλεη ηελ άκεζε θαη ηε 

βαζηθή απνξξνή, παξαηεξείηαη όηη ε βαζηθή ξνή είλαη δηαξθήο, θαζ’ όιε ηε δηάξθεηα 

ηνπ επεηζνδίνπ βξνρήο, ελώ ε άκεζε απνξξνή αλέξρεηαη κέρξη ηελ παξνρή αηρκήο, 

θαη ζηγά ζηγά θζίλεη κέρξη λα θηάζεη ηε βαζηθή ξνή, εθόζνλ απηή ππάξρεη, ή κπνξεί 

λα θηάζεη θαη ην κεδέλ (Μηκίθνπ θαη Μπαιηάο, 2003).  

Σηελ παξνύζα εξγαζία, ιόγσ έιιεηςεο δεδνκέλσλ γηα ηελ πξνζνκνίσζε ηεο βαζηθήο 

ξνήο, δελ επηιέρζεθε θάπνην πξόηππν ππνινγηζκνύ ηεο: 

Parameters → Baseflow → None 

Δμάιινπ, δεδνκέλνπ όηη ε βαζηθή ξνή νθείιεηαη ζρεδόλ απνθιεηζηηθά ζηελ ππόγεηα 

ξνή ησλ πδάησλ, δελ επεξεάδεηαη αηζζεηά θαηά ηε δηάξθεηα ησλ πιεκκπξώλ, όπνηε 

δε ζρεηίδεηαη κε ην ζθνπό ηεο παξνύζαο εξγαζίαο.  
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3.3.1.5. Σο ππόηςπο διόδεςζηρ πλημμύπαρ 

Γηα ην πξόηππν δηόδεπζεο πιεκκύξαο δελ επηιέρζεθε θάπνηα κέζνδνο θαη δε γίλεηαη 

θάπνηα πεξαηηέξσ αλάιπζε, θαζώο μεθεύγεη από ην ζηόρν ηεο παξνύζαο εξγαζίαο.  

3.3.2. Σο μεηεωπολογικό μονηέλο (METEOROLOGIC MODEL) 

Μεηά ην ζηήζηκν ηνπ κνληέινπ ιεθάλεο απνξξνήο, όπσο πεξηγξάθεθε αλαιπηηθά πην 

πάλσ, αθνινπζεί ε θαηάξηηζε ηνπ κεηεσξνινγηθνύ κνληέινπ γηα ηελ εηζαγσγή ησλ 

ζηνηρείσλ κεηεσξνινγηθήο πιεξνθνξίαο. Αξρηθά, δεκηνπξγείηαη από ην θεληξηθό 

κελνύ:  

Components → Meteorologic Model Manager → New → Met1→ Specified 

Hyetograph  

Γίλεηαη ε δπλαηόηεηα ζην ρξήζηε εηζαγσγήο παξαηεξεκέλσλ επεηζνδίσλ 

βξνρόπησζεο, όπνπ απηά ππάξρνπλ, είηε ε εηζαγσγή ππνζεηηθώλ επεηζνδίσλ βξνρήο 

γηα επηιεγκέλε πεξίνδν επαλαθνξάο κε ηε βνήζεηα ησλ όκβξησλ θακππιώλ. Λόγσ 

απνπζίαο βξνρνκεηξηθήο πιεξνθνξίαο ζηελ πεξηνρή κειέηεο, εηζήρζεζαλ βξνρέο γηα 

θάζε ππνιεθάλε, όπσο πξνέθπςαλ από ηελ όκβξηα θακπύιε πνπ αληηζηνηρεί ζηελ ελ 

ιόγσ πεξηνρή.  

Γεκηνπξγείηαη ινηπόλ ην αξρείν πνπ ζα δερζεί ηα δεδνκέλα ζε κνξθή ρξνλνζεηξάο: 

Components → Times Series Data Manager → Precipitation Gages → New → Gage 

14 

Ζ δηαδηθαζία απηή αθνινπζείηαη θαη γηα ηηο 12 ππνιεθάλεο κειέηεο, δεκηνπξγώληαο 

ηηο αληίζηνηρεο ρξνλνζεηξέο βξνρήο (Gage 17, Gage 22, Gage 19 θ.ν.θ.) 

Αξρηθά, επηιέρζεθε ε όκβξηα θακπύιε πνπ αληηζηνηρεί ζηελ πεξηνρή κειέηεο 

(Αηηηθή) κε ζπληειεζηή θ = 15 (Κνδώλεο, 1995): 

 

 (3.10) 

 

Ζ πδξνινγηθή πξνζνκνίσζε ζα γίλεη γηα ηξεηο πεξηόδνπο επαλαθνξάο Τ=20, Τ=100, 

Τ=1000. Τν ππνζεηηθό επεηζόδην βξνρήο είλαη εκεξήζην (24h) κε ρξνληθό βήκα d=15 

min. Γηα ηελ θαηαλνκή ηνπ ζπλνιηθνύ ύςνπο βξνρήο ζην ρξόλν θαη ζπλεπώο ηελ 

θαηάξηηζε πεηνγξάκκαηνο ζρεδηαζκνύ, επηιέρζεθε η μέθοδορ ηυν εναλλαζζόμενυν 

μπλοκ.  

Σύκθσλα κε ηε κέζνδν απηή, εθόζνλ έρεη επηιεγεί ε πεξίνδνο επαλαθνξάο Τ, ε 

δηάξθεηα ηνπ επεηζνδίνπ βξνρήο (24h) θαη ην ρξνληθό βήκα (15 min) ππνινγίδεηαη 
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από ηελ όκβξηα θακπύιε (3.7), ε έληαζε ηεο βξνρήο i (mm/h) γηα θάζε ηέηαξην, θαη 

ελ ζπλερεία, από ηελ έληαζε πξνθύπηεη ην αληίζηνηρν ύςνο βξνρήο h (mm).  

Γηα ηε κεηαηξνπή ηνπ ζεκεηαθνύ ύςνπο βξνρήο ζε επηθαλεηαθό, ππνινγίδεηαη ν 

ζςνηελεζηήρ επιθανειακήρ αναγυγήρ θ: 

                                     (3.11) 

 

όπνπ Α ε έθηαζε ηεο ιεθάλεο απνξξνήο ζε km
2
 θαη d=15 min. 

Σηε ζπλέρεηα, πνιιαπιαζηάδεηαη ν ζπληειεζηήο θ κε ην αληίζηνηρν ηκεκαηηθό ύςνο 

βξνρήο h θαη επεηδή θάζε ηκεκαηηθό ύςνο πεξηέρεη θαη ηελ πξνεγνύκελε ηηκή, απηή 

αθαηξείηαη θαη ηειηθά πξνθύπηνπλ ηα επηζπκεηά ηκεκαηηθά ύςε βξνρήο (Γh). Ζ 

δηαδηθαζία ππνινγηζκνύ ηνπ πεηνγξάκκαηνο ζρεδηαζκνύ ηειεηώλεη κε ηα ηκεκαηηθά 

ύςε βξνρήο λα θαηαηάζζνληαη ζε ρξνληθή αθνινπζία κε ην κέγηζην ζην κέζν ηεο 

ζπλνιηθήο δηάξθεηαο βξνρήο (12h) θαη ηα ππόινηπα ζε θζίλνπζα ζεηξά ελαιιαθηηθά 

αξηζηεξά θαη δεμηά ηνπ θεληξηθνύ κπινθ θ.ν.θ.  

Παξνπζηάδεηαη ελδεηθηηθά ε παξαπάλσ δηαδηθαζία ησλ ππνινγηζκώλ γηα πεξίνδν 

επαλαθνξάο Τ=20 ζε κηα ηπραία ιεθάλε απνξξνήο (17) έθηαζεο 28.97 km
2 

.  

Πίνακαρ 3.6. Οι ςπολογιζμοί για ηην καηάπηιζη ηος ςεηογπάμμαηορ ζσεδιαζμού για μια 

ηςσαία λεκάνη αποπποήρ (17) με Τ=20 έηη. 

d h T i mm/h h mm θ h*θ Γh καηάηαξη 

0.25 20 84.956 21.239 0.766 16.271 16.271 0.246 

0.5 20 51.936 25.968 0.816 21.202 4.931 0.250 

0.75 20 38.944 29.208 0.841 24.557 3.355 0.254 

1 20 31.749 31.749 0.856 27.178 2.621 0.258 

…. …. …. …. …. …. …. …. 

23 20 3.427 78.820 0.952 75.032 0.252 0.260 

23.25 20 3.401 79.067 0.952 75.282 0.250 0.256 

23.5 20 3.375 79.313 0.952 75.530 0.248 0.252 

23.75 20 3.350 79.556 0.952 75.776 0.246 0.248 

24 20 3.325 79.798 0.953 76.021 0.244 0.244 

Τα πεδία πνπ πξέπεη λα ζπκπιεξσζνύλ ζην HEC-HMS ζε απηό ην ζηάδην, γηα ηελ 

εηζαγσγή ησλ ρξνλνζεηξώλ βξνρόπησζεο είλαη: ν ηξόπνο εηζαγσγήο, νη κνλάδεο, ην 
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ρξνληθό παξάζπξν (δηάξθεηα βξνρήο θαη ρξνληθό βήκα), όπσο παξνπζηάδνληαη ζηηο 

Δικόνερ 3.12. θαη 3.13, θαη είλαη θνηλέο γηα θάζε κηα από ηηο 12 ππνιεθάλεο: 

 

 

 

 

 

 

 

 

Δικόνα 3.12. Οι γενικέρ πςθμίζειρ ηυν σπονοζειπών βποσόπηυζηρ ππιν ηην ειζαγυγή 

ηοςρ ζηο HEC-HMS. 

 

Δικόνα 3.13. Φπονικόρ καθοπιζμόρ επειζοδίος βποσήρ. 

Τέινο, ην πεηόγξακκα ζρεδηαζκνύ κηαο ηπραίαο ιεθάλεο απνξξνήο (14) θαη γηα 

πεξίνδν επαλαθνξάο Τ=20 έηε, θαίλεηαη ζηελ παξαθάησ εηθόλα: 

 

 

 

 

 

 

 

 

 

Δικόνα 3.14. Το ςεηόγπαμμα ζσεδιαζμού για ηη λεκάνη αποπποήρ 14 (Τ=20 έηη ). 
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Σε θάζε ππνιεθάλε αληηζηνηρεί δηαθνξεηηθό πεηόγξακκα όπσο πξνέθπςε από ηε 

μέθοδο  ηυν εναλλαζζόμενυν μπλοκ γηα ηηο 3 πεξηόδνπο επαλαθνξάο Τ=20, Τ=100, 

Τ=1000 έηε.  

3.3.3. Σο απσείο πποζομοιώζεων (CONTROL SPECIFICATIONS) 

Τν ηειεπηαίν βήκα πξηλ ηνλ ππνινγηζκό ησλ πιεκκπξνγξαθεκάησλ, είλαη ν νξηζκόο 

ηεο ρξνληθήο δηάξθεηαο ηεο πξνζνκνίσζεο. Γεκηνπξγείηαη έλα λέν αξρείν από ην 

κελνύ: 

Components → Control Specifications Manager→ New→Control 1 

 

 

Δικόνα 3.15. Το απσείο πποζομοίυζηρ ππιν ηοςρ ςπολογιζμούρ. 

3.3.4. Σο απσείο ςπολογιζμών-Αποηελέζμαηα 

Δθόζνλ έρεη νινθιεξσζεί ν ππνινγηζκόο ησλ δεδνκέλσλ εηζόδνπ γηα ηελ πδξνινγηθή 

πξνζνκνίσζε ηεο ιεθάλεο απνξξνήο ζηελ πεξηνρή κειέηεο, ην ηειηθό ζηάδην είλαη ν 

ππνινγηζκόο ησλ πδξνγξαθεκάησλ ησλ επηκέξνπο ππνιεθαλώλ. Ο ρξήζηεο 

κεηαβαίλεη ζην κελνύ: 

Compute → Create Simulation Run → Run1 

Γηα ηε δεκηνπξγία ηνπ αξρείνπ ππνινγηζκώλ πνπ ζα «ηξέμεη» ην πξόγξακκα, αξρηθά 

επηιέγεηαη ην κνληέιν ιεθάλεο απνξξνήο, ην κεηεσξνινγηθό κνληέιν θαη ην αξρείν 

πξνζνκνηώζεσλ. Ο ππνινγηζκόο γίλεηαη κέζσ ηεο εληνιήο: Compute → Select Run 

→ Run1 ή απεπζείαο, αθνύ έρεη επηιεγεί ην αξρείν ππνινγηζκώλ (Run1) παηώληαο ην 

αληίζηνηρν εηθνλίδην. 

Τα απνηειέζκαηα δίλνληαη είηε κε ηε κνξθή δηαγξακκάησλ (graph), είηε κε ηε κνξθή 

πηλάθσλ (time series table) ζηνπο νπνίνπο παξνπζηάδνληαη ε βξνρόπησζε, νη 

απώιεηεο θαη ε απνξξνή κε ηε κνξθή ρξνλνζεηξάο, είηε σο ηηκέο παξνρώλ αηρκήο, 

νιηθήο βξνρόπησζεο, νιηθώλ απσιεηώλ θαη απνξξνήο (summary table). Δλδεηθηηθά, 

παξνπζηάδνληαη ηα απνηειέζκαηα ζηα 2 ζεκεία (userpoints) όπνπ έρνπλ ηνπνζεηεζεί 
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ζηαζκεγξάθνη, θαζώο θαη ην πιεκκπξνγξάθεκα ζε κηα αλάληε ππνιεθάλε απνξξνήο 

(W150) γηα πεξίνδν επαλαθνξάο Τ=20 έηε. 

Γηα ηελ πεξηνρή Οηλόε: 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.16. Υδπογπάθημα ανάνηη θέζηρ μέηπηζηρ για επειζόδιο βποσήρ 24 h και 

πεπίοδο επαναθοπάρ 20 έηη. 

Γηα ηελ πεξηνρή Μαγνύια: 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.17. Υδπογπάθημα θέζηρ μέηπηζηρ λίγο ππιν ηην έξοδο ηηρ λεκάνηρ, για 

επειζόδιο βποσήρ 24 h και πεπίοδο επαναθοπάρ 20 έηη. 
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Γηα ηελ αλάληε ππνιεθάλε W150 (βι. Δικόνα 3.6.) 

 

 

Δικόνα 3.18. Υεηόγπαμμα και πλημμςπογπάθημα ζσεδιαζμού για επειζόδιο βποσήρ 24 h 

ανάνηη ςπολεκάνηρ W150 και πεπίοδο επαναθοπάρ 20 έηη. 

Τέινο, ν ζπγθεληξσηηθόο πίλαθαο (summary table) γηα ηελ παξαπάλσ ιεθάλε: 

 

Δικόνα 3.19. Σςγκενηπυηικόρ πίνακαρ ηηρ ανηίζηοισηρ ςπολεκάνηρ αποπποήρ. 

3.3.5. Γιεπεύνηζη ηων ςδπολογικών παπαμέηπων-Αποηελέζμαηα 

Παξαηεξήζεθε όηη, ε πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο κειέηεο κε ηηο 

παξακέηξνπο πνπ επηιέρζεθαλ έδσζε πιεκκπξνγξαθήκαηα ζε νξηζκέλεο κόλν 
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ιεθάλεο απνξξνήο, κεηαηξέπνληαο ηε βξνρόπησζε εμ νινθιήξνπ ζε απώιεηεο. Απηό 

ζηάζεθε ε αθνξκή γηα πεξαηηέξσ δηεξεύλεζε ησλ παξακέηξσλ θαη ηελ εθαξκνγή 

αιιαγώλ.  

Σπγθεθξηκέλα, ζην πξόηππν ππνινγηζκνύ ησλ απσιεηώλ βξνρήο, επηιέρζεθε ε 

κέζνδνο SCS, κε δεδνκέλα εηζόδνπ ην αξρηθό έιιεηκκα (initial abstraction), ν 

αξηζκόο cn θαη ην πνζνζηό αδηαπέξαηεο επηθάλεηαο (impervious). Σηελ εθαξκνγή 

απηή ρξεζηκνπνηήζεθαλ νη ίδηνη αξηζκνί cn, όπσο ππνινγίζηεθαλ, αιιά δόζεθε ηηκή 

ζην αξρηθό έιιεηκκα ίζε κε 10 mm, θαη ηα πνζνζηά ηεο αδηαπέξαηεο επηθάλεηαο 

ηνπνζεηήζεθαλ σο κεδεληθά. Αθόκα, επηιέρζεθε σο κέζνδνο δηόδεπζεο πιεκκύξαο 

ην lag routing. Θεσξήζεθε όηη ε κέζε ηαρύηεηα ξνήο ηνπ λεξνύ είλαη ίζε κε 1 m/s, 

θαη ζε ζπλδπαζκό κε ην κήθνο θάζε ηκήκαηνο ηνπ πνηακνύ (R20, R300 θ.ιπ.), 

ππνινγίζηεθε ν αληίζηνηρνο ρξόλνο ζε ιεπηά (min). 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.20. Ππόηςπο ςπολογιζμού διόδεςζηρ πλημμύπαρ. 

Τα πξόηππα βαζηθήο ξνήο θαη άκεζεο απνξξνήο έκεηλαλ ηα ίδηα. Παξαηίζεληαη ηα 

απνηειέζκαηα γηα ηηο δύν ζέζεο κέηξεζεο (Οηλόε θαη Μαγνύια) θαζώο θαη ηα 

πιεκκπξνγξαθήκαηα ζηελ πιένλ αλάληε ππνιεθάλε απνξξνήο (W170) (βι. Δικόνα 

3.6.) θαη ηελ αληίζηνηρε θαηάληε ιεθάλε (W340), γηα πεξίνδν επαλαθνξάο Τ=20 έηε. 

Παξαηεξείηαη όηη, ηα πιεκκπξνγξαθήκαηα έρνπλ αιιάμεη κνξθή ζε όιεο ηηο 

ππνιεθάλεο, θαη νη αληίζηνηρεο παξνρέο αηρκήο έρνπλ απμεζεί. 
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Γηα ηελ πεξηνρή Οηλόε: 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.21. Υδπογπάθημα ανάνηη θέζηρ μέηπηζηρ για επειζόδιο βποσήρ 24 h και 

πεπίοδο επαναθοπάρ 20 έηη. 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 3.22. Υδπογπάθημα θέζηρ μέηπηζηρ λίγο ππιν ηην έξοδο ηηρ λεκάνηρ για 

επειζόδιο βποσήρ 24 h και πεπίοδο επαναθοπάρ 20 έηη. 
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Δικόνα 3.23. Υεηόγπαμμα και πλημμςπογπάθημα ζσεδιαζμού για επειζόδιο βποσήρ 24 h 

ανάνηη ςπολεκάνηρ και πεπίοδο επαναθοπάρ 20 έηη. 

 

Δικόνα 3.24. Υεηόγπαμμα και πλημμςπογπάθημα ζσεδιαζμού για επειζόδιο βποσήρ 24 h 

καηάνηη ςπολεκάνηρ και πεπίοδο επαναθοπάρ 20 έηη. 
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ΤΔΡΑΤΛΙΚΗ ΠΡΟ΢ΟΜΟΙΩ΢Η ΢ΑΡΑΝΣΑΠΟΣΑΜΟΤ 

4.1. ΕΙ΢ΑΓΩΓΗ 

Έπεηηα από ηελ νινθιήξσζε ηεο πδξνινγηθήο πξνζνκνίσζεο ηεο ιεθάλεο απνξξνήο 

ζηελ πεξηνρή κειέηεο, αθνινπζεί ε πδξαπιηθή πξνζνκνίσζε ηκήκαηνο ηνπ πνηακνύ. 

Η δηαδηθαζία απηή, πξαγκαηνπνηείηαη ζην πδξαπιηθό κνληέιν HEC-RAS. Σν κνληέιν 

απηό επηηξέπεη ηε κνλνδηάζηαηε αλάιπζε θαη ηελ πξνζνκνίσζε θπζηθώλ 

πδαηνξεπκάησλ ή ηερλεηώλ ζπζηεκάησλ. Πξόθεηηαη γηα έλα ζύλνιν κνληέισλ κε 

ηέζζεξηο ζπληζηώζεο αλάιπζεο (Brunner, 2008): 

1. Τπνινγηζκόο ηνπ πξνθίι ηεο ειεύζεξεο επηθάλεηαο ζε ζπλζήθεο κόληκεο 

ξνήο. 

2. Τπνινγηζκνί ζε ζπλζήθεο κε κόληκεο ξνήο. 

3. Τπνινγηζκνί απόζεζεο θεξηώλ πιώλ. 

4.  Τπνινγηζκνί ζρεηηθά κε ηε ζεξκνθξαζία ηνπ λεξνύ. 

΢πγθεθξηκέλα, ην πξόγξακκα ππνινγίδεη ηε ζηάζκε ηεο ειεύζεξεο επηθάλεηαο ηνπ 

λεξνύ γηα βαζκηαίσο κεηαβαιιόκελε ξνή, ζε ζύζηεκα πδαηνξεπκάησλ κε ηερλεηά 

ζπζηήκαηα ή ζε θπζηθέο θνίηεο πδαηνξεπκάησλ, ζε ζπλζήθεο ππνθξίζηκεο, 

ππεξθξίζηκεο ή θαη κεηθηήο ξνήο. Αθόκα, κπνξεί λα ππνινγίζεη, πδξαπιηθά άικαηα, 

πδξαπιηθέο ζπλζήθεο ζε γέθπξεο, ππεξρεηιηζηέο, θαζώο θαη ηε δηάβξσζε ηεο θνίηεο 

ζηηο γέθπξεο.  Σα βαζηθά κέξε ηνπ πξνγξάκκαηνο απηνύ, είλαη ην γεσκεηξηθό αξρείν 

θαη ην πδξνινγηθό αξρείν, ηα νπνία αλαπηύζζνληαη παξαθάησ.  

Αξρηθά, δεκηνπξγείηαη έλα γεσκεηξηθό ππόβαζξν ζην ινγηζκηθό HEC-GeoRAS, κηα 

επέθηαζε ηνπ πξνγξάκκαηνο ArcGis 9.3. Σν ινγηζκηθό απηό, δίλεη ηε δπλαηόηεηα ζην 

ρξήζηε λα δεκηνπξγήζεη έλα αξρείν απαξαίηεησλ γεσκεηξηθώλ δεδνκέλσλ (θνίηε 
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πνηακνύ, όρζεο θ.α.) πξνηνύ ηα εηζάγεη γηα ηειηθή επεμεξγαζία ζην HEC-RAS. 

Δθόζνλ νινθιεξσζεί ε επεμεξγαζία ζην HEC-GeoRAS θαη εμαρζεί ην γεσκεηξηθό 

αξρείν, αθνινπζνύλ νη πδξνινγηθέο πιεξνθνξίεο (παξνρέο ζρεδηαζκνύ, ζπλζήθεο 

κόληκεο ξνήο) όπσο αλαιύνληαη ζε επόκελε ελόηεηα. Αθνινπζεί ζρεδηάγξακκα πνπ 

παξνπζηάδεη ηελ πνξεία ησλ εξγαζηώλ γηα ηελ πδξαπιηθή πξνζνκνίσζε (Σσήμα 4.1). 

 

 

Σσήμα 4.1. Σσεδιάγπαμμα ποπείαρ επγαζιών για ηην ςδπαςλική πποζομοίυζη και ηη 

ζύνθεζη σαπηών.  

 

 

 

HEC-GeoRAS 

 

Γεωμεηρικό 

αρτείο 

 

 Φεθηαθό κνληέιν 

εδάθνπο 

 

Κύξηα γξακκή ξνήο 

πνηακνύ 

 

 
Όρζεο πνηακνύ 

 

 

Κύξηεο δηεπζύλζεηο 

ξνήο 

 

 
Γηαηνκέο 

 

 

΢πληειεζηήο 

Manning 

 

 

HEC-RAS 

 

Τδρολογικό 

αρτείο 

 

 
Παξνρέο αηρκήο 

από ην HEC-HMS 

 

 Μόληκε/Με 

κόληκε ξνή 

 

 
Οξηαθέο ζπλζήθεο 

 

HEC-GeoRAS 

 

Πηεδνκεηξηθόο 

ράξηεο 

 

 

Υάξηεο πιεκκπξηθήο 

θαηάθιπζεο 
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4.2. ΔΗΜΙΟΤΡΓΙΑ ΓΕΩΜΕΣΡΙΚΟΤ ΑΡΥΕΙΟΤ ΔΕΔΟΜΕΝΩΝ ΢ΣΟ HEC-GeoRAS 

Γύν είλαη ηα βαζηθά κέξε ηνπ κελνύ ζην ινγηζκηθό HEC-GeoRAS, όπσο θαίλεηαη θαη 

ζηελ Εικόνα 4.1., ην RAS Geometry θαη ην  RAS Mapping. Σν πξώην απνηειείηαη 

από επηκέξνπο εληνιέο/ εξγαιεία κε ηε βνήζεηα ησλ νπνίσλ γίλεηαη ε πξνεπεμεξγαζία 

ησλ γεσκεηξηθώλ δεδνκέλσλ γηα ηελ εηζαγσγή ηνπο ζην HEC-RAS, ελώ ην δεύηεξν 

επεμεξγάδεηαη ηα απνηειέζκαηα πνπ εμάγνληαη από ην HEC-RAS (Ackerman and 

Cameron, 2011).  

 

 

Εικόνα 4.1. Η επγαλειοθήκη ηος HEC-GeoRAS. 

Σν πξσηνγελέο δεδνκέλν γηα λα μεθηλήζεη ε πξνεπεμεξγαζία είλαη ηο τηθιακό 

μονηέλο εδάθοςρ. ΢ηελ παξνύζα εξγαζία, δεκηνπξγήζεθε ην ςεθηαθό κνληέιν 

εδάθνπο ζε κνξθή tin, έρνληαο ζαλ δεδνκέλα πςόκεηξα θαη ηζνϋςείο. Η δεκηνπξγία 

έγηλε κε ηελ εμήο αιιεινπρία εληνιώλ: 

3D analyst→ Create/Modify TIN→ Create TIN from features θαη επηιέγσ ην πεδίν κε 

ηα πςόκεηξα (elevation) θαη ηηο ηζνϋςείο (contour). 

Σν επόκελν βήκα είλαη ε δεκηνπξγία δηαθόξσλ ζεκαηηθώλ επηπέδσλ RAS Geometry 

→ Create RAS Layers.  

Γίλεηαη πιεζώξα επηινγώλ γηα ηα ζεκαηηθά επίπεδα. Η δεκηνπξγία ηνπο εμαξηάηαη 

από ην ζθνπό ηεο θάζε εξγαζίαο. Χο ςποσπευηικά γηα ηε δεκηνπξγία ηνπο ζεσξνύληαη 

ηα ζεκαηηθά επίπεδα (Ackerman and Cameron, 2011): 

- Η θύξηα γξακκή ξνήο πνηακνύ (Stream centerline) 

- Οη δηαηνκέο (Cross section cut lines) 

Χο πξναηξεηηθά ζεκαηηθά επίπεδα ζεσξνύληαη: 

- Οη όρζεο (Banks) 

- Οη θύξηεο δηεπζύλζεηο ξνήο (Flow path centerlines) 

- Οη ρξήζεηο γεο (Land use) 

- Αλαρώκαηα (Levees) 

- Πεξηνρέο αλελεξγνύ ξνήο (Ineffective flow areas) 

- Γέθπξεο/ ππόγεηνπο νρεηνύο (Bridges/ culverts) 

- Πεξηνρέο απνζήθεπζεο λεξνύ (Floodplain storage areas)  

΢ηελ παξνύζα εξγαζία δεκηνπξγήζεθαλ 5 ζεκαηηθά επίπεδα: 

1. Η θύξηα γξακκή ξνήο πνηακνύ 
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2. Οη όρζεο 

3. Οη θύξηεο δηεπζύλζεηο ξνήο 

4. Οη δηαηνκέο 

5. Οη ρξήζεηο γεο 

4.2.1. H κύρια γραμμή ροής ποηαμού (stream centerline) 

Από ην κελνύ RAS Geometry → Create RAS Layers → Stream centerline 

δεκηνπξγείηαη ην ζεκαηηθό επίπεδν κε ην όλνκα River. ΢ηε ζπλέρεηα, γίλεηαη 

ςεθηνπνίεζε από ην κελνύ Editor → Start Editing θαη ην εξγαιείν ζρεδίαζεο (sketch 

tool) (Εικόνα 4.2.), κε βάζε ην πδξνγξαθηθό δίθηπν όπσο απηό πξνέθπςε από ηελ 

πδξνινγηθή πξνεπεμεξγαζία ηεο ιεθάλεο απνξξνήο, ζην ινγηζκηθό HEC-GeoΗΜS. 

Δδώ, επηιέρζεθε λα ςεθηνπνηεζεί ν θύξηνο, βόξεηνο θιάδνο ηνπ πνηακνύ, θαηά κήθνο 

ηνπ νπνίνπ έρνπλ ηνπνζεηεζεί ζηαζκεγξάθνη, όπσο παξνπζηάδεηαη θαη ζηελ Εικόνα 

4.3. Η θνξά ηεο ςεθηνπνίεζεο έγηλε από ηα αλάληε πξνο ηα θαηάληε.  

 

 

Εικόνα 4.2. Το μενού για ηη τηθιοποίηζη ηυν θεμαηικών επιπέδυν. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.3. Η τηθιοποιημένη κύπια γπαμμήρ ποήρ ηος ποηαμού. 

Μεηά ηελ νινθιήξσζε ηεο ςεθηνπνίεζεο αθνινπζεί ε νλνκαζία ηεο θύξηαο γξακκήο 

ξνήο ηνπ πνηακνύ. Απηό πξαγκαηνπνηείηαη κε ην εξγαιείν     όπνπ επηιέγεηαη ην 
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πδαηόξεπκα θαη δίλεηαη όλνκα ζηελ θύξηα γξακκή ξνήο θαη ζην αληίζηνηρν ηκήκα ηνπ 

(reach) (Εικόνα 4.4.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.4. Η ονομαζία ηηρ κύπιαρ γπαμμήρ ποήρ ηος ποηαμού. 

΢ηε ζπλέρεηα, ππνινγίδνληαη ηα απαξαίηεηα ραξαθηεξηζηηθά ηεο θύξηαο γξακκήο 

ξνήο ηνπ πνηακνύ, έηζη ώζηε λα ζπκπιεξσζεί θαη ν αληίζηνηρνο πίλαθαο ηδηνηήησλ. 

Η ζεηξά ησλ εληνιώλ έρεη σο εμήο: RAS Geometry → Stream Centerline Attributes 

→Topology/Length-Station/Elevation. 

Με ηελ εληνιή Topology, ειέγρεηαη ε ζύλδεζε θαη ν πξνζαλαηνιηζκόο ηνπ 

πδξνγξαθηθνύ δηθηύνπ πνπ έρεη ζρεκαηηζηεί. Με ηελ εληνιή Length-Station, 

ππνινγίδνληαη ηα κήθε ηεο θύξηαο γξακκήο ξνήο γηα θάζε ηκήκα θαη θαζνξίδεηαη ε 

θνξά ξνήο. Απηό ην εξγαιείν ρξεζηκεύεη θαη ζηνλ ππνινγηζκό ηεο απόζηαζεο κεηαμύ 

ησλ δηαηνκώλ, όπσο παξνπζηάδεηαη ζε επόκελε ελόηεηα. Σέινο, ε εληνιή Elevation, 

κεηαηξέπεη ηε δηζδηάζηαηε γξακκή ξνήο ζε ηξηζδηάζηαηε ρξεζηκνπνηώληαο ην 

ςεθηαθό κνληέιν εδάθνπο. Χζηόζν, απηό ην βήκα δελ είλαη ρξήζηκν, θαζώο δε 

ρξεζηκνπνηνύληαη δεδνκέλα πςνκέηξσλ ζην HEC-RAS (Ackerman and Cameron, 

2011). 

4.2.2. Οι ότθες (bank lines) 

Οη όρζεο ηνπ πνηακνύ είλαη δπν πνιπγσληθέο γξακκέο πνπ δεκηνπξγνύληαη 

εθαηέξσζελ απηνύ. Οπζηαζηηθά δηαρσξίδνπλ ηε ξνή εληόο θαη εθηόο ηεο θνίηεο ηνπ 

πδαηνξεύκαηνο. Η δεκηνπξγία απηνύ ηνπ ζεκαηηθνύ επηπέδνπ κπνξεί λα ζεσξείηαη 

πξναηξεηηθή, σζηόζν δηεπθνιύλεη ζην κεηέπεηηα νξηζκό ησλ νρζώλ ζην HEC-RAS. 

Οη θαλόλεο πνπ αθνινπζνύληαη ζηε ράξαμε ησλ νρζώλ είλαη όηη (Ackerman and 

Cameron, 2011): 

Οη δπν απηέο γξακκέο ησλ νρζώλ ζα πξέπεη λα ηέκλνπλ ηελ θάζε δηαηνκή. 
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- Ο πξνζαλαηνιηζκόο ηνπο δελ έρεη ζεκαζία, θαηά ηε ράξαμε. 

- Οη γξακκέο απηέο κπνξεί λα είλαη ζπλερόκελεο ή δηαθνπηόκελεο.  

Η ράξαμε ησλ νρζώλ γίλεηαη όπσο θαη ζηελ θύξηα γξακκήο ξνήο ηνπ πνηακνύ κε ηελ 

ελεξγνπνίεζε ηνπ κελνύ editor γηα ςεθηνπνίεζε, εθόζνλ έρεη δεκηνπξγεζεί ην 

ζεκαηηθό πεδίν: RAS Geometry → Create RAS Layers → Bank lines 

Η ςεθηνπνίεζε κπνξεί λα γίλεη ρεηξνθίλεηα παξάιιεια ζηελ θύξηα γξακκήο ξνήο 

ηνπ πνηακνύ δεμηά θαη αξηζηεξά απηήο, σζηόζν ράξηλ επθνιίαο κπνξεί λα αληηγξαθεί 

θαη λα ηνπνζεηεζεί ζε επηζπκεηή απόζηαζε κέζσ ηεο εληνιήο copy parallel από ην 

κελνύ editor. Η απόζηαζε πνπ επηιέρζεθε είλαη 2.5 m. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.5. Οι κύπιερ γπαμμέρ ηυν οσθών. 

4.2.3. Οι κύριες διεσθύνζεις ροής (Flow path centerlines) 

Οη θύξηεο δηεπζύλζεηο ξνήο είλαη επίζεο έλα πξναηξεηηθό πεδίν, σζηόζν είλαη 

απαξαίηεην γηα ηε ζπκπιήξσζε ηεο απόζηαζεο θάζε δηαηνκήο από ηελ θαηάληε 

δηαηνκή, όπσο πξνθύπηεη ζην επόκελν βήκα. Γεκηνπξγείηαη θαηά ηα γλσζηά, RAS 

Geometry → Create RAS Layers → Flow path centerlines 

Οη θύξηεο δηεπζύλζεηο ξνήο δεκηνπξγνύληαη απηόκαηα θαηά ηε δηεύζπλζε ξνήο από ηα 

αλάληε πξνο ηα θαηάληε. Δθόζνλ έρεη ήδε δεκηνπξγεζεί ε θύξηα γξακκήο ξνήο ηνπ 

πνηακνύ, απηή νπζηαζηηθά αληηγξάθεηαη γηα λα γίλεη ε θύξηα δηεύζπλζε ξνήο ζηελ 

θύξηα θνίηε ηνπ πνηακνύ (Ackerman and Cameron, 2011). 

4.2.4. Οι διαηομές (Cross section cut lines) 

Οη δηαηνκέο είλαη ην βαζηθό ζεκαηηθό επίπεδν πνπ ελδηαθέξεη, θαζώο εμάγεη 

πςόκεηξα εδάθνπο ζην HEC-RAS θαη δίλεη κηα «εηθόλα» ηνπ εδάθνπο ζηελ θνίηε ηνπ 

πνηακνύ. Οη βαζηθνί θαλόλεο πνπ δηέπνπλ ην ζρεδηαζκό ηνπο είλαη νη αθόινπζνη 

(Ackerman and Cameron, 2011): 
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- Να ζρεδηάδνληαη από ηελ αξηζηεξή όρζε πξνο ηε δεμηά θνηηώληαο πξνο ηα 

θαηάληε. 

- Να κελ ηέκλνληαη κεηαμύ ηνπο θαη λα ηέκλνπλ ηελ θύξηα γξακκήο ξνήο ηνπ 

πνηακνύ αθξηβώο κηα θνξά. 

- Καη θπξίσο, λα είλαη θάζεηεο ζηε δηεύζπλζε ξνήο ηνπ πνηακνύ. 

Η δεκηνπξγία ηνπ ζεκαηηθνύ επηπέδνπ γίλεηαη κε ηηο επηινγέο: RAS Geometry → 

Create RAS Layers → XS Cut Lines.  

Ο ζρεδηαζκόο ησλ δηαηνκώλ κπνξεί λα γίλεη κία πξνο κία ρεηξνθίλεηα κε ην 

ζρεδηαζηηθό εξγαιείν          ηεο ςεθηνπνίεζεο  θαη ην αληίζηνηρν κελνύ editor. 

Βέβαηα, ππάξρεη ε δπλαηόηεηα απηόκαηεο παξαγσγήο δηαηνκώλ κε ηε βνήζεηα ηνπ 

εξγαιείνπ Construct XS Cut Lines            . Ο ρξήζηεο κπνξεί λα νξίζεη ηελ απόζηαζε 

κεηαμύ ησλ δηαηνκώλ θαη ην κήθνο απηώλ, όπσο παξνπζηάδεηαη ζηελ Εικόνα 4.6. 

 

 

 

 

 

 

 

 

Εικόνα 4.6. Οπιζμόρ απόζηαζηρ και μήκοςρ ηυν διαηομών. 

΢ηελ παξνύζα εξγαζία, έγηλε επηινγή ησλ δηαηνκώλ πνπ ζα κειεηεζνύλ θαη ζα 

εηζαρζνύλ ζην HEC-RAS, έηζη ώζηε λα βξίζθνληαη ζε ραξαθηεξηζηηθά ζεκεία ησλ 

ιεθαλώλ απνξξνήο (αξρή/κέζε/ηέινο, Εικόνα 4.7). Γύν από απηέο δεκηνπξγήζεθαλ 

εμ νινθιήξνπ ζην HEC-RAS βάζε ηνπνγξαθηθώλ δηαγξακκάησλ ζηηο δύν ζέζεηο 

κέηξεζεο (Οηλόε θαη Μαγνύια). 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.7. Το θεμαηικό επίπεδο ηυν διαηομών. 
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Σέινο, ππάξρεη ε δπλαηόηεηα πξνεπηζθόπεζεο ηεο θάζε δηαηνκήο κε ηε βνήζεηα ηνπ 

εξγαιείνπ Plot Cross Section             , ελδεηθηηθά παξνπζηάδεηαη κηα ηπραία δηαηνκή: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.8. Μια ηςσαία διαηομή ηηρ κύπιαρ κοίηηρ ηος ποηαμού μελέηηρ. 

Πξηλ ηελ εμαγσγή ησλ δεδνκέλσλ ζην HEC-RAS, πξαγκαηνπνηείηαη ν ππνινγηζκόο 

ησλ ηδηνηήησλ ησλ δηαηνκώλ κε ηελ εθαξκνγή κηαο ζεηξάο εληνιώλ από ην κελνύ:  

RAS Geometry → XS Cut Line Attributes. ΢ε θάζε κηα δηαηνκή, ζπκπιεξώλεηαη θαη 

ην αληίζηνηρν πεδίν ζηνλ πίλαθα ηδηνηήησλ ησλ δηαηνκώλ. ΢πγθεθξηκέλα κε ηελ 

εληνιή: 

River/Reach Names: ΢πκπιεξώλνληαη ηα νλόκαηα ηεο θύξηαο θνίηεο θαη ηνπ 

αληίζηνηρνπ θιάδνπ (΢αξαληαπόηακνο/ 1) γηα θάζε δηαηνκή. 

Stationing:               ΢πκπιεξώλεηαη ν ζηαζκόο ηνπ πνηακνύ (river station) ζε θάζε 

δηαηνκή. Σν πξόγξακκα ππνινγίδεη νπζηαζηηθά ηελ απόζηαζε 

ηεο δηαηνκήο από ην αξρηθό θαηάληε ηκήκα ηνπ πνηακνύ 

(ζεκείν εμόδνπ).  

Bank Stations:        Γηα ηε ζπκπιήξσζε απηνύ ηνπ πεδίνπ (left bank, right bank) 

ρξεζηκνπνηείηαη ην ζεκαηηθό επίπεδν ησλ νρζώλ. Τπνινγίδεηαη 

ην πνζνζηό ηνπ κήθνπο ηεο δηαηνκήο από ηελ αξηζηεξή 

πιεπξά, κέρξη ην ζεκείν πνπ απηή ηέκλεη ηε δεμηά θαη ηελ 

αξηζηεξή όρζε αληίζηνηρα. 

Downstream Reach Lengths: Τπνινγίδεηαη ε απόζηαζε κέρξη ηελ θαηάληε δηαηνκή 

βάζε ηνπ ζεκαηηθνύ επηπέδνπ ησλ θύξησλ δηεπζύλζεσλ ξνήο. 



Κεθάλαιο 4: Υδπαςλική πποζομοίυζη Σαπανηαπόηαμος 

 

 61 

Elevation: Γεκηνπξγείηαη έλα λέν ζεκαηηθό επίπεδν δηαηνκώλ (XSCutLines3D) ζε 

ηξηζδηάζηαηε κνξθή ιακβάλνληαο ππόςε ην ςεθηαθό κνληέιν εδάθνπο 

(tin). 

4.2.5 . Οι τρήζεις γης (Landuse Areas) 

Σν ζεκαηηθό επίπεδν ησλ ρξήζεσλ γεο ρξεζηκεύεη ζηελ εμαγσγή ησλ ηηκώλ ηνπ 

ζπληειεζηή Manning ζηε ζέζε ηεο θάζε δηαηνκήο. Αξρηθά, δεκηνπξγείηαη ην 

ζεκαηηθό επίπεδν ησλ ρξήζεσλ γεο: RAS Geometry → Create RAS Layers → 

Landuse Areas.  

΢ηε ζπλέρεηα, επηιέγεηαη ην κελνύ ηεο ςεθηνπνίεζεο editor θαη δεκηνπξγείηαη έλα 

πνιύγσλν νξηζκέλν ζηηο όρζεο ηνπ πδαηνξεύκαηνο. Δλώλνληαο, κέζσ ηεο εληνιήο 

clip ηνπ Arctoolbox, ηηο ρξήζεηο γεο γηα όιε ηε ιεθάλε απνξξνήο (Φάπηηρ 3.1) κε ην 

λέν πνιύγσλν ησλ ρξήζεσλ γεο (landuse) πξνθύπηεη έλα ζεκαηηθό επίπεδν πνπ 

πεξηέρεη ηηο ρξήζεηο γεο ζηελ πεξηνρή πνπ ελδηαθέξεη, έηζη ώζηε λα πξνθύςεη ν 

ζπληειεζηήο Manning γηα ηελ θάζε δηαηνκή.  

 

 

 

 

 

 

 

Εικόνα 4.9. Οι σπήζειρ γηρ καηά μήκορ ηος ποηαμού. 

Αθνινύζσο, δεκηνπξγείηαη έλαο πίλαθαο πνπ πεξηέρεη κηα ηηκή ηνπ ζπληειεζηή 

Manning γηα θάζε δηαηνκή, κέζσ ηεο εληνιήο: RAS Geometry → Manning’s n 

Values → Create LU Manning table θαη ηέινο, εμάγνληαη νη ηηκέο πνπ αθνξνύλ θάζε 

δηαηνκή ζε λέν πίλαθα κέζσ ηεο εληνιήο RAS Geometry →  Manning n’ values → 

Extract N values (Εικόνα 4.10). 

 

 

 

 

 

 
 

 

Εικόνα 4.10. Απόδοζη ηιμών ζςνηελεζηών Manning ζύμθυνα με ηιρ σπήζειρ γηρ. 
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Η απόδνζε ηηκώλ ζηνπο ζπληειεζηέο manning έγηλε κέζσ εηδηθνύ πίλαθα πνπ 

βξίζθεηαη ζην manual ηνπ HEC-RAS. Μεηά ηελ νινθιήξσζε ηεο δεκηνπξγίαο ησλ 

απαξαίηεησλ ζεκαηηθώλ πεδίσλ, αθνινπζεί ε εμαγσγή ηνπ γεσκεηξηθνύ αξρείνπ ζην 

HEC-RAS. Απηό γίλεηαη κέζσ ηεο εληνιήο: RAS Geometry → Export RAS data.  

4.3.  ΕΙ΢ΑΓΩΓΗ ΓΕΩΜΕΣΡΙΚΩΝ ΔΕΔΟΜΕΝΩΝ ΢ΣΟ HEC-RAS 

Αξρηθά, δεκηνπξγείηαη έλα λέν project κε ηηο εμήο εληνιέο: File → New Project. Από 

ηηο θεληξηθέο επηινγέο ηνπ πξνγξάκκαηνο γίλεηαη ε επηινγή ησλ κνλάδσλ κέηξεζεο, 

ζην κεηξηθό ζύζηεκα (metric system S.I.). 

 

 

 

 

 

 
Εικόνα 4.11. Το κενηπικό μενού ηος ππογπάμμαηορ HEC-RAS. 

Η εηζαγσγή ηνπ γεσκεηξηθνύ αξρείνπ γίλεηαη κέζσ ηεο εληνιήο Edit → Geometric 

data θαη ζηε ζπλέρεηα από ην παξάζπξν ησλ γεσκεηξηθώλ δεδνκέλσλ, επηιέγεηαη ε 

εληνιή: File → Import Geometry Data → GIS Format. 

Σα ραξαθηεξηζηηθά ηεο θάζε δηαηνκήο παξνπζηάδνληαη ζην παξάζπξν Cross section 

data (Edit cross section), όπσο θαίλεηαη ζηελ παξαθάησ εηθόλα: 

 

 

 

 

 

 

 

 

 

 
Εικόνα 4.12. Η διαηομή ζηο ζηαθμό μέηπηζηρ ζηην πεπιοσή Οινόη. 
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 River/ Reach: Σν όλνκα ηνπ πνηακνύ θαη ην αληίζηνηρν ηκήκα ζην νπνίν 

αλήθεη ε δηαηνκή.  

 River Station: Ο θσδηθόο αξηζκόο ηεο δηαηνκήο, πξόθεηηαη γηα ηελ απόζηαζε 

ηεο δηαηνκήο από ην αξρηθό θαηάληε ηκήκα ηνπ πνηακνύ.  

 Cross Section Coordinates: Πίλαθαο πνπ πεξηιακβάλεη ηα ραξαθηεξηζηηθά 

ζεκεία ηεο δηαηνκήο. ΢πγθεθξηκέλα, ηελ απόζηαζε ηνπο από ην αξηζηεξό 

άθξν ηεο δηαηνκήο (Station) κε ηα αληίζηνηρα πςόκεηξα ηνπο (Elevation).  

 Downstream Reach Lengths: Η απόζηαζε ηεο θάζε δηαηνκήο από ηελ θαηάληε 

ηεο.  

 Manning’s n Values: Οη ηηκέο ηνπ ζπληειεζηή manning γηα ηελ αξηζηεξή θαη 

δεμηά όρζε θαη ηελ θύξηα θνίηε ηνπ πνηακνύ. 

 Main Channel Bank Stations: Οη απνζηάζεηο ηεο αξηζηεξήο θαη δεμηάο όρζεο 

από ην αξηζηεξό άθξν ηεο δηαηνκήο. ΢ηελ παξνύζα εξγαζία, ζε νξηζκέλεο 

δηαηνκέο έγηλε πξνζαξκνγή ησλ νρζώλ ζύκθσλα κε ην ζρήκα ηεο θάζε 

δηαηνκήο.  

 Cont / Exp Coefficients: Οη ζπληειεζηέο ζπζηνιήο/δηαζηνιήο γηα ην κεηέπεηηα 

ππνινγηζκό ησλ ηνπηθώλ απσιεηώλ. Οη ηηκέο είλαη default από ην πξόγξακκα 

γηα ηε κόληκε ξνή.  

Σα παξαπάλσ ραξαθηεξηζηηθά ησλ δηαηνκώλ πξνθύπηνπλ από ηελ πξνεπεμεξγαζία 

ηνπ πνηακνύ θαη ησλ ινηπώλ ζεκαηηθώλ επηπέδσλ ζην HEC-GeoRAS.  

΢ηελ παξνύζα εξγαζία, ππήξμαλ πξνβιήκαηα ζηελ απεηθόληζε ησλ δηαηνκώλ ζηα 

ζεκεία όπνπ νη ηζνϋςείο ήηαλ πνιύ αξαηέο (ηζνδηάζηαζε 20 m). ΢ηελ πεξίπησζε 

απηή, ε δηαηνκή παξνπζηαδόηαλ ζε έλα πςόκεηξν (πεδηάδα), (Εικόνα 4.13.), γεγνλόο 

πνπ δεκηνπξγνύζε πξνβιήκαηα ζηνπο κεηέπεηηα πδξαπιηθνύο ππνινγηζκνύο. Γηα ηελ 

επίιπζε απηνύ ηνπ πξνβιήκαηνο, νη ελ ιόγσ δηαηνκέο δεκηνπξγήζεθαλ κε 

κεγαιύηεξν πιάηνο (1000 m έλαληη 200 m). Χζηόζν, γηα ηελ ηειηθή εηζαγσγή ηνπο 

ζην HEC-RAS, έγηλε πξνζαξκνγή έηζη ώζηε ην πιάηνο ηνπο λα κελ μεπεξλά ηα 200 

m (Εικόνα 4.14.). 

 

 

 

 

 
 

 

Εικόνα 4.13. Το ζημείο όπος οι διαηομέρ ςπέζηηζαν πεπαιηέπυ επεξεπγαζία. 
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Εικόνα 4.14. Μια ηςσαία διαηομή μεηά από επεξεπγαζία. 

Σέινο, ζηα ζεκεία όπνπ έρνπλ ηνπνζεηεζεί ζηαζκνί κέηξεζεο, δεκηνπξγήζεθαλ εθ 

λένπ νη δηαηνκέο ζην  HEC-RAS κε βάζε ηα ηνπνγξαθηθά δηαγξάκκαηα ηεο πεξηνρήο 

ζηα ελ ιόγσ ζεκεία, (Εικόνα 4.12. θαη Εικόνα 4.15.). 

 

 

 

 

 

 

 

 

 
 

 

 

Εικόνα 4.15. Η διαηομή ζηο ζηαθμηγπάθο ζηην πεπιοσή Μαγούλα. 

4.4.  ΕΙ΢ΑΓΩΓΗ ΤΔΡΟΛΟΓΙΚΩΝ ΔΕΔΟΜΕΝΩΝ ΢ΣΟ HEC-RAS 

΢ηελ παξνύζα εξγαζία, επηιέρζεθε λα γίλεη ε πδξαπιηθή πξνζνκνίσζε ηνπ πνηακνύ 

ζε ζπλζήθεο κόληκεο ξνήο. Έηζη από ην κελνύ, Edit → Steady Flow Data, γίλεηαη ε 

επεμεξγαζία ησλ πδξνινγηθώλ δεδνκέλσλ.  
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΢ην παξάζπξν ησλ δεδνκέλσλ ησλ ζπλζεθώλ κόληκεο ξνήο, εηζάγεηαη αξρηθά ν 

αξηζκόο ησλ πξνθίι, γηα θαζέλα από ηα νπνία ζπκπιεξώλνληαη νη αληίζηνηρεο 

πιεκκπξηθέο αηρκέο γηα ηελ θάζε δηαηνκή, όπσο πξνέθπςαλ από ηελ πδξνινγηθή 

πξνζνκνίσζε ζην HEC-HMS. Σα πξνθίι, εδώ είλαη ηξία, Σ=20, Σ=100 θαη Σ=1000. 

Η κεηνλνκαζία ησλ επηιεγκέλσλ πξνθίι επηηπγράλεηαη κέζσ ηεο εληνιήο: Options → 

Edit Profile Names.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.16. Υδπολογικά δεδομένα ζε ζςνθήκερ μόνιμηρ ποήρ. 

Γηα λα νινθιεξσζεί ε εηζαγσγή ησλ πδξνινγηθώλ δεδνκέλσλ, γίλεηαη ε επηινγή ησλ 

νξηαθώλ ζπλζεθώλ (Reach Boundary Conditions). Ο νξηζκόο ησλ νξηαθώλ ζπλζεθώλ 

είλαη απαξαίηεηνο γηα λα μεθηλήζεη ν ππνινγηζκόο ηεο αξρηθήο επηθάλεηαο ηνπ λεξνύ 

θαη νη κεηέπεηηα ππνινγηζκνί ηεο εμίζσζεο ελέξγεηαο. Αλάινγα κε ην θαζεζηώο ξνήο 

πνπ επηθξαηεί ζην πδαηόξεπκα (ππνθξίζηκε/ ππεξθξίζηκε ξνή), νξίδεηαη θαη ε ζέζε 

ησλ νξηαθώλ ζπλζεθώλ. ΢ηελ ςποκπίζιμη ποή, νη νξηαθέο ζπλζήθεο είλαη απαξαίηεηεο 

ζην θαηάληε ηκήκα ηνπ πνηακνύ, ελώ νη ππνινγηζκνί μεθηλνύλ από ηα αλάληε πξνο 

ηα θαηάληε. Αληίζηνηρα, ζηελ ςπεπκπίζιμη ποή, νη νξηαθέο ζπλζήθεο έρνπλ λόεκα 

κόλν ζηελ αλάληε ζέζε κε ηνπο ππνινγηζκνύο λα αξρίδνπλ από ηα θαηάληε πξνο ηα 

αλάληε. ΢ηελ πεξίπησζε ηεο μεικηήρ ποήρ, νη νξηαθέο ζπλζήθεο νξίδνληαη θαη ζηα δύν 

άθξα ηνπ πνηακνύ. ΢ηελ παξνύζα εξγαζία, επηιέρζεθε ε κεηθηή ξνή, θαζώο 

παξαηεξνύληαη ήπηεο θιίζεηο εδάθνπο ζε θάπνηα ζεκεία ηνπ πδαηνξεύκαηνο, αιιά 
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θαη εληνλόηεξεο θιίζεηο ζε άιια ζεκεία. ΢πλεπώο, νη νξηαθέο ζπλζήθεο νξίζηεθαλ 

θαη ζηελ θαηάληε θαη ζηελ αλάληε ζέζε.  

 

 

 

 

 

 

Εικόνα 4.17. Οπιζμόρ οπιακών ζςνθηκών για μόνιμη ποή. 

Ο ρξήζηεο κπνξεί λα επηιέμεη αλάκεζα ζε ηέζζεξηο δηαθνξεηηθνύο ηύπνπο νξηαθώλ 

ζπλζεθώλ, ζπγθεθξηκέλα (Brunner, 2008): 

- Known Water Surface Elevation (Γλσζηό πηεδνκεηξηθό θνξηίν): ΢ε απηή ηελ 

νξηαθή ζπλζήθε πξέπεη λα εηζαρζεί έλα γλσζηό πηεδνκεηξηθό θνξηίν γηα θάζε 

πξνθίι. 

- Critical Depth (Κξίζηκν βάζνο): Με απηήλ ηελ επηινγή δε ρξεηάδεηαη θακία 

επηπιένλ πιεξνθνξία. Σν πξόγξακκα ππνινγίδεη ην θξίζηκν βάζνο γηα θάζε 

πξνθίι θαη ην ρξεζηκνπνηεί ζαλ νξηαθή ζπλζήθε. 

- Normal Depth (Οκνηόκνξθν βάζνο): ΢ε απηή ηελ νξηαθή ζπλζήθε, εηζάγεηαη 

ε θιίζε ηεο γξακκήο ελέξγεηαο, βάζε ηεο νπνίαο ππνινγίδεηαη ην νκνηόκνξθν 

βάζνο κε ηελ εμίζσζε manning. Γεληθά, ε θιίζε ηεο γξακκήο ελέξγεηαο 

πξνζδηνξίδεηαη θαηά πξνζέγγηζε σο ε κέζε θιίζε ηεο θύξηαο θνίηεο ηνπ 

πδαηνξεύκαηνο.  

- Rating Curve (Κακπύιε ζηάζκεο – παξνρήο): Η νξηαθή απηή ζπλζήθε 

πξνϋπνζέηεη ηελ εηζαγσγή δεπγώλ ηηκώλ ζηάζκεο – παξνρήο. Από ηελ 

θακπύιε απηή ην πξόγξακκα κπνξεί κε παξεκβνιή λα ππνινγίζεη ην 

πηεδνκεηξηθό θνξηίν γηα ηελ αληίζηνηρε παξνρή. 

΢ηελ παξνύζα εξγαζία, ιόγσ έιιεηςεο πδξνκεηξηθώλ δεδνκέλσλ, σο νξηαθή 

ζπλζήθε επηιέρζεθε ην νκνηόκνξθν βάζνο. Η θιίζε γξακκήο ελέξγεηαο 

ππνινγίζηεθε από ην πξνθίι ηνπ πδαηνξεύκαηνο (profile plot) ίζε κε 0.01. 

4.5.  ΟΙ ΤΔΡΑΤΛΙΚΟΙ ΤΠΟΛΟΓΙ΢ΜΟΙ 

4.5.1. Προεηοιμαζία γεωμεηρικού και σδρολογικού αρτείοσ για ηοσς 

σπολογιζμούς 
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Από ην βαζηθό κελνύ ηνπ πξνγξάκκαηνο, επηιέγεηαη: Run  →Steady Flow analysis. 

Καη ζην παξάζπξν ηεο αλάιπζεο ηεο κόληκεο ξνήο, επηιέγνληαη ην επηζπκεηό 

γεσκεηξηθό θαη πδξνινγηθό αξρείν, ην θαζεζηώο ξνήο (ππνθξίζηκε, ππεξθξίζηκε, 

κηθηή) θαη ηειηθώο ε εληνιή Compute. 

Η πξώηε πξνζπάζεηα πδξαπιηθήο πξνζνκνίσζεο θαη ησλ αληίζηνηρσλ ππνινγηζκώλ, 

ρσξίο θάπνηα πεξαηηέξσ ξύζκηζε, παξνπζίαζε ζθάικαηα θαη πξνεηδνπνηήζεηο 

(warnings) ζηνπο ηειηθνύο ζπγθεληξσηηθνύο πίλαθεο γηα θάζε δηαηνκή. Δλδεηθηηθά 

παξνπζηάδνληαη θάπνηα από απηά:  

Πίνακαρ 4.1. Παποςζίαζη πιο ζςσνών ζθαλμάηυν καηά ηοςρ ςδπαςλικούρ 

ςπολογιζμούρ.  

Warnings Ανηιμεηώπιζη 

The velocity head has changed more than 

0.5 ft (0.15 m). This may indicate the 

need for additional cross sections. 

Δηζαγσγή ελδηάκεζσλ δηαηνκώλ αλά 5 m 

θαη ζε νξηζκέλα ζεκεία αλά 1 m  (εληνιή 

interpolation). 

The conveyance ratio (upstream 

conveyance divided by downstream 

conveyance) is less than 0.7 or greater 

than 1.4. This may indicate the need for 

additional cross sections. 

Δηζαγσγή ελδηάκεζσλ δηαηνκώλ αλά 5 m 

θαη ζε νξηζκέλα ζεκεία αλά 1 m  (εληνιή 

interpolation). 

The energy equation could not be 

balanced with the specified number of 

iterations. The program used critical 

depth for water surface and continued on 

with the calculations.  

Παξεκβνιή βαζκηαίσο απμαλόκελσλ 

παξνρώλ ζηηο δηαηνκέο κε κεγάιεο 

απνθιίζεηο ζηηο παξνρέο αηρκήο (π.ρ. από 

4 m
3
/s λα αθνινπζνύλ 28 m

3
/s). 

During the standard step iterations, when 

the assumed water surface was set equal 

to critical depth, the calculated water 

surface came back below critical depth. 

This indicates that there is not a valid 

subcritical answer. The program 

defaulted to critical depth.  

Απηό ην κήλπκα είλαη ινγηθό όηαλ από 

ηελ ππνθξίζηκε ξνή ζε κηα δηαηνκή 

κεηαβαίλεη ζε ππεξθξίζηκε ξνή ζηελ 

ακέζσο θαηάληε δηαηνκή.  

4.5.2. Σο θεωρηηικό σπόβαθρο ηων σπολογιζμών 

Σν πξόγξακκα HEC-RAS ππνινγίδεη ην πξνθίι ηεο ειεύζεξεο επηθάλεηαο ζε θάζε 

δηαηνκή, επηιύνληαο ηελ εμίζσζε ελέξγεηαο (4.1) κεηαμύ δύν δηαδνρηθώλ δηαηνκώλ.  

 (4.1) 
2 2

2 2 1 1
2 2 1 1

2 2
e

a v a v
z y z y h

g g
     
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Όπνπ, z1, z2: πςόκεηξα ηνπ ππζκέλα ηνπ πδαηνξεύκαηνο από ην επίπεδν αλαθνξάο, 

y1, y2: βάζε λεξνύ ζηηο δηαδνρηθέο δηαηνκέο, 

v1, v2: κέζεο ηαρύηεηεο δηαηνκώλ (παξνρή/εκβαδόλ δηαηνκήο), 

α1, α2: δηνξζσηηθνί ζπληειεζηέο θηλεηηθήο ελέξγεηαο ηαρύηεηαο 

      g:  επηηάρπλζε βαξύηεηαο 

      he: νιηθέο απώιεηεο ελέξγεηαο (γξακκηθέο θαη ηνπηθέο)   

 

  

 

 

 

 

 

 

 

 

Διάγπαμμα 4.1. Τα βαζικά μεγέθη ηηρ εξίζυζηρ ενέπγειαρ (Πηγή: Brunner, 2008) 

Οη νιηθέο απώιεηεο ελέξγεηαο he ζπλίζηαληαη ζηηο γξακκηθέο απώιεηεο, ζηηο απώιεηεο 

ιόγσ ηξηβήο θαη ζπζηνιήο/ δηαζηνιήο κεηαμύ ησλ δηαδνρηθώλ δηαηνκώλ, όπσο 

θαίλεηαη ζηελ εμίζσζε (4.2): 

 (4.2) 

 

L ε κέζε ζηαζκηζκέλε απόζηαζε κεηαμύ δύν δηαδνρηθώλ δηαηνκώλ 

  νη απώιεηεο ιόγσ ηξηβήο 

C  ν ζπληειεζηήο ζπζηνιήο/δηαζηνιήο γηα ηηο ηνπηθέο απώιεηεο ελέξγεηαο

  
2 2

2 2 1 1

2 2

a v a v

g g
  ε δηαθνξά θηλεηηθήο ελέξγεηαο κεηαμύ δύν δηαδνρηθώλ δηαηνκώλ 

 

i. Οη γξακκηθέο απώιεηεο ελέξγεηαο  

Οη γξακκηθέο απώιεηεο L ππνινγίδνληαη από ηε ζρέζε (4.3), ζε ζπλάξηεζε κε ηηο 

κέζεο παξνρέο κεηαμύ δηαδνρηθώλ δηαηνκώλ: 

 (4.3) 
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fe
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Llob, Lch, Lrob νη απνζηάζεηο ηεο αξηζηεξήο όρζεο, ηνπ θύξηνπ πδαηνξεύκαηνο θαη ηεο 

δεμηάο όρζεο, κεηαμύ δηαδνρηθώλ δηαηνκώλ όπσο ππνινγίζηεθαλ ζην 

γεσκεηξηθό αξρείν (downstream reach length)  

Qlob, Qch, Qrob νη κέζεο παξνρέο ζην αξηζηεξό ηκήκα ηεο δηαηνκήο, ζηελ θύξηα θνίηε 

θαη ζην δεμί ηκήκα απηήο.  

Πξηλ ηνλ ππνινγηζκό ησλ απσιεηώλ ηξηβήο, απαξαίηεηνο είλαη ν ππνινγηζκόο ηνπ 

ζςνηελεζηή μεηαθοπάρ Κ γηα θάζε δηαηνκή. Η κέζνδνο ππνινγηζκνύ επηιέγεηαη από 

ηελ εληνιή  Run → Options → Conveyance calculations → At breaks in n values 

only.  Οπζηαζηηθά, ρσξίδεηαη ε δηαηνκή ζε επηκέξνπο ηκήκαηα (εθηόο ηνπ 

δηαρσξηζκνύ ζε αξηζηεξή όρζε, θύξηα θνίηε θαη δεμηά όρζε) γηα θάζε δηαθνξεηηθή 

ηηκή Manning n. Ο ζςνηελεζηήρ μεηαθοπάρ Κ, ππνινγίδεηαη από ηε ζρέζε: 

 (4.4) 

n ν ζπληειεζηήο Manning 

Α ην εκβαδόλ ηεο δηαηνκήο 

R ε πδξαπιηθή αθηίλα (Α/Ρ, Ρ: ε βξερόκελε πεξίκεηξνο) 

Γηα θάζε ηηκή ηνπ ζπληειεζηή Manning ni, ππνινγίδεηαη θαη ν αληίζηνηρνο 

ζπληειεζηήο Κi, (εμ. 4.4), θαη νη επηκέξνπο ηηκέο αζξνίδνληαη έηζη ώζηε ηειηθά λα 

πξνθύςεη κηα ηηκή Κ γηα ηελ αξηζηεξή όρζε (Klob), κηα ηηκή γηα ηε δεμηά όρζε (Krob) 

θαη κηα ηηκή γηα ηελ θύξηα θνίηε (Kch), (Σσήμα 4.1.). Ο νιηθόο ζπληειεζηήο Κ γηα ηε 

δηαηνκή πξνθύπηεη από ην άζξνηζκα Klob+ Kch+ Krob.  

 

 

 

 

 

 

Σσήμα 4.2. Ο ςπολογιζμόρ ηος ζςνηελεζηή μεηαθοπά Κ για όλη ηη διαηομή (Πηγή: 

Brunner, 2008). 

ii. Οη απώιεηεο ιόγσ ηξηβήο 

Η κέζε θιίζε γξακκήο ελέξγεηαο ππνινγίδεηαη από ην πξόγξακκα κέζσ ηεο 

εληνιήο Run → Options → Friction slope method. Η γεληθή κνξθή ηεο εμίζσζεο πνπ 

δίλεη ηε κέζε θιίζε γξακκήο ελέξγεηαο είλαη:  

 

 (4.5) 

fS

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Σν πξόγξακκα HEC-RAS δίλεη ηε δπλαηόηεηα επηινγήο ελαιιαθηηθώλ κνξθώλ ηεο 

παξαπάλσ εμίζσζεο (4.5) γηα ηνλ ππνινγηζκό ηεο κέζεο θιίζεο. ΢ηελ παξνύζα 

εξγαζία επηιέρζεθε ε κέζνδνο average conveyance, ε νπνία ζπληζηάηαη γηα κόληκε 

ξνή. Η εμίζσζε πνπ αληηζηνηρεί ζηελ ελ ιόγσ κέζνδν είλαη: 

 

 (4.6) 

 

Q1, Q2 νη κέζεο παξνρέο ζηηο δύν δηαδνρηθέο δηαηνκέο 

Κ1, Κ2  νη ζπληειεζηέο κεηαθνξάο γηα θάζε δηαηνκή 

iii. Οη ηνπηθέο απώιεηεο ελέξγεηαο 

Γηα ηελ εύξεζε ησλ νιηθώλ απσιεηώλ ελέξγεηαο, ην ηειεπηαίν βήκα είλαη ν 

ππνινγηζκόο ησλ ηνπηθώλ απσιεηώλ ελέξγεηαο, ήηνη ε δηαθνξά ηεο κέζεο θηλεηηθήο 

ελέξγεηαο θάζε δηαηνκήο.  

Γηα  v1, v2 νη κέζεο ηαρύηεηεο δηαηνκώλ, v ε κέζε ηαρύηεηα όιεο ηεο δηαηνκήο θαη Q1, 

Q2 νη κέζεο παξνρέο ζηηο δύν δηαδνρηθέο δηαηνκέο, ηζρύεη ε ζρέζε (εμ. 4.7) ζύκθσλα 

θαη κε ην αθόινπζν ζρήκα:  

 

 

 

 

 

 

 

 

 

Σσήμα 4.3. Υπολογιζμόρ ηηρ μέζηρ κινηηικήρ ενέπγειαρ ηηρ διαηομήρ (Πηγή:Brunner, 

2008). 

 

 

 (4.7) 

 

 

Από ηε ζρέζε (4.7) θαη απινπνηώληαο ηελ επηηάρπλζε βαξύηεηαο πξνθύπηεη ν 

δηνξζσηηθόο ζπληειεζηήο θηλεηηθήο ελέξγεηαο α: 

 (4.8) 

 

Δπνκέλσο, κπνξεί πιένλ λα ππνινγηζηεί ε δηαθνξά ηεο κέζεο θηλεηηθήο ελέξγεηαο ηεο 

δηαηνκήο.  
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Σν ηειεπηαίν θνκκάηη πνπ πξέπεη λα πξνζδηνξηζηεί είλαη ν ζπληειεζηήο 

ζπζηνιήο/δηαζηνιήο (contraction/expansion). Σν πξόγξακκα ζεσξεί όηη ε ζπζηνιή 

ζηε ξνή ζπκβαίλεη όηαλ ε κέζε ηαρύηεηα θαηάληε είλαη κεγαιύηεξε από ηε κέζε 

ηαρύηεηα αλάληε, θαη αληίζηνηρα ε δηαζηνιή, όηαλ ε κέζε ηαρύηεηα αλάληε είλαη 

κεγαιύηεξε από ηε κέζε ηαρύηεηα θαηάληε. Γηα ππνθξίζηκε ξνή νη ζπληειεζηέο 

απηνί παίξλνπλ ηππηθέο ηηκέο 0.1 θαη 0.3 αληίζηνηρα, ελώ ζηελ ππεξθξίζηκε ξνή νη 

ηππηθέο ηηκέο είλαη 0.01 θαη 0.03 αληίζηνηρα (Brunner, 2008), όπσο απνδεηθλύεηαη θαη 

ζηα απνηειέζκαηα.  

Σειηθά, έρνληαο όια ηα δεδνκέλα ππνινγίδνληαη νη νιηθέο απώιεηεο ελέξγεηαο (εμ. 

4.2) θαη θαη’ επέθηαζε μεθηλνύλ νη ππνινγηζκνί ζηελ εμίζσζε ελέξγεηαο (εμ. 4.1). 

Οπζηαζηηθά, εθαξκόδεηαη έλαο επαλαιεπηηθόο αιγόξηζκνο γηα ηνλ πξνζδηνξηζκό ηνπ 

πηεδνκεηξηθνύ θνξηίνπ ζε θάζε δηαηνκή (WS), βαζηδόκελνο ζηελ εμίζσζε ελέξγεηαο 

(εμ. 4.1) θαη ζηελ εμίζσζε απσιεηώλ (εμ. 4.2). ΢πγθεθξηκέλα, ην πξόγξακκα ππνζέηεη 

έλα αξρηθό πηεδνκεηξηθό θνξηίν γηα ηελ αλάληε δηαηνκή, εάλ πξόθεηηαη γηα 

ππνθξίζηκε ξνή (θαη αληίζηνηρα ζηελ θαηάληε δηαηνκή γηα ππεξθξίζηκε ξνή), θαη 

βάζε απηνύ, ππνινγίδεη ην ζπληειεζηή κεηαθνξάο Κ (εμ. 4.4) θαη ηε κέζε ηαρύηεηα 

(παξνρή/εκβαδόλ). Έρνληαο ηηο ηηκέο απηέο, ζηε ζπλέρεηα, ππνινγίδεη ηε κέζε θιίζε 

γξακκήο ελέξγεηαο Sf  θαη ηέινο ηηο νιηθέο απώιεηεο ελέξγεηαο (εμ. 4.2). Με ηελ 

εμίζσζε ελέξγεηαο (εμ. 4.1) ππνινγίδεη ηειηθά ην πηεδνκεηξηθό θνξηίν ηεο δηαηνκήο. 

Η δηαδηθαζία νινθιεξώλεηαη κε ηε ζύγθξηζε ηεο ππνινγηζκέλεο ηηκήο θαη ηεο ηηκήο 

πνπ ηέζεθε αξρηθά, θαη ειέγρεηαη αλ ζπγθιίλεη ζε έλα επηηξεπηό όξην.   

Σέινο, θαηά ηε δηάξθεηα ησλ ππνινγηζκώλ ην πξόγξακκα ππνινγίδεη ην θξίζηκν 

βάζνο κε κέζνδν πνπ νξίδεηαη από ηελ εληνιή Critical Depth Computation Method 

(Run → Steady Flow analysis→ Options)  θαη ην ζπγθξίλεη κε ην πηεδνκεηξηθό βάζνο 

ζηελ δηαηνκή κειέηεο, ζπκβάιινληαο ζηνλ έιεγρν ηεο νξζόηεηαο ησλ εηζαρζέλησλ 

δεδνκέλσλ. ΢ηελ παξνύζα εξγαζία, γηα ηνλ ππνινγηζκό ηνπ θξίζηκνπ βάζνπο επειέγε 

ε παξαβνιηθή κέζνδνο, ε νπνία είλαη ε ηαρύηεξε θαη πξνηείλεηαη από ηνπο 

θαηαζθεπαζηέο ηνπ HEC-RAS (Brunner, 2008). 

4.5.3.  Σα αποηελέζμαηα ζηις διαηομές μελέηης 

Από ηελ εληνιή View→ Cross sections,  ζην θεληξηθό κελνύ γίλεηαη ε επηζθόπεζε 

ησλ απνηειεζκάησλ, ζε κνξθή δηαγξάκκαηνο θαη κε ηελ επηινγή Detailed Output 

Tables, παξνπζηάδνληαη πίλαθεο κε ηα ραξαθηεξηζηηθά κεγέζε ζηελ θάζε δηαηνκή. 

Δλδεηθηηθά, παξνπζηάδνληαη ηα δηαγξάκκαηα θαη νη πίλαθεο ζηηο δύν δηαηνκέο 

κειέηεο, ζηηο όπνηεο ππάξρνπλ ζηαζκνί κέηξεζεο ζηάζκεο-παξνρήο.  

1. Η δηαηνκή ζηε ζέζε Οηλόε 
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Διάγπαμμα 4.2. Διαηομή ποηαμού για πλημμύπα πεπιόδος επαναθοπάρ Τ=20, Τ=100 

και Τ=1000 έηη. 

2. Η δηαηνκή ζηε ζέζε Μαγνύια. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Διάγπαμμα 4.3. Διαηομή ποηαμού για πλημμύπα πεπιόδος επαναθοπάρ Τ=20, Τ=100 

και Τ=1000 έηη. 
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Εικόνα 4.18. Πίνακαρ με ηα σαπακηηπιζηικά μεγέθη ηηρ εξίζυζηρ ενέπγειαρ ηηρ 

διαηομήρ. 

Πίνακαρ 4.2. Η ζηάθμη νεπού ζηη διαηομή μελέηηρ (Οινόη) για ηιρ ηπειρ πεπιόδοςρ 

επαναθοπάρ. 

 

 

 

 

 

Πίνακαρ 4.3. Η ζηάθμη νεπού ζηη διαηομή μελέηηρ (Μαγούλα) για ηιρ ηπειρ πεπιόδοςρ 

επαναθοπάρ. 

 

Περίοδος 

επαναθοράς 

ζε έηη 

΢ηάθμη νερού 

(m) 

T20 2.12 

T100 2.66 

T1000 4.05 

 

4.5.4.  Σα αποηελέζμαηα ζηις διαηομές μελέηης με ηις νέες παροτές αιτμής  

΢ηελ ελόηεηα απηή παξνπζηάδνληαη ηα απνηειέζκαηα από ηελ εηζαγσγή ηνπ ίδηνπ 

γεσκεηξηθνύ αξρείνπ, θαη ελόο λένπ πδξνινγηθνύ αξρείνπ πνπ πεξηιακβάλεη ηηο 

Περίοδος 

επαναθοράς 

ζε έηη 

΢ηάθμη νερού 

(m) 

T20 0.43 

T100 0.61 

T1000 2.66 
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παξνρέο αηρκήο όπσο πξνέθπςαλ κε ηελ αιιαγή ησλ πδξνινγηθώλ παξακέηξσλ ζην 

HEC-HMS (Κεθάιαην 3.3.5). 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 4.19. Το νέο ςδπολογικό απσείο. 

Οη νξηαθέο ζπλζήθεο παξακέλνπλ νη ίδηεο, όπσο παξνπζηάζηεθαλ ζηελ πξνεγνύκελε 

ελόηεηα. Σα απνηειέζκαηα ησλ δηαηνκώλ ζηηο ζέζεηο κέηξεζεο είλαη: 

1. Η δηαηνκή ζηε ζέζε Οηλόε 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Διάγπαμμα 4.4. Διαηομή ποηαμού για πλημμύπα πεπιόδος επαναθοπάρ Τ=20, Τ=100 

και Τ=1000 έηη. 
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Πίνακαρ 4.4. Η ζηάθμη νεπού ζηη διαηομή μελέηηρ (Οινόη) για ηιρ ηπειρ πεπιόδοςρ 

επαναθοπάρ με ηο νέο ςδπολογικό απσείο. 

 

Περίοδος 

επαναθοράς 

ζε έηη 

΢ηάθμη νερού 

(m) 

T20 1.43 

T100 1.95 

T1000 3.3 

2. Η δηαηνκή ζηε ζέζε Μαγνύια. 

 

 

Διάγπαμμα 4.5. Διαηομή ποηαμού για πλημμύπα πεπιόδος επαναθοπάρ Τ=20, Τ=100 

και Τ=1000 έηη. 

Πίνακαρ 4.5. Η ζηάθμη νεπού ζηη διαηομή μελέηηρ (Μαγούλα) για ηιρ ηπειρ πεπιόδοςρ 

επαναθοπάρ με ηο νέο ςδπολογικό απσείο. 

 

Περίοδος 

επαναθοράς 

ζε έηη 

΢ηάθμη νερού 

(m) 

T20 2.35 

T100 3.02 

T1000 4.01 
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ΔΦΑΡΜΟΓΗ ΢ΣΟ HEC ΜΔ ΠΑΡΑΣΗΡΗΜΔΝΟ ΔΠΔΙ΢ΟΓΙΟ 

ΒΡΟΥΟΠΣΩ΢Η΢ 

5.1. ΓΔΝΙΚΑ 

Σην θεθάιαην απηό παξνπζηάδνληαη ηα απνηειέζκαηα ηεο πδξνινγηθήο θαη 

πδξαπιηθήο πξνζνκνίσζεο ηεο ίδηαο πεξηνρήο κειέηεο, κε ηε δηαθνξά όηη αληί γηα 

επεηζόδηα βξνρήο πνπ έρνπλ δεκηνπξγεζεί από όκβξηεο θακπύιεο (Κεθάιαην 3), 

ρξεζηκνπνηείηαη παξαηεξεκέλν επεηζόδην βξνρόπησζεο.  

Η δηαδηθαζία ηεο πδξνινγηθήο πξνζνκνίσζεο ζην HEC-HMS γίλεηαη κε ηνλ ίδην 

ηξόπν, όπσο πεξηγξάθεθε αλαιπηηθά ζην ηξίην θεθάιαην ηεο εξγαζίαο. Η δηαθνξά 

έγθεηηαη ζηελ θαηάξηηζε ηνπ κεηεσξνινγηθνύ κνληέινπ. Δηζάγεηαη έλα επεηζόδην 

βξνρόπησζεο, όπσο θαηαγξάθεθε από ηξεηο κεηεσξνινγηθνύο ζηαζκνύο ζηηο 

πεξηνρέο Βίιηα, Μάλδξα θαη Πξάζηλν γηα ηέζζεξηο κέξεο, από ηηο 6/2/2012 κέρξη ηηο 

10/2/2012. Σηε ζπλέρεηα, ππνινγίδεηαη κε ηε κέζνδν ησλ πνιπγώλσλ Thiessen ε 

κέζε βξνρόπησζε ζε θάζε ππνιεθάλε. Μεηά από απηήλ ηελ πξνεπεμεξγαζία ζην 

ArcGis, νη βξνρνπηώζεηο ηειηθά εηζάγνληαη ζην HEC-HMS γηα ηελ νινθιήξσζε ηεο 

πδξνινγηθήο πξνζνκνίσζεο.  

Αθνύ νινθιεξσζεί ε δηαδηθαζία ζην HEC-HMS, νη παξνρέο αηρκήο πνπ πξνέθπςαλ 

εηζάγνληαη σο πδξνινγηθό αξρείν ζην πδξαπιηθό κνληέιν HEC-RAS, κε ηε 

δηαδηθαζία πνπ έρεη ήδε πεξηγξαθεί.  

5.2. Η ΤΓΡΟΛΟΓΙΚΗ ΠΡΟ΢ΟΜΟΙΩ΢Η 

Γεκηνπξγείηαη έλα θαηλνύξην project, όπνπ ην κνληέιν ιεθάλεο απνξξνήο έρεη ήδε 

δεκηνπξγεζεί κε ηελ πξνεπεμεξγαζία ζην ΗΔC-GeoHMS, θαη εηζάγεηαη ζην 
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πδξνινγηθό κνληέιν. Τα πξόηππα ππνινγηζκνύ βαζηθήο απνξξνήο θαη άκεζεο 

απνξξνήο κέλνπλ σο έρνπλ (Κεθάιαην 3).  

Σην πξόηππν ππνινγηζκνύ ησλ απσιεηώλ βξνρήο, επηιέρζεθε ε ίδηα κέζνδνο, ηεο 

SCS, κε νξηζκέλεο αιιαγέο ζηηο παξακέηξνπο. To αξρηθό έιιεηκκα (initial 

abstraction) ζεσξήζεθε ίζν κε 10 mm θαη ην πνζνζηό αδηαπέξαηεο επηθάλεηαο ίζν κε 

0 γηα θάζε ππνιεθάλε. Αθόκα γηα ην πξόηππν δηόδεπζεο πιεκκύξαο (Routing) 

επηιέρζεθε ε κέζνδνο lag time. Θεσξήζεθε όηη ε κέζε ηαρύηεηα ξνήο ηνπ λεξνύ είλαη 

ίζε κε 1 m/s, θαη ζε ζπλδπαζκό κε ην κήθνο θάζε ηκήκαηνο ηνπ πνηακνύ (R20, R300 

θ.ιπ.) ππνινγίζηεθε ν αληίζηνηρνο ρξόλνο ζε ιεπηά min. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 5.1. Πρόησπο σπολογιζμού διόδεσζης πλημμύρας. 

Σην κεηεσξνινγηθό κνληέιν εηζάγεηαη ην παξαηεξεκέλν επεηζόδην βξνρήο. Αξρηθά 

εθαξκόζηεθε ε κέζνδνο ησλ πνιπγώλσλ Thiessen ζην ArcGis.  

5.2.1. Η μέθοδος πολσγώνων Thiessen 

Σηε κέζνδν απηή ππνινγίδεηαη ην κέζν βξνρνκεηξηθό ύςνο κε ηε βνήζεηα νξηζκέλσλ  

ζπληειεζηώλ βάξνπο. Σπγθεθξηκέλα, πξνθύπηνπλ πνιύγσλα, κε ηε ράξαμε 

κεζνθαζέησλ ζηηο επζείεο πνπ ζρεκαηίδνπλ νη γεηηνληθνί κεηεσξνινγηθνί ζηαζκνί, ηα 

νπνία πνιύγσλα απνηεινύλ ηελ επηθάλεηα απνξξνήο πνπ πεξηβάιινπλ ηνλ ελ ιόγσ 

ζηαζκό. Ο ζπληειεζηήο βάξνπο wi ηνπ θάζε ζηαζκνύ είλαη ίζνο κε ην ιόγν ηνπ 

εκβαδνύ ηνπ πνιπγώλνπ Ai πξνο ην εκβαδόλ ηεο ιεθάλεο απνξξνήο A (wi = Ai/ A). 

Δπνκέλσο,  

 (5.1) 

όπνπ hi ην ύςνο βξνρήο ζε θάζε ζηαζκό (Γηαλλόπνπινο, 2005).  
1

n

i i

i

h w h



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Βέβαηα, ε ράξαμε ησλ πνιπγώλσλ Thiessen γίλεηαη απηνκαηνπνηεκέλα κε ηελ 

εθαξκνγή κηαο ζεηξάο εληνιώλ ζην ArcGis. Η δηαδηθαζία πνπ αθνινπζείηαη είλαη ε 

εμήο: 

1. Δηζάγνληαη νη κεηεσξνινγηθνί ζηαζκνί, βάζε ησλ ζπληεηαγκέλσλ ηνπο κε ηελ 

εληνιή Tools → Add X,Y data.  

2. Γεκηνπξγία κάζθαο (mask) γηα όιε ηελ πεξηνρή κειέηεο (βνεζεηηθό grid ζην 

νπνίν όια ηα θαηλία εληόο ιεθάλεο έρνπλ ηελ ηηκή 0). Με ηελ εληνιή Spatial 

Analyst → Options → Extent → Same as layer mask, επηιέγεηαη ε επέθηαζε 

ησλ πνιπγώλσλ Thiessen ζε όιε ηελ έθηαζε ησλ ππνιεθαλώλ ηεο πεξηνρήο 

κειέηεο.  

3. Με ηελ εληνιή Spatial Analyst → Distance → Allocation, επηιέγνληαο σο 

εηζεξρόκελν δεδνκέλν ηνπο ζηαζκνύο κέηξεζεο, εμάγνληαη ηα πνιύγσλα 

Thiessen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 5.2. Τα πολύγωνα Thiessen για ηην περιοτή μελέηης. 

Ο ππνινγηζκόο ησλ ζπληειεζηώλ βάξνπο (Thiessen) 

Από ηνλ πίλαθα ηδηνηήησλ ησλ πνιπγώλσλ ππνινγίδεηαη ν ζπλνιηθόο αξηζκόο ησλ 

θαηλίσλ (open attribute table → count → statistics → sum), θαη δηαηξώληαο ηνλ 

αξηζκό ησλ θαηλίσλ θάζε πνιπγώλνπ κε ην ζπλνιηθό πξνθύπηεη ν αληίζηνηρνο 

ζπληειεζηήο Thiessen γηα θάζε ζηαζκό. Έηζη, πξνθύπηεη ν αθόινπζνο πίλαθαο: 
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Πίνακας 5.1. Οι ζσνηελεζηές Thiessen για κάθε ζηαθμό. 

Μεηεωρολογικοί ζηαθμοί ΢σνηελεζηές Thiessen 

Βίιηα 0.518 

Πξάζηλν 0.327 

Μάλδξα 0.155 

Τν άζξνηζκα ησλ ζπληειεζηώλ πξέπεη λα είλαη ίζν κε ηε κνλάδα, όπνπ θαη ηζρύεη.  

Από ηελ Εικόνα 5.2. πξνθύπηεη όηη νξηζκέλεο ππνιεθάλεο επεξεάδνληαη από έλα θαη 

κόλν κεηεσξνινγηθό ζηαζκό (π.ρ. ε ππνιεθάλε 17). Σε απηέο ηηο πεξηπηώζεηο ν 

ζπληειεζηήο κέλεη σο έρεη (Πίνακας 5.1.). Σηελ πεξίπησζε όκσο, πνπ ππνιεθάλεο 

απνηεινύλ κέξνο δύν ή θαη ηξηώλ πνιπγώλσλ, ν ζπληειεζηήο Thiessen πξνθύπηεη από 

ην εκβαδόλ πνπ θαηαιακβάλεη ην πνιύγσλν σο πξνο ηε ζπλνιηθή έθηαζε. Έηζη, γηα 

θάζε ππνιεθάλε, νη αληίζηνηρνη ζπληειεζηέο βάξνπο είλαη: 

Πίνακας 5.2. Οι ζσνηελεζηές Thiessen για κάθε σπολεκάνη. 

 

 

 

 

 

 

 

 

 

 

 

 

Τειηθά, ηα επεηζόδηα βξνρόπησζεο γηα θάζε ππνιεθάλε ππνινγίδνληαη ζύκθσλα κε 

ηε ζρέζε (5.1.) θαη εηζάγνληαη ζην HEC-HMS κε ηε κνξθή ρξνλνζεηξώλ (Times 

Series Data, Κεθάιαην 3). Δλδεηθηηθά, παξνπζηάδεηαη ε βξνρόπησζε ζε κηα ηπραία 

ιεθάλε ζε πεξηβάιινλ HEC-HMS. 

 

 

 

 

 

Τπολεκάνη Βίλια Πράζινο Μάνδρα 

17 0.518 - - 

14 0.518 - - 

19 0.518 - - 

29 0.4 0.6 - 

22 0.4 0.6 - 

20 - 0.327 - 

15 - 0.327 - 

21 - 0.327 - 

34 - 0.300 0.7 

23 - 0.327 - 

33 - 0.155 - 

25 0.6 0.2 0.2 



Κεθάλαιο 5: Εθαρμογή ζηο HEC με παραηηρημένο επειζόδιο βροτόπηωζης 

 

 81 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 5.3. Το παραηηρημένο σεηόγραμμα ζε μια ησταία σπολεκάνη (14). 

5.2.2. Αποηελέζμαηα ηης σδρολογικής προζομοίωζης 

Παξνπζηάδνληαη ελδεηθηηθά ηα πιεκκπξνγξαθήκαηα ζηελ πιένλ αλάληε ιεθάλε 

W170 θαη ζηελ θαηάληε ιεθάλε W340 (βι. Εικόνα 3.6 ζει. 30). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 5.4. Υεηόγραμμα και πλημμσρογράθημα ζτεδιαζμού για επειζόδιο βροτής 

06/02/12-10/02/12 ανάνηη σπολεκάνης. 
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Εικόνα 5.5. Υεηόγραμμα και πλημμσρογράθημα ζτεδιαζμού για επειζόδιο βροτής 

06/02/12-10/02/12 καηάνηη σπολεκάνης. 

Σηελ θαηάληε ζέζε κέηξεζεο (userpoint3) ην πξνζνκνησκέλν πιεκκπξνγξάθεκα 

ζπγθξίλεηαη κε ην παξαηεξεκέλν πιεκκπξνγξάθεκα, όπσο έρεη πξνθύςεη από ηηο 

αληίζηνηρεο κεηξήζεηο. Δηζάγνληαη νη κεηξεκέλεο παξνρέο, κε ηε κνξθή ρξνλνζεηξάο 

κε ηηο εληνιέο: Times Series Data → Discharge Gages, εθηεινύληαη μαλά νη 

ππνινγηζκνί θαη πξνθύπηεη ην αθόινπζν απνηέιεζκα: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εικόνα 5.6. Το προζομοιωμένο και ηο παραηηρημένο πλημμσρογράθημα για ηην 

καηάνηη θέζη μέηρηζης.  
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Παξαηεξείηαη όηη, ε παξνρή αηρκήο, ζρεδόλ ηαπηίδεηαη ρξνληθά κε κηα δηαθνξά κηζήο 

ώξαο ζηα δύν πιεκκπξνγξαθήκαηα, θαη νη αληίζηνηρεο παξνρέο αηρκήο έρνπλ κηθξή 

δηαθνξά (Εικόνα 5.7). Ο θιάδνο θαζόδνπ παξνπζηάδεη ηε κεγαιύηεξε δηαθνξά, 

πξόβιεκα ην νπνίν ζα κπνξνύζε λα επηιπζεί κε ηελ επηινγή άιισλ κνλαδηαίσλ 

πδξνγξαθεκάησλ γηα ηνλ ππνινγηζκό ηεο άκεζεο απνξξνήο, ζπγθεθξηκέλα κε 

κεγαιύηεξν ρξόλν βάζεο θαη ρξόλν αλόδνπ.  

Qαηρκ = 5.966 m
3
/s γηα ην πξνζνκνησκέλν πιεκκπξνγξάθεκα 

Qαηρκ = 6.50 m
3
/s γηα ην παξαηεξεκέλν πιεκκπξνγξάθεκα 

Η δηαθνξά ησλ όγθσλ ηνπο είλαη ηεο ηάμεο 38%, ζπγθεθξηκέλα: 

Vπξνζ. = 1122318 m
3 

θαη Vπαξαη. = 1818628 m
3
 

 

 

Εικόνα 5.7. Σσγκριηικά αποηελέζμαηα προζομοιωμένοσ και παραηηρημένοσ 

πλημμσρογραθήμαηος για ηη θέζη μέηρηζης. 

5.3. Η ΤΓΡΑΤΛΙΚΗ ΠΡΟ΢ΟΜΟΙΩ΢Η 

Γεκηνπξγείηαη έλα λέν project, ην νπνίν έρεη ην ίδην γεσκεηξηθό αξρείν (Geometric 

Data), όπσο πεξηγξάθεθε αλαιπηηθά ε δηαδηθαζία ζην Κεθάιαην 4, θαη έλα θαηλνύξην 

πδξνινγηθό αξρείν (Steady Flow Data). Σην πδξνινγηθό απηό αξρείν εηζάγνληαη νη 

παξνρέο αηρκήο όπσο ππνινγίζηεθαλ από ηελ πδξνινγηθή πξνζνκνίσζε ζην HEC-

HMS.  

Γηα ηνλ ππνινγηζκό, εηζάγνληαη θαη εδώ ελδηάκεζεο παξνρέο, βαζκηαίσο 

απμαλόκελεο. Οη νξηαθέο ζπλζήθεο εηζήρζεζαλ ηόζν ζην αλάληε όζν θαη ζην 

θαηάληε ζεκείν, γηα κεηθηή ξνή.  

5.3.1. Σα αποηελέζμαηα ηης προζομοίωζης 
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1. Η δηαηνκή ζηε ζέζε Οηλόε 

 

 

 

 

 

 

 

 

 

 

 

 

Διάγραμμα 5.1. Η διαηομή ζηη θέζη Οινόη, για παραηηρημένο επειζόδιο βροτής 

(06/02/12-11/02/12). 

2. Η δηαηνκή ζηε ζέζε Μαγνύια. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Διάγραμμα 5.2. Η διαηομή ζηη θέζη Μαγούλα, για παραηηρημένο επειζόδιο βροτής 

(06/02/12-11/02/12). 
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Η ζηάζκε λεξνύ πνπ πξνθύπηεη από ηελ πδξαπιηθή πξνζνκνίσζε είλαη ίζε κε 0.64 

m, ελώ από ηηο κεηξήζεηο πξνέθπςε ζηα 0.644 m.  
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΢ΤΝΘΕ΢Η ΥΑΡΣΩΝ ΠΛΗΜΜΤΡΘΚΗ΢ ΕΠΘΚΘΝΔΤΝΟΣΗΣΑ΢ 

6.1. ΓΕΝΘΚΑ 

Αθνύ νινθιεξσζνύλ νη πδξαπιηθνί ππνινγηζκνί, δίλεηαη ε δπλαηόηεηα εμαγσγήο ησλ 

δεδνκέλσλ ζε πεξηβάιινλ HEC-GeoRAS κε ζθνπό ηε ζύλζεζε ραξηώλ κε ηα 

πηεδνκεηξηθά βάζε θαη ηα πνιύγσλα ησλ πιεκκπξηθώλ θαηαθιύζεσλ. Η εμαγσγή ησλ 

απνηειεζκάησλ ηεο πξνζνκνίσζεο από ην HEC-RAS ζην HEC-GeoRAS εθηειείηαη 

κε ηελ εληνιή File → Export GIS Data (Εηθόλα 6.1. ζει.87). Σην παξάζπξν απηό 

επηιέγεηαη ην πξνθίι πνπ ζα εμαρζεί (Τ=20, Τ=100, Τ=1000). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εηθόλα 6.1. Εμαγωγή πξνζνκνηωκέλνπ αξρείνπ από ην HEC-RAS ζην HEC-GeoRAS. 
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Παξάγεηαη έλα αξρείν ηύπνπ .sdf,  ην νπνίν κεηαηξέπεηαη ζε κνξθή .xml ζε επόκελν 

βήκα. Ωζηόζν, πξηλ ηελ εμαγσγή ησλ δεδνκέλσλ ζην HEC-GeoRAS γίλεηαη κηα 

ηειεπηαία απαξαίηεηε ξύζκηζε ζηα δεδνκέλα ηεο πξνζνκνίσζεο. Οη δηαηνκέο ζηα 

ζεκεία κέηξεζεο (Οηλόε θαη Μαγνύια), πνπ δεκηνπξγήζεθαλ εμ νινθιήξνπ ζην 

HEC-RAS (δελ πεξηιακβάλνληαλ ζην γεσκεηξηθό αξρείν ηνπ HEC-GeoRAS), δελ 

ζεσξνύληαη γεσαλαθεξκέλεο, νκνίσο θαη νη ελδηάκεζεο ηνπο (interpolated) κε 

απνηέιεζκα ηε κε ηειηθή εηζαγσγή ηνπο ζην ArcGis, θαη θαη’ επέθηαζε ηελ νξζή 

δεκηνπξγία πηεδνκεηξηθώλ θαη πιεκκπξηθήο θαηάθιπζεο ραξηώλ. Τν πξόβιεκα 

επηιύζεθε επηιέγνληαο ζην παξάζπξν ησλ γεσκεηξηθώλ δεδνκέλσλ ηνπ HEC-RAS 

ηελ εληνιή, GIS Tools → GIS Cut Lines → Accept Displayed Locations (as 

Georeferenced). Σην ζεκείν απηό γίλεηαη ε επηινγή ησλ δηαηνκώλ πνπ δελ είλαη 

γεσαλαθεξκέλεο. 

Μεηά ηελ εμαγσγή ησλ απνηειεζκάησλ ε δηαδηθαζία κεηαθέξεηαη ζε πεξηβάιινλ 

ArcGis. Τν πξώην βήκα είλαη ε κεηαηξνπή ηνπ αξρείνπ ras sdf ζε xml κε ηελ 

αληίζηνηρε εληνιή ζηελ εξγαιεηνζήθε ηνπ HEC-GeoRAS. Σηε ζπλέρεηα, κε ηελ 

εληνιή RAS Mapping → Layer Setup, δεκηνπξγείηαη κηα αλάιπζε γηα ην πξνθίι πνπ 

έρεη επηιερζεί, ζπκπιεξώλνληαο όια ηα απαξαίηεηα ζηνηρεία. Έρεη ήδε γίλεη 

κεηαηξνπή ηνπ ςεθηαθνύ κνληέινπ εδάθνπο από κνξθή tin ζε κνξθή raster θαη κε 

απηή ηε κνξθή εηζάγεηαη ζην παξάζπξν ησλ εληνιώλ (Εηθόλα 6.2.). Επηιέγεηαη 

επίζεο ην κέγεζνο ηνπ θαηλίνπ ίζν κε 20 m (όζν είλαη ε ηζνδηάζηαζε ησλ ηζνϋςώλ 

από ηηο νπνίεο παξήρζε ην ςεθηαθό κνληέιν εδάθνπο), θαη νλνκάδεηαη ε βάζε 

δεδνκέλσλ κε ην όλνκα ηνπ αληίζηνηρνπ πξνθίι, κέζα ζηελ νπνία απνζεθεύνληαη ηα 

πηεδνκεηξηθά βάζε θαη ηα πνιύγσλα ησλ πιεκκπξηθώλ θαηαθιύζεσλ. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Εηθόλα 6.2. Σπκπιήξωζε ηωλ απαξαίηεηωλ ζηνηρείωλ γηα ηελ αλάιπζε ηνπ πξνθίι 

Τ=20 έηε. 
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Σεκαληηθή παξαηήξεζε είλαη όηη πξέπεη λα έρεη νξηζηεί ην ίδην ζύζηεκα 

ζπληεηαγκέλσλ. Μεηά ηελ νινθιήξσζε ηεο πξνεπεμεξγαζίαο ησλ εηζεξρόκελσλ 

δεδνκέλσλ αθνινπζεί ε εηζαγσγή ησλ απνηειεζκάησλ ηνπ HEC-RAS, κε ηηο εληνιέο 

RAS Mapping → Import RAS Data.  

6.2.  ΢ΤΝΘΕ΢Η ΠΘΕΖΟΜΕΣΡΘΚΩΝ ΥΑΡΣΩΝ 

Με ηηο εληνιέο RAS Mapping → Inundation Mapping → Water Surface Generation 

δεκηνπξγνύληαη νη πηεδνκεηξηθέο επηθάλεηεο γηα ηα δηάθνξα πιεκκπξηθά επεηζόδηα 

θαη νλνκάδνληαη κε ην πξόζεκα «t» θαη ην όλνκα ηνπ θάζε πξνθίι. Οπζηαζηηθά, 

θαηαζθεπάδεηαη έλα ηξηζδηάζηαην κνληέιν ηεο πδάηηλεο επηθάλεηαο από ηηο δηαηνκέο 

θαη ην πηεδνκεηξηθό θνξηίν ζε θάζε δηαηνκή.  

 

 

 

 

 

 

 

 

Εηθόλα 6.3. Οη πηεδνκεηξηθέο επηθάλεηεο γηα πεξίνδν επαλαθνξάο Τ=20 έηε. 

6.3.  ΢ΤΝΘΕ΢Η ΥΑΡΣΩΝ ΠΛΗΜΜΤΡΘΚΗ΢ ΚΑΣΑΚΛΤ΢Η΢ 

Η πηεδνκεηξηθή επηθάλεηα, πνπ έρεη παξαρζεί από ηελ πξνεγνύκελε δηαδηθαζία, 

ζπλδπάδεηαη κε ην ςεθηαθό κνληέιν εδάθνπο. Σθνπόο είλαη ν ππνινγηζκόο ησλ 

αθξηβώλ νξίσλ ηεο θαηάθιπζεο θαη ησλ βαζώλ ηνπ λεξνύ γηα όιν ην πιεκκπξηθό 

πεδίν. Με ηηο εληνιέο RAS Mapping → Inundation Mapping → Floodplain 

delineation, ην ςεθηαθό κνληέιν ηεο πηεδνκεηξηθήο επηθάλεηαο ζπγθξίλεηαη κε ην 

ςεθηαθό κνληέιν εδάθνπο. Σηα ζεκεία όπνπ ην πςόκεηξν ηεο πηεδνκεηξηθήο 

επηθάλεηαο είλαη κεγαιύηεξν από ην πςόκεηξν εδάθνπο, ππνινγίδεηαη ε δηαθνξά ησλ 

δύν πςνκέηξσλ, ε νπνία αληηπξνζσπεύεη ην αληίζηνηρν βάζνο ηνπ λεξνύ ζηε ζέζε. 

Καη’ απηόλ ηνλ ηξόπν, δεκηνπξγνύληαη αξρεία πνπ πεξηέρνπλ ηα βάζε ηνπ λεξνύ γηα 

ηα δηάθνξα πιεκκπξηθά επεηζόδηα θαη νλνκάδνληαη κε ην πξόζεκα «d» (depth). 

Παξάιιεια, θαηαζθεπάδνληαη πνιύγσλα πνπ πεξηέρνπλ ηα αθξηβή όξηα ηεο 

θαηάθιπζεο γηα ην θάζε πξνθίι, ηα νπνία νλνκάδνληαη κε ην πξόζεκα «b» 

(boundary). 
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Εηθόλα 6.4. Τα βάζε θαη ε έθηαζε πιεκκύξαο γηα πεξίνδν επαλαθνξάο Τ=20 έηε. 

6.4. ΠΘΕΖΟΜΕΣΡΘΚΟΘ ΥΑΡΣΕ΢ ΚΑΘ ΥΑΡΣΕ΢ ΠΛΗΜΜΤΡΘΚΗ΢ ΚΑΣΑΚΛΤ΢Η΢ 

Σην θεθάιαην απηό παξνπζηάδνληαη νη ράξηεο πηεδνκεηξίαο θαη ησλ πιεκκπξηθώλ 

θαηαθιύζεσλ γηα ηηο ηξεηο πεξηόδνπο επαλαθνξάο (Τ=20, Τ=100 θαη Τ=1000 έηε) θαη 

γηα ην παξαηεξεκέλν επεηζόδην βξνρόπησζεο.  

Παξαηίζεηαη ζε πίλαθα θαη ζπγθξηηηθό δηάγξακκα ηα εκβαδά ησλ πιεκκπξηθώλ 

θαηαθιύζεσλ γηα ηηο παξαπάλσ πεξηπηώζεηο. Παξαηεξείηαη όηη δελ ππάξρνπλ 

ζεκαληηθέο δηαθνξέο ζηηο εθηάζεηο ησλ πιεκκπξηθώλ θαηαθιύζεσλ γηα ηηο ηξεηο 

πεξηόδνπο επαλαθνξάο, έσο 1 km
2
, γεγνλόο πνπ εμεγείηαη από ηελ πεξηνξηζκέλε 

αλάιπζε ηνπ ρξεζηκνπνηεκέλνπ ςεθηαθνύ κνληέινπ εδάθνπο (ηζνϋςείο 

ηζνδηάζηαζεο 20 m). 

Πίλαθαο 6.1. Εκβαδά θαηαθιπδόκελωλ πεξηνρώλ. 

Πεξίνδνο 

επαλαθνξάο (έηε) 

Έθηαζε 

(km
2
)  

Τ20 0.74 

Τ100 0.76 

Τ1000 0.8 

παξαηεξεκέλν 

επεηζόδην βξνρήο 
0.67 

 

 

 

 

 

 

 

Δηάγξακκα 6.1. Σπγθξηηηθή παξνπζίαζε θαηαθιπδόκελωλ πεξηνρώλ. 

Εμβαδά πλημμσρικών καηακλύζεων

0.6

0.65

0.7

0.75

0.8

0.85

παραηηρημένο επειζόδιο

βροχής

Τ20 Τ100 Τ1000

Περίοδος επαναθοράς/παραηήρηζεις

Έ
κ
ηα

ζ
η

 k
m

2



Κεθάιαην 6: Σύλζεζε ραξηώλ πιεκκπξηθήο επηθηλδπλόηεηαο 

 

 

 91 

 

Χάξηεο 6.1. Πηεδνκεηξηθόο ράξηεο πεξηόδνπ επαλαθνξάο 20 έηε. 
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Χάξηεο 6.2. Πηεδνκεηξηθόο ράξηεο πεξηόδνπ επαλαθνξάο 100 έηε. 
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Χάξηεο 6.3. Πηεδνκεηξηθόο ράξηεο πεξηόδνπ επαλαθνξάο 1000 έηε. 
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Χάξηεο 6.4. Πηεδνκεηξηθόο ράξηεο παξαηεξεκέλνπ επεηζνδίνπ βξνρόπηωζεο. 
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Χάξηεο 6.5. Χάξηεο πιεκκπξηθήο θαηάθιπζεο γηα πεξίνδν επαλαθνξάο 20 έηε. 
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Χάξηεο 6.6. Χάξηεο πιεκκπξηθήο θαηάθιπζεο γηα πεξίνδν επαλαθνξάο 100 έηε. 
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Χάξηεο 6.7. Χάξηεο πιεκκπξηθήο θαηάθιπζεο γηα πεξίνδν επαλαθνξάο 1000 έηε. 
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Χάξηεο 6.8. Χάξηεο πιεκκπξηθήο θαηάθιπζεο γηα παξαηεξεκέλν επεηζόδην βξνρόπηωζεο. 
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΢ΤΝΟΦΗ-΢ΤΜΠΕΡΑ΢ΜΑΣΑ 
 
ΓΕΝΙΚΑ 

Η παξνύζα κεηαπηπρηαθή εξγαζία εμεηάδεη ην κεζνδνινγηθό πιαίζην γηα ηελ 

θαηάξηηζε ραξηώλ πιεκκύξαο κε ηε ρξήζε ησλ ειεύζεξσλ ινγηζκηθώλ ηνπ Σώκαηνο 

Μεραληθώλ ηνπ Ακεξηθαληθνύ Σηξαηνύ, HEC-HMS θαη HEC-RAS. Η 

πξνεπεμεξγαζία ησλ πξσηνγελώλ δεδνκέλσλ επηηπγράλεηαη κε ην ζύζηεκα 

γεσγξαθηθώλ πιεξνθνξηώλ ArcGis θαη ζπγθεθξηκέλα κε ηηο επεθηάζεηο απηνύ HEC-

GeoHMS θαη HEC-GeoRAS.  

Ωο πεξηνρή κειέηεο επηιέρζεθε ε ιεθάλε απνξξνήο ηνπ Σαξαληαπόηακνπ ζηελ 

πεξηνρή ηεο Διεπζίλαο, ήηνη 200 km
2
. Η πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο 

απηήο πξαγκαηνπνηήζεθε γηα ηξεηο πεξηόδνπο επαλαθνξάο (Τ=20, 100, 1000 έηε) θαη 

ελόο παξαηεξεκέλνπ επεηζνδίνπ βξνρήο (06/02/12-10/02/12). Η πδξαπιηθή 

πξνζνκνίσζε εθαξκόζηεθε γηα 20 km ηνπ βόξεηνπ θιάδνπ ηνπ πνηακνύ ζε ζπλζήθεο 

κόληκεο ξνήο. Τα ζπκπεξάζκαηα από ηελ νινθιήξσζε ηεο δηαδηθαζίαο απηήο είλαη 

ηα αθόινπζα.  

Η ΤΔΡΟΛΟΓΙΚΗ ΠΡΟ΢ΟΜΟΙΧ΢Η 

Η πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο κειέηεο εθαξκόζηεθε ζην πδξνινγηθό 

κνληέιν HEC-HMS κε ηελ απαξαίηεηε πξνεπεμεξγαζία ησλ πξσηνγελώλ δεδνκέλσλ 

ζηελ επέθηαζε ηνπ πξνγξάκκαηνο ArcGis, HEC-GeoHMS.  

Τα πξσηνγελή δεδνκέλα, ην ςεθηαθό κνληέιν εδάθνπο, ν ράξηεο ρξήζεσλ γεο θαη ν 

ράξηεο γεσινγίαο, νδήγεζαλ ζηε ηειηθή ράξαμε ησλ ππνιεθαλώλ θαη ηελ εμαγσγή 

ηνπ πδξνγξαθηθνύ δηθηύνπ επηιέγνληαο ην αλάινγν θαηώθιη (threshold). Οπζηαζηηθά, 

ζην HEC-GeoHMS δεκηνπξγήζεθε ην αξρείν ηεο ιεθάλεο απνξξνήο, ην νπνίν κεηά 

από θαηάιιειε επεμεξγαζία ζπκβαηόηεηαο εηζήρζε ζην HEC-HMS, καδί κε ηα 

απαξαίηεηα ηνπνινγηθά ραξαθηεξηζηηθά ησλ ππνιεθαλώλ απνξξνήο θαη ησλ 

αληίζηνηρσλ πδξνινγηθώλ ραξαθηεξηζηηθώλ.  

Σηε ζπλέρεηα, ηίζεηαη ζηελ θξίζε ηνπ ρξήζηε ε επηινγή ησλ θαηάιιεισλ 

καζεκαηηθώλ πξνηύπσλ γηα ηνλ ππνινγηζκό ησλ απσιεηώλ βξνρήο, ηεο άκεζεο 

απνξξνήο, ηεο βαζηθήο ξνήο θαη ηεο δηόδεπζεο πιεκκύξαο. Γηα ηηο απώιεηεο βξνρήο 

επηιέρζεθε ε κέζνδνο SCS, ε νπνία έρεη σο δεδνκέλα εηζόδνπ ηνλ αξηζκό θακπύιεο 

απνξξνήο CN, ην αξρηθό έιιεηκκα θαη ην πνζνζηό ηεο αδηαπέξαηεο επηθάλεηαο. Η 

πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο πξαγκαηνπνηήζεθε γηα δύν δηαθνξεηηθά 

ζελάξηα. Τν πξώην ιάκβαλε σο αξρηθό έιιεηκκα ην 20% ηεο κέγηζηεο δπλεηηθήο 
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θαηαθξάηεζεο, όπσο νξίδεηαη από ηε βηβιηνγξαθία, ελώ ζην δεύηεξν ηέζεθε σο 

αξρηθό έιιεηκκα 10 mm. Αθόκα, ηα δύν απηά ζελάξηα, δηέθεξαλ σο πξνο ηηο 

αδηαπέξαηεο επηθάλεηεο. Τειηθά, πξνέθπςαλ πιεκκπξνγξαθήκαηα ζρεδηαζκνύ κε 

κεγαιύηεξεο θαη πην «ινγηθέο» ηηκέο παξνρώλ ζην δεύηεξν ζελάξην.  

Όζνλ αθνξά ζηελ επηινγή ηνπ πξνηύπνπ γηα ην ππνινγηζκό ηεο άκεζεο απνξξνήο, 

θξίζεθε θαηάιιειν ην ζπλζεηηθό κνλαδηαίν πδξνγξάθεκα, κηα παξαιιαγή ηνπ 

κνλαδηαίνπ πδξνγξαθήκαηνο ηνπ Βξεηαληθνύ Ιλζηηηνύηνπ Υδξνινγίαο, 

πξνζαξκνζκέλν ζην ρξνληθό βήκα ηεο θαηαηγίδαο ζρεδηαζκνύ, ήηνη 15 min. Γηα ηε 

βαζηθή ξνή δελ επηιέρζεθε θάπνηα κέζνδνο ππνινγηζκνύ, ιόγσ έιιεηςεο δεδνκέλσλ, 

ελώ γηα ηε δηόδεπζε πιεκκύξαο, ζην δεύηεξν ζελάξην, επηιέρζεθε ε κέζνδνο lag 

time, πνπ νπζηαζηηθά δελ πξνθαιεί κεγάιε δηαθνξά ζηα εμαγόκελα 

πιεκκπξνγξαθήκαηα.  

Τν κεηεσξνινγηθό κνληέιν, απαξηίδεηαη από πεηνγξαθήκαηα ζρεδηαζκνύ γηα θάζε 

ππνιεθάλε ζηελ πεξηνρή κειέηεο, όπσο απηά πξνέθπςαλ από ηε κέζνδν ησλ 

ελαιιαζζόκελσλ ηκεκάησλ, από ηηο εθηηκεζείζεο όκβξηεο θακπύιεο ηεο πεξηνρήο. 

Σηελ πνξεία ηεο εξγαζίαο, πξνέθπςαλ δεδνκέλα βξνρόπησζεο, όπνηε 

πξαγκαηνπνηήζεθε πδξνινγηθή πξνζνκνίσζε ηεο ιεθάλεο κειέηεο θαη γηα ην 

παξαηεξεκέλν επεηζόδην βξνρόπησζεο (06/02/12-10/02/12). Σπγθεθξηκέλα, ζηελ 

θαηάληε ζέζε ηεο ιεθάλεο κειέηεο (πεξηνρή Μαγνύια), έγηλε ζύγθξηζε ηνπ 

παξαηεξεκέλνπ πιεκκπξνγξαθήκαηνο, όπσο πξνέθπςαλ από ηηο κεηξήζεηο ηνπ 

ζηαζκεγξάθνπ, κε ην πξνζνκνησκέλν πιεκκπξνγξάθεκα. Τα ζπκπεξάζκαηα πνπ 

πξνέθπςαλ είλαη όηη, ε δηαθνξά ησλ όγθσλ είλαη ηεο ηάμεο ηνπ 38%, νη αηρκέο 

ρξνληθά θαη πνζνηηθά ζρεδόλ ηαπηίδνληαη κε πνιύ κηθξέο δηαθνξέο, σζηόζν ηηο 

κεγαιύηεξεο δηαθνξέο παξνπζηάδεη ν θιάδνο θαζόδνπ ησλ πιεκκπξνγξαθεκάησλ. 

Απηό ζα κπνξνύζε λα εμαιεηθζεί κε ηε ρξήζε δηαθνξεηηθώλ κνλαδηαίσλ 

πδξνγξαθεκάησλ, κεγαιύηεξνπ ρξόλνπ βάζεο θαη ρξόλνπ αλόδνπ. 

Η ΤΔΡΑΤΛΙΚΗ ΠΡΟ΢ΟΜΟΙΧ΢Η 

Η πδξαπιηθή πξνζνκνίσζε εθηειέζηεθε γηα 20 km ηνπ πνηακνύ Σαξαληαπόηακνπ 

γηα ηηο ηξεηο πεξηόδνπο επαλαθνξάο θαη γηα ην παξαηεξεκέλν επεηζόδην 

βξνρόπησζεο.  

Τν γεσκεηξηθό αξρείν δεκηνπξγήζεθε ζην HEC-GeoHMS, θαη νη δηαηνκέο πνπ 

επηιέρζεθαλ λα εηζαρζνύλ ζην πδξαπιηθό κνληέιν  HEC-RAS, βξίζθνληαη ζε 

ραξαθηεξηζηηθέο ζέζεηο ησλ ιεθαλώλ απνξξνήο (αξρή, κέζε, ηέινο). Τν πξόβιεκα 

πνπ παξνπζηάζηεθε, ήηαλ ε αδπλακία απνηύπσζεο ηνπ γεσγξαθηθνύ αλάγιπθνπ 

ζηελ θνίηε, εμαηηίαο ηεο πνιύ κηθξήο αλάιπζεο (ηζνδηάζηαζε ηζνϋςώλ 20 m). Γπν 

από ηηο δηαηνκέο ζηελ αλάληε ζέζε (πεξηνρή Οηλόε) θαη ζηελ θαηάληε ζέζε (πεξηνρή 

Μαγνύια), ζρεδηάζηεθαλ εθ λένπ ζην HEC-RAS, ράξε ζηελ επηηόπνπ απνηύπσζε 
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από ηνπνγξαθηθό ζπλεξγείν θαη ράξαμε κεθνηνκήο, από ηελ νπνία πξνθύπηνπλ ηα 

πςόκεηξα ηνπ ππζκέλα ζε θάζε ζεκείν ηνπ πδαηνξεύκαηνο. 

Μεηά ηελ νινθιήξσζε ηνπ γεσκεηξηθνύ αξρείνπ θαη ηελ εηζαγσγή ζην HEC-RAS, 

αθνινπζεί ε δεκηνπξγία ηνπ πδξνινγηθνύ αξρείνπ, ην νπνίν πεξηιακβάλεη ηηο 

παξνρέο αηρκήο όπσο απηέο πξνέθπςαλ από ην HEC-HMS. Η πδξαπιηθή 

πξνζνκνίσζε εθηειέζηεθε γηα κόληκε ξνή, ζε ζπλζήθεο κεηθηήο ξνήο (ελαιιαγή 

ππνθξίζηκεο/ ππεξθξίζηκεο ξνήο). Σε πνιιά ζεκεία, θξίζεθε αλαγθαία ε εηζαγσγή 

λέσλ δηαηνκώλ κε βαζκηαίσο απμαλόκελεο παξνρέο πξνο απνθπγήλ θαη εμάιεηςε ησλ 

παξνπζηαδόκελσλ ζθαικάησλ θαη πξνεηδνπνηεηηθώλ κελπκάησλ. 

Αμίδεη λα ζεκεησζεί όηη, ζηελ πεξίπησζε ηνπ παξαηεξεκέλνπ επεηζνδίνπ βξνρήο 

ζηελ θαηάληε ζέζε Μαγνύια όπνπ έρεη ηνπνζεηεζεί ζηαζκεγξάθνο, ε παξαηεξεκέλε 

ηηκή ζηάζκεο κεηξήζεθε 0.644 m θαη ε πξνζνκνησκέλε ηηκή ππνινγίζηεθε ζηα 0.64 

m.  

Τέινο, ηα απνηειέζκαηα από ηελ πξνζνκνίσζε απηή, εμάγνληαη εθ λένπ ζην HEC-

GeoRAS, γηα ηε ζύλζεζε πηεδνκεηξηθώλ ραξηώλ θαη ραξηώλ πιεκκπξηθήο 

θαηάθιπζεο. 

΢ΤΝΘΕ΢Η ΥΑΡΣΧΝ ΠΛΗΜΜΤΡΑ΢ 

Η ραξηνζύλζεζε έγηλε ζε πεξηβάιινλ HEC-GeoRAS γηα ηηο ηξεηο πεξηόδνπο 

επαλαθνξάο θαη ην παξαηεξεκέλν επεηζόδην βξνρήο. 

Δμάγνληαη ηα πηεδνκεηξηθά βάζε ζε θάζε δηαηνκή, όπσο ππνινγίζηεθαλ ζηελ 

πδξαπιηθή πξνζνκνίσζε, θαη ζηε ζπλέρεηα απηά ζπγθξηλόκελα κε ηα πςόκεηξα ηνπ 

ςεθηαθνύ κνληέινπ εδάθνπο, δίλνπλ ηα βάζε ηεο πιεκκπξηθήο θαηάθιπζεο θαη ηηο 

αληίζηνηρεο εθηάζεηο.  

Τα εκβαδά ησλ θαηαθιπδόκελσλ πεξηνρώλ δελ έρνπλ κεγάιεο δηαθνξέο γηα ηηο ηξεηο 

πεξηόδνπο επαλαθνξάο, δελ παξαηεξείηαη ε αλακελόκελε αύμεζε ηνπ εκβαδνύ 

θαηαθιπδόκελεο έθηαζεο κε ηελ απμαλόκελε κέγηζηε πιεκκπξηθή παξνρή (αλά 

πεξίνδν επαλαθνξάο). Μηα εμήγεζε πνπ κπνξεί λα δνζεί είλαη ε κηθξή αλάιπζε ηνπ 

ςεθηαθνύ κνληέινπ εδάθνπο πνπ ρξεζηκνπνηήζεθε γηα ηε ζύλζεζε ησλ ραξηώλ 

πιεκκύξαο.  

ΑΞΙΟΛΟΓΗ΢Η ΛΟΓΙ΢ΜΙΚΟΤ 

Όπσο έρεη ήδε αλαθεξζεί, ε δηαδηθαζία ησλ πξνζνκνηώζεσλ, πδξνινγηθή θαη 

πδξαπιηθή, πξαγκαηνπνηήζεθαλ κε ην ειεύζεξν ινγηζκηθό HEC. Σε γεληθέο γξακκέο, 

πξόθεηηαη γηα έλα κνληέιν ζην νπνίν, αλ εμαηξεζνύλ ηα ιεηηνπξγηθά πξνβιήκαηα πνπ 

παξνπζηάζηεθαλ (π.ρ. ηξόπνο εηζαγσγήο δεδνκέλσλ), αληαπνθξίλεηαη ζε 
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ηθαλνπνηεηηθό βαζκό ζηηο αλάγθεο ησλ ελ ιόγσ δηαδηθαζηώλ. Τα εγρεηξίδηα ρεηξηζκνύ 

θαζνδεγνύλ ην ρξήζηε ζε κεγάιν βαζκό, σζηόζν αξθεηά θσιύκαηα πνπ 

παξνπζηάζηεθαλ θαηά ηε δηάξθεηα εθπόλεζεο ηεο εξγαζίαο επηιύζεθαλ κε ηελ 

αλαδήηεζε ζε άιιεο βηβιηνγξαθηθέο αλαθνξέο. Γηα ηηο αλάγθεο πνπ πηζαλόλ ζα 

ρξεζηκνπνηεζεί ην ινγηζκηθό, νδεγεί ζε αμηόπηζηα απνηειέζκαηα, όπσο έρεη 

παξαηεξεζεί θαη από ηα απνηειέζκαηα ηεο παξνύζαο εξγαζίαο.  Σε ζπλδπαζκό κε  

ηελ επθνιία εύξεζεο ηνπ, θαη ηνπ κεδεληθνύ θόζηνπο ηνπ, αμίδεη λα ρξεζηκνπνηεζεί 

από ηνπο ελδηαθεξόκελνπο ρξήζηεο.  

ΠΡΟΣΑ΢ΕΙ΢ ΜΕΣΕΞΕΛΙΞΗ΢ ΣΗ΢ ΕΡΓΑ΢ΙΑ΢ 

Σύκθσλα κε ηελ Οδεγία 2007/60/ΔΚ, ε εθπόλεζε ραξηώλ πιεκκπξηθήο 

επηθηλδπλόηεηαο απνηειεί ην πξώην ζηάδην πξηλ ηελ εθπόλεζε ησλ νινθιεξσκέλσλ 

ζρεδίσλ δηαρείξηζεο πιεκκπξηθνύ θηλδύλνπ. Φπζηθό επαθόινπζν είλαη ε εθπόλεζε 

ραξηώλ θηλδύλσλ πιεκκύξαο, δειαδή, έλαο ζπλδπαζκόο ησλ ραξηώλ πιεκκπξηθήο 

θαηάθιπζεο θαη ησλ ρξήζεσλ γεο, όπνπ ζα απεηθνλίδνληαη πιένλ νη επηπηώζεηο ησλ 

πιεκκπξώλ ηόζν ζε νηθνλνκηθό επίπεδν όζν θαη ζε αλζξώπηλν δπλακηθό. Σπλεπώο, 

κηα αλακελόκελε ρξήζηκε εμέιημε ηεο παξνύζαο εξγαζίαο είλαη ε θαηάξηηζε ελόο 

κεζνδνινγηθνύ πιαηζίνπ γηα ηελ εθπόλεζε ραξηώλ πιεκκύξαο πνπ λα απεηθνλίδνπλ 

ηηο θνηλσληθέο θαη νηθνλνκηθέο επηπηώζεηο ησλ πιεκκπξώλ.   

Δλδηαθέξνλ βέβαηα παξνπζηάδεη, ε δηεξεύλεζε θαη ε εθαξκνγή θαη άιισλ κεζόδσλ 

ππνινγηζκνύ ησλ καζεκαηηθώλ πξνηύπσλ γηα ηηο απώιεηεο βξνρήο, ηελ άκεζε 

απνξξνή, ηε βαζηθή ξνή θαη ηε δηόδεπζε πιεκκύξαο, πνπ πξνζθέξεη ην πδξνινγηθό 

κνληέιν HEC-HMS, έηζη ώζηε λα γίλεη ε ζύγθξηζε ησλ εμαγόκελσλ 

πιεκκπξνγξαθεκάησλ θαη λα εθαξκόδεηαη δεδνκέλνπ ησλ ζπλζεθώλ ε βέιηηζηε 

κέζνδνο ππνινγηζκνύ ησλ αληίζηνηρσλ δηεξγαζηώλ.  
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